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Introduction

Welcome!

Thank you for choosing PhoneTree to deliver your important messages! This guide has been designed to
take you step-by-step through the basic required setup of your PhoneTree system, including the
pre-configuration steps necessary to complete before calls can take place, as well as daily operation and
common questions. For further information on certain features that are not discussed in this guide, you can
search the help files located within the PhoneTree software or visit our website at www.phonetree.com.

We are always improving our product and support materials. For the latest updates for this User Guide,
please visit www.phonetree.com/customersupport/downloads.htm.

Contacting Us

We're here to help if you ever have questions. Keep the following contact information handy and let us
know anytime you have a question, comment or concern.

Toll-Free Customer Support......... 866.234.2943

Fax ... ..o i 800.245.4221

E-Mail ... ... ... support@phonetree.com
USPS ... PhoneTree

2400 Reynolda Rd
Winston-Salem, NC 27106

Notice of Liability

The information in this book is intended to be accurate and useful with the operation of your PhoneTree.
Personal Communication Systems, Inc. shall not have any liability for loss or damage caused by directly or
indirectly using the instructions contained within this book or by the computer software and hardware
products described in it.

Trademarks

The trademarked names used in this book are used for editorial purposes only and to the benefit of the
trademarked owner with no intention of infringement of the trademark. We further state that PhoneTree,
PhoneTree 2100, PhoneTree 2500, PhoneTree 2500 SE, PhoneTree 3500, PhoneTree 3500 SE, PhoneTree
PT-400, PhoneTree G2PT, PhoneTree Client, PhoneTree OnDemand and the PhoneTree logo are all
trademarks of Personal Communication Systems, Inc.
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Installation: Check System Requirements

Step One: Check System Requirements

PhoneTree requires a minimum set of requirements from your system in order to work correctly. If

your PC has fewer than these requirements, your PhoneTree system may not complete certain

tasks well or at all.

Local Disk {C:) Properties

| General | Tools | Hardware || Sharing | Quota

L= \Internal Drive

Type: Local Disk.
File spstem: ~ MTFS

B Used space:
B Free space:

13,288 439,808 bk
26.669.969,400 tilkes

Capacity: 39.958.409.215 tiges

Diive C

[[] Compress drive ta save disk space

Allow Indexing Service ko index this disk for Fast fle searching

System Properties

System Restore

. Automatic Updates _Fh_emole
Genersl | Computer Name Hardware Advanced

Spstem;
Microsoft Windaws =P
Professional
“ersion 2002
Service Pack 2

 — John Doe

00000-0 EM-0000000-00000

IntellR]
Pentium(R] 4 CPU 2.B0GHz
2.79GHz, 768 ME of AAM
Physical Address Extension

Support Informalion

System Requirements (Minimum)

« Intel Pentium 4 or equivalent processor

» Windows 2000, Windows XP, Windows Server 2003, or Windows Vista

PhoneTree is not compatible with Windows 3.1, Windows 95, Windows 98, Windows ME,

Windows NT, or Mac OS.

« RAM: 2000........... 512 MB
XP............. 512 MB
Server 2003 . .. .. 512 MB
Vista ........... 1GB

+ Hard Drive Space: 1 GB
+ CD ROM Drive

+ Color Monitor (SVGA) with 1024 x 768 resolution

+ One USB port per unit.

Note: If you do not have any available USB ports, you will need to purchase a new host
controller card. There is a max of 12 lines (3 PT-400 units or 6 G2PT units) per host

controller card (true dual [or quad]). For more information, please contact Customer Support.

In addition to the above requirements, the computer hosting PhoneTree must be:

- Configured and installed on the client network.

+ Able to access the Internet for initial configuration, to receive online training and in case of

any future technical support needs from PhoneTree Customer Support.

Note: PhoneTree is designed to allow operation in the background however, we cannot guarantee

compatibility or problem-free operation with other programs.



Installation: Install the Software

Step Two: Install the Software

Note to Windows Vista users: User Account Control (UAC) must be disabled before you can
install the PhoneTree software. Please see the Installing PhoneTree on Windows Vista insert
that was included with your package or visit www.phonetree.com/customersupport for
instructions on how to do this.

1. Insert the CD

Insert the PhoneTree Installation CD into your CD-ROM drive. The Installer Menu should
start automatically. Choose Install PhoneTree Software and enter the supplied Serial Key
(found on the inside of the software case) when prompted. If it does not start automatically,
click on Start » Run » Browse... » Installer.exe (look for this file on the CD) » click Open »
click OK. The Installer Menu should then launch.

To install Adobe Reader, relaunch the Installer Menu. If you plan to use the PhoneTree Client
software for limited remote access of your PhoneTree system from a networked PC (see page
131), launch the Installer Menu from that PC.

2. Choose the Default Settings
Click on Next several times until the installation process starts. In order to assure reliable
operation and ease of service, please DO NOT change the default installation information as it
is presented.

3. Finish Installation
If asked, choose “Yes, I want to restart my computer now” and click Finish. Do not start the
PhoneTree program at this time.

4. Install Female and Male Voice Text-to-Speech (3500 only)
Repeat this process for both the Female and Male Voice CDs.



Installation: Connect the Hardware

|—\
- ———————— HE Phone Line Jack

Hardware Model: G2PT

L2

Teeghone System
Equ

ModelNo: G2PT
Soril

TiAdb1000

Campleswith
Fort 8 FCC Rules

USDMATTBGZP
IC: 1917A.G2PT

RENOTB
Jack RJIAC
9DC 350 mA

Bl Headphone/Speaker Jack
B Microphone Jack
A USB Cable Jack

DIP Switches
(See warning below)
B Power Adapter Jack

Step Three: Connect the Hardware
G2PT

1.

Connect the phone cable

The G2PT’s single phone jack design (a) has the ability to be configured for 1 or 2 Line capacity.
Please see page 14 for instructions on how to connect to various wall jack configurations.

. Connect the USB cable

Using the supplied USB cable, connect the flat end to an available USB port on your PC and the
square end to the PhoneTree’s USB cable jack (b). A USB cable is required for each PhoneTree
hardware box (if all of your USB ports are in use, see page 8).

. Connect the power adapter

Connect the supplied power adapter to the PhoneTree’s power adapter jack (c) and then insert it
into a wall power outlet or power strip.

. Connect the headset microphone

Using the supplied headset microphone, connect the Headphone plug, or a set of computer
speakers, into the SPKR jack (d). Next, connect the Microphone plug into the MIC jack (e),
located right below the SPKR jack. Note: If using more than one unit, make sure that the headset
microphone or speaker set, is connected to the unit that contains lines 1-2.

Caution! (DIP Switches)

The DIP (Dual In-Line Package) Switches are pre-configured from PCS and should only be adjusted
if there is an installation problem as described on page 18. For information on how to properly set the
DIP Switches, please see page 166.



Installation: Connect the Hardware, continued

Hardware Model: PT-400

PHONE
LINE 1

—— B Phone Line Jack

PHONE
LINE 2

PHONE
LINE 3

PHONE
LINE 4

AEEAER > @ —— [ Headphone/Speaker Jack

MICROPHONE ! @ — B Microphone Jack

USB‘?

[ USB Cable Jack

powa«gg) @ —— [ Power Adapter Jack
9 VDC

1000mA
® ®

PT-400
1. Connect the phone cable

Connect an analog phone cable to each enabled phone jack. Depending on the number of lines
you ordered for your PhoneTree hardware, all phone jacks on the back of each PT-400 unit
may not be enabled.

2. Connect the USB cable

Using the supplied USB cable, connect the flat end to an available USB port on your PC and the
square end to the PhoneTree’s USB cable jack (b). A USB cable is required for each PhoneTree
hardware box (if all of your USB ports are in use, see page 8).

3. Connect the power adapter

Connect the supplied power adapter to the PhoneTree’s power adapter jack (c) and then insert it
into a wall power outlet or power strip.

4. Connect the headset microphone
Using the supplied headset microphone, connect the Headphone plug, or a set of computer
speakers, into the Speaker jack (d). Next, connect the Microphone plug into the Microphone
jack (e), located just below the Speaker jack.

Note: If using more than one unit, make sure that the headset microphone or speaker set, is
connected to the unit that contains lines 1-4.



Installation; Install the Hardware Drivers

Step Four: Install the Hardware Drivers

After the hardware steps on the previous page are completed, your computer may prompt you for
permission to install the hardware drivers for Windows. Check with your IT personnel to make sure
the Windows user login you plan to run PhoneTree with has the correct permissions associated with
it. If the permissions are not set high enough, Windows will prevent you from moving further with
the installation.

If you are running Windows XP, you will be required to install the drivers manually:

Windows XP (with Service Pack 2)

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for cument and updated software by

looking on your computer, on the hardware installation CD, or on
the Windows Update Web site (with your permission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

() Yes, this time onhy
() Yes, now and every time | connect a device
() No, not this time

Click Next to continue.

P

Choose No, not this time and click Next. Choose Install the software automatically
(Recommended), then click Next.

Hardware Installation

L E The sofhware vou are instaling for this hardware:
L]
PCS PhoneTree USE Shared 01-04 [B)]

haz not passed Windows Logo testing to verif_y itz compatibility

with "Windaws %P [Tell me why this testing is important |

Continuing your i llation of this soft may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and

tact the hard vendor for sof that has
passed Windows Logo testing.

[ Continug Anypway ] [ STOF Installation ]

Next, you will be informed that the drivers have not passed Windows Logo testing. Be assured that it
is 100% safe to install the PhoneTree drivers on your computer. Click Continue Anyway to proceed.
Windows will prompt you to do this several times until the hardware is fully installed.

Note: If you accidentally pressed STOP Installation, unplug the power adapter from the PhoneTree
box for about 10 seconds and then reinsert it. You should see Windows detect the hardware again and
then just follow the steps listed above.



Installation: Install the Hardware Drivers, continued

Windows Vista

You may receive the warning screen below. Be assured that it is 100% safe to install PhoneTree on
your PC.

58 Windows Security (==

@ Windows can't verify the publisher of this driver software

# Don'tinstall this driver software

Wou should check your manufacturer's website for updated driver software
foryour device,

i Install this driver software anyway
: Only install driver software ebtained from your manufacturer's website or

disc, Unsigned scftware frem other sources may harm your computer or steal
infermaticn,

(w) See details

Please click Install this driver software anyway.

L

x

_Jl,l Your devices are ready to use
¥ Device driver software installed successfully.,

It may take a few minutes for Windows to recognize the PhoneTree device drivers. When you see

the above message appear in the lower right corner of the screen, the PhoneTree hardware has
been successfully installed.



Installation: Connect Analog Phone Cable

Step Five: Connect Analog Phone Cable
G2PT

The G2PT’s single phone jack design allows it to be used for either a 1 or 2 line system. The
number of PhoneTree lines you purchased will determine how many PhoneTree hardware units
you have. For example, if you have ordered a 4-line PhoneTree system, you will have two
PhoneTree units: one unit representing lines 1-2 and the other for lines 3-4. By using the supplied
cables and adapter, each PhoneTree unit can be configured to work with most any analog wall jack.
Using the examples below, choose the wall jack configuration that you will use and connect your
analog phone cable(s) as instructed.

Note: These illustrations represent connections for one G2PT PhoneTree hardware unit. If you
have more than one PhoneTree unit, you will need additional wall jacks enabled for each unit.

Single, Analog Wall Jack Duplex Analog Wall Jack
(1-Line PhoneTree Unit) (1-Line PhoneTree Unit)
or

Single, 2-Line Analog Wall Jack

(2-Line PhoneTree Unit) N

3]
g

®

Connect PhoneTree to either wall
jack using the 7-foot phone cable.

Connect PhoneTree to the wall jack
using the 7-foot phone cable. Duplex Analog Wall Jack
(2-Line PhoneTree Unit)

4-Wire Jack

2-Wire Jack

Connect PhoneTree to the 4-wire jack
on the duplex adapter using the 7-foot
The Duplex Adapter (included with each phone cable.

PhoneTree G2PT unit) has been specially
wired for exclusive use with the Duplex Analog

Duplex Adapter

Plug the adapter into either wall jack.

Wall Jack (2-Line) configuration. It will not Using the 4-inch phone cable, connect
serve as a standard splitter. This adapter is the 2-wire jack on the duplex adapter
not found in stores and is only sold directly to the remaining wall jack (see figure
from PhoneTree (www.phonetree.com/shop). above).



Installation: Connect Analog Phone Cable, continued

PT-400

Unlike the G2PT model, each phone jack located on the back of the PT-400 (see page 11) represents
one phone jack, or line card, inside the PhoneTree unit. The PT-400 does not require special phone
jack configurations. An individual, analog wall jack is required for each phone line board installed
inside the unit. Even though each PT-400 unit has four phone jacks, all may not be enabled.
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Pre-Configuration Steps: Verify Device Connection

Pre-Configuration

Before starting the PhoneTree software configurations, we recommend that the following steps are
completed. These steps have been designed to help ensure that your PhoneTree operates at its
fullest potential on your PC.

Step One: Verify Device Connection
Check to see if your PC recognizes your PhoneTree unit by doing the following:
Right-click the My Computer icon on your computer desktop and choose Properties.

b. Click on the Hardware tab and then the Device Manager button. Then scroll down to Universal
Serial Bus controllers.

c. Click on the + sign next to its icon.

£ Device Manager

File  Action Wiew Help
8 2
- E'.;, BIOMES

_g Cormpuker
“g Disk drives
»_é Display adapters
i DVDJCD-ROM drives
=) Floppy disk controllers
+] _ﬁ Floppy disk drives
+-(=) IDE ATAJATAPI controllers
+-z» Keyboards
+- ") Mice and ather pointing devices
+- % Manitors
+- B8 Metwork adapters
- 5 Ports (COM&LPT)
+ 9% Processors
+-@), Sound, viden and game controllers
+-%g Storage volumes

+] Syskem devices
- Universal Serial Bus controllers

B2 Intelir) 52501BA/BAM LUSE Universal Host Controller - 2442
= Intel(r) 5280 1BA/BAM USE Universal Host Controller - 2444
= PCS PhoneTree USE Line 01

= PCS PhoneTree USE Shared 01-04 (B)

= |ISE Composite Device

= LISE Root Hub

= LISE Roat Hub

[

d. You should see the following devices (exact descriptions vary) at a minimum:
Host Controller
USB Root Hub

PCS PhoneTree USB Line 01 (if you do not see the correct number of installed lines AND if
you have purchased more than 2 lines, follow the instructions in the Troubleshooting:
Checking DIP Switches section on page 166).

Other devices may be present. Leave this window open in order to complete the next step.



Pre-Configuration Steps: Disahle Power Management

Step Two: Disable Power Management

To manage power, Windows will attempt to disable USB functionality when a device is not used. As
the default behavior, this often does not work correctly and may cause Windows to not properly
recognize any USB device (including PhoneTree). Because the default power management setting
often causes problems for PhoneTree and other USB devices and because you already have the
Device Manager open, go ahead and change the setting by completing the following steps:

a. Under the the Universal Serial Bus Controllers
branch, right-click a USB Root Hub, and then
choose Properties (see picture at right).

£ Device Manager

File  Action Miew Help
&2 8 =§a
=2 DI0HES

j Cormputer

) e Dish drives

e é Display adapters

[&-[L DVD/CD-ROM drives

el =) Floppy disk controllers

e ﬁ Flappy disk drives

1=} IDE ATAJATART contrallers
- Keyboards

Mice and ather painting devices
w8 Monitors

= B Metwork adapters

wl- % Ports (COM & LPT)

-8 Processors

-8 Sound, wideo and game cantrollers
e Storage volumes

- iy System devices
= Universal Serial Bus controllers
Intel(r) 82801 BA4/BAM USE Universal Host Cor

Intel(r) 82801 BA/BAM USE Universal Host Cor

LISE ook Hub
<. FETE———.

Update Driver. ..
4 Disable >

Uninstall

CIpens prope

Scan for hardware changes

[Crrovertes

USB Root Hub Properties

. __.General Pawer Driver.J Power Management
b. Click the Power Management

tab. "é & WSEB Root Hub

c. De-select the “Allow the computer
to turn off this device to save
power” check box (see picture at
right).

d. Repeat Steps a-c for each USB
Root Hub in your Device Manager.

e. Click OK, and close the Device . -
Manager.

[ Asllows the computer ta turn off this device ta save power.




Pre-Configuration Steps: Turn Off PC Hibernation

Step Three: Turn Off PC
Hibernation

For Windows 2003 & XP:

The Windows hibernation or another power
management function sometimes interferes
with the operation of your PC when left
idle, which can cause problems when using
PhoneTree. To resolve this:

a.

Right-click on a blank area of your
desktop and choose Properties.

Click on the Screen Saver tab.

Disable your screen saver by choosing
“None” from the drop-down, then click
the Power button (see picture at right).

Once the Power Options Properties
window opens, click on the Power
Schemes tab. Make sure that the
settings for your selected scheme
include the Never setting for Turn off
monitor, Turn off hard disks and
System standby (see picture below
right). Now click on the Hibernate tab.

Make sure the Enable hibernation
option is NOT selected on this Hibernate
tab. Click OK, then click OK on the
Display Properties screen.

Display Properties

Themes Desklop‘i Screen Saver | Appearance Sett\ngs-

Moritor povwer
To adjust monitor power settings and save energy,

click Power,
Power.

[0S l[ Cancel ][ Apply

]

Power, Options Properties E]

Peower Schemes |Advanced-- Hibermate | UPS

Select the power scheme with the most appropriate settings for
thiz computer. Mote that changing the settings below will modify
the selected scheme.

Power schemes

| Minimal Poveer Management v!

Settings for Minimal Power M anagement pawer scheme

Turmn off monitor: ! Newer v|
Tum off hard disks: ‘ Newer v|
System standby: ‘ Newer w |

| 0K i [ Cancel ] [ Apply




Pre-Configuration Steps: Turn Off PC Hibernation, continued

FOI’ WindOWS ViSta: B Screen Saver Settings @

a. Right-click on a blank area of your [ sareensaver |
desktop and choose Personalization. |

b. Click on the Screen Saver link.

c. Disable your screen saver by choosing
None from the drop-down, then click on
Change power settings...

d. On the Power Options tab, under
Select a power plan, click Change

plan settings for the current power Sereen sauer

plan you are using. [money +| [ Settings.. Preview
e. Once in the Edit Plan Settings tab, set siti | 10 =] minutes [0 resume, display lagon screen

drop-down boxes for Turn off the Power management

dlsplay and Put the Computer to Sleep Consere energy of maximize perfarrance by adjusting display

brightness and other pouver settings,

to Never. Next, click on Change

advanced power settings. ange power settings

l oK H Cancel H Apply ]

f. From the list of advanced settings, click
the + sign next to the following items:

Hard Disk: set Turn off hard disk
after to O minutes. This will change M} Select the power plan that you want to customize, and

. then choose settings that reflect how you want your
the Settlng to Never. cornputer to ranage power,

& Power Options T | (53]

[ Advanced settings |

W) Charige settings that are currerthy unavailable

Sleep: set Sleep after and Hibernate

after both to O minutes. [Balanced [Activel -

Display: set Turn off display after to E adddit:”:' seitings £
. . . [+ Hari 15

O minutes and Adaptive display to T

Off.

m

When finished, click Apply and then OK. ; S'“;It:'. S
You will return to the Edit Plan Settings tab. . W,

Click Save changes to exit. Setting: Never
[ USE settings

& Praneer huttans and lid

[ f," Restore plan defaults

| Ok ] Cancel Apply




Pre-Configuration Steps: Get a Copy of Your Phone Book

Step Four: Get a Copy of Your Phone Book

Because the dialing rules are set by independent phone companies, varying from location to location
across the United States, and are continually being updated, you will need to tell PhoneTree how
your numbers must be dialed. This is a one-time setup step that will not need to be repeated unless
the dialing rules change for your location. The easiest way to get the dialing rules for your area is to
get a copy of the phone book issued by your telephone service provider and have it ready when you
complete the configuration steps on page 30. Your phone company may be able to provide a copy of
your phone book if yours has been misplaced.

We have also found the following website helpful in determining local dialing rules, although no
guarantees are made regarding the accuracy of the information: www.localcallingguide.com.



Pre-Configuration Steps: Hardware Functionality

PhoneTree Hardware Functionality (While In Use):
G2PT

Your PhoneTree unit has been designed to stand upright or, if you have more than one unit, stacked
on its side to save room.

While in operation, your PhoneTree will use the built in LEDs to display the activity. Below is a
description for each LED and how it functions:

Line 1 —|

Line 2 : w

Power —| {

Do
[ =22 0
— =
- -
- -
N _/

Stacked PhoneTree Position
(ideal for multiple units)

Standing PhoneTree Position
(ideal for a single unit)

L1 (Line 1): This yellow light illuminates only while your PhoneTree is making a call on Line 1 and
briefly turns off while switching between calls.

L2 (Line 2): Corresponds to the second phone line (if enabled) and is otherwise the same as Line 1
in color and functionality.

ON (Power): This green light illuminates while your PhoneTree has power, regardless of whether
it is making calls or not.

Interference

If your PhoneTree experiences radio interference while
making calls, install a ferrite clip on the phone cable close
to the PhoneTree’s phone jack.




Pre-Configuration Steps: Hardware Functionality, continued

PT-400

Always make sure the green power light is on to be assured that your PhoneTree system is able to
make calls. The speaker can be used to listen to any call activity for your line of choice or you can
connect the headphones to listen to them privately. For more information about listening to calls
and choosing which line to hear, please see page 84.

Speaker
B |
Power S o 458
Interference

If your PhoneTree experiences radio interference while making calls, install a ferrite clip on the
phone cable(s) close to the PhoneTree’s phone jack (see page 23).

24
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One-Time Configurations: Desktops

51 PhoneTree
Navigation Help

I Fionetice | toos |l tasks ] Admin Y CallConter JRALULLIC

Vé

PhoneTres 1

Al caling iz stopped. The CallCenter must be active for PhoneTree ta send or receive calls [Use Sound Ca

Desktops

Upon opening the PhoneTree software, you will be presented with the Desktop View. In this view,
you will see that the software is divided into five major sections; each represented by its own tab.
These tabs give access to each Desktop View and are an important part of using and navigating
through the PhoneTree software. Before you start configuring your PhoneTree, please read the
brief description for each tab to help you understand its specific function:

Lo

™ Call Center

The PhoneTree Desktop stores your call list(s) of names and numbers,
as well as your recorded message(s), unique call job settings and other
important features.

The Tools Desktop contains useful utilities that relate to your past and
present call jobs such as Call Logs. For more information on the Tools
Desktop, please see the help files within the software.

The Tasks Desktop stores any built tasks (macros), manual or
automatic, created for your call list(s). For more information on Tasks,
turn to page 93.

The InfoLine Desktop allows you to create up to 999 call-in InfoLines
(for access to assignments, announcements, schedules, directions, etc.).
This feature is only available with the 2500 and 3500 models. For
instructions on how to set up and use InfoLines, please see the help
files within the software.

The Admin Desktop contains several features that globally control
how PhoneTree makes calls in your area, as well as other settings. The
Admin Desktop will be discussed on the following pages.

The Call Center Desktop launches the Call Center from which all
actual phone calls are placed and received. For more information on
the Call Center, turn to page 83.



One-Time Configurations: The Admin Desktop

1 cotcomer LIS

£ iz = :
= 4 usied L H
&
Configure Phone  Configure Global — Configure Dialing Import Mernu Central Database
Lines Settings Translatar M anager

o
et
Anzwering AutaT ask Record Greeting  Blocked Mumbers  Administrator
M achine Manager [Hella] Passwords
Pt
Configure ehail Configure
OnDemand
Service
All calling is stopped. The CallCenter must be active for PhoneTree ta send of receive calls Use Sound Ca -

The Admin Desktop
Click on the Admin tab from the Desktop View.

To start the basic configuration of your PhoneTree system, you will first need to access the Admin
Desktop. The Admin Desktop contains several icons (varies with model), some of which globally
control how PhoneTree makes calls in your area and from your location. On the following pages,
you will learn how to configure the icons needed for your basic PhoneTree setup.

Note: Some features for each icon will not be discussed in this user guide, but have a complete
description contained within the help files. To access detailed help for any part of the software,
click Help from any screen.



One-Time Configurations: Configure Phone Lines

F

Configure Phone
Lines

Step One: Configure Phone Lines
First, click on the Configure Phone Lines icon.

On this screen, you will tell PhoneTree how it needs to access the analog phone line(s) you are
using. Some phone lines, usually with business phone systems, may require a Prefix (digit(s) that
must be dialed before the phone number) and/or a Suffix (digit(s) that must be dialed after the
phone number) to access an available outside line. If you have a direct analog phone line (i.e. a
phone line that is not part of a phone system), then you should not have to add a prefix or suffix to
complete a call.

If you are unsure of how your phone line(s) are set up, connect the phone line(s) you intend to use
with PhoneTree, one-by-one, to a standard, non-digital telephone and try making a phone call. You
will know if you need a prefix/suffix if you cannot complete the call by just dialing a phone
number on its own. If you do require a prefix/suffix to access an outside line and are unaware what
numbers to use, please contact your phone system company.

Configure Phone Lines Bl
Select line:
@ Detected [T Use different settings at night | | E o520 P bl g
2 Line use:
-3 " Anzwer calls anly
-4 72 0 * Make calls

v Line may answer when not making calls
I wait for dialtone before dialing

f# Touchtone dialing ¢ Pulze dialing

Optional line access and biling codes:

Prefi a7
Suffis: |

If phone numberis {17 digits or more, use

Prefix |8T

Suffi |

oK | LCancel | Diefaults | Test Line | Help

To enter a Prefix, type the number in both Prefix boxes followed by a “T” (wait for dial tone).

To enter a Suffix, first type the “T”, followed by the required number(s) in each Suffix box.

If your PhoneTree system is a multi-line setup, you may need to set a prefix and/or suffix for each
line. To do this, choose the next ascending number in the Select Line column (for example, “1” is
for Line 1, “2” is for Line 2, etc.) and repeat the process for each line that shows a green dot beside
the word “Detected.”

When you are finished, click OK.

For features not discussed for this icon or for more information, please click Help.
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Configure Global
Settings

Step Two: Configure Global Settings

Next, click on the Configure Global Settings icon.

5 Global Settings

Digling  Misc l Call Eenter] Desktop] Microphone] Software Updates] Emailer]

M ame of your organization [appears on printed reports]:

|Blue Ridge Group

Click on the Misc tab and enter your company’s name in the box labeled “Name of your
organization” (the name you type here will appear on the top border of the Desktop View as well as
any call reports generated in PhoneTree).

PhoneTree can automatically print, save as a file or e-mail reports for your call job results (see page
90). Enter the time you want your reports to generate in the Enable daily file maintenance to run
at box (default 1:00 AM). Note: The Call Center must be running during this time. It is
recommended the time set here be after your calls typically end for the day.

5 Global Settings

Dialing] Misc] Call Eenter] Desktop  Microphone | Saoftware Updates] Emailer]

™ Use the sound card in my PC to record/play messages

Micraphone style:

b '

" Microphone only é@
=

" Custom ‘{ 1 i
-l b,

Set the record volume for your microphone. Choose 'Microphone only' for
most unitz purchased before 07-2002. Choose Microphone in Headset' for
unitz purchazed after 07-2002. Choose 'Custom’ to enter your own settings
[pick walues that produce pleaging recording volumes).

Ok | Lancel | Defaults Help

Next, click on the Microphone tab.

Uncheck Use the sound card in my PC... and then set the microphone style to Microphone in
headset.

When finished, click OK.

For features not discussed for this icon or for more information, please click Help.
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T
Configure Dialing
Tranzlator

Step Three: Configure Dialing Translator
Click on the Configure Dialing Translator icon.

In this section, you will learn how to program the rules set by your phone company for dialing local
phone numbers in your area. You will need your phone book or local dialing information (refer to
page 22) for this step.

First, look in your phone book and find the local calling section for your city/town. Here, you
should find a section labeled “local dialing” that lists all the area codes local to you with their
corresponding exchanges. Since PhoneTree requires only the area codes that are local to you, do
not worry about obtaining any area codes that are only dialed long distance from your city/town. If
your phone book does not list your local area codes and exchanges, try contacting your phone company
for information or refer to the website link listed on page 22.

Area codes in my lizk
: Del

To add a local area code, click the Add button under Area codes in my list. On the following screen,
enter the area code and then press [Enter| on your keyboard.

Under each area code, via the area code drop

down box you will see three columns: 11 digit Calls made to area code ¥ | are most often dialed with:

(Long Distance), 10 digit (Metro) and 7 digit T 11digts  © 10 djfits i+ 7 digits
(Local). These columns are used for telling 16105551212 BI0ESH1212  HE5-1212
PhoneTree which exchanges for each area code

that are local and/or long distance. Since the local 11 digit 10 gt G
dialing information you obtain from your phone exchangss  eschfnges  ewchanges
company will list what is local, the concept here S A
will be to place the list of exchanges under the 11 a0 =
digit column and extract the local exchanges Eg;

from it. If you entered multiple area codes, you S04

will need to repeat this for each area code. 205
Remember, the concept here is to, one-by-one, %g?
move the exchange(s) that require a different )
dialing method to their appropriate column. For ‘gfg 3

example, with the button placed on 11 digit, let’s
say exchange number 231 was a local exchange. It
would have to be moved from the long distance

column to the local column. (331 6) - 5008

Area code Number

To move an exchange, click the Add button beneath the column you wish to move it to, type in the
exchange and press [Enter| on your keyboard; repeat as needed. When finished, press [Esc] on your
keyboard. Repeat this process for each area code that requires exchanges to be moved.

When finished, click OK.

For features not discussed for this icon or for more information, please click Help.

Add Add | B ‘
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Step Four: Import Menu Manager

Click the Import Menu Manager icon.

If you have a list of names and numbers stored in a file, PhoneTree can import that data using one
of the supplied translators to create your call list. The translators have been named based on the
file format they are designed to work with.

Import Menu Manager

Installed translators: [for importing data in a specific format] Select a translator to install::
Click to see details: =
Fii ol Details: AES__ImpDrt.exe
Sy W Display in drop down menu Ascilmpart. exe
gg\é” : : Centrall atabaselmport. exe
Dizplay az: (in drop down menu) Charvenware, exe
Central database Fored Col CSWImport exe
ined Colurnn : z
Riepart Reader Fixedimport. exe
Tranzlatar: ReportReader.exe
Eividi ' Servantt.eeper.exe
HEMEEAe Shelbylmport. exe
‘Wwhen importing, look for files with TotalChurchlmpart. exe
thiz extension: [eg: *.*, *.doc, etc.]

Template [ie: MuTemplate. mdb):

Uninztall Inztall

LCancel Help

The translators are separated into two different sections:

S

The left-side box shows the currently installed and ready to use translators which are for the most
commonly used file formats.

The right-side box shows the complete list of available translators including the few already installed
in the left box. If you are using a supported membership management or database software package,
you will need to install the correct translator.

To install a translator, click on your translator of choice in the right-side box and then click the
Install button. This will move a copy of the translator you chose to the left-side box. After the
translator moves, it is automatically named as “New!” in the Display as box under the Details
section. Rename the translator to the same name that it was in the right-sided box, without the
“.exe” as shown in the example above.

When finished, click OK.

For features not discussed for this icon or for more information, please click Help.
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Step Five: Configure eMail
Click on the Configure eMail icon.

PhoneTree can be configured to e-mail your call results as an AutoReport (see page 90) and/or
messages in text form (2500 and 3500 only, including SE) to e-mail addresses in your call lists.
The settings on this screen must correspond to a valid e-mail account, and you can get most of these
values from the E-Mail Accounts area of your e-mail program, such as Outlook or Outlook Express.

& Configure Emailer

E-Mail Settings

Please complete each field in order to ensure e-mail functionality.

User Information Server Information

YourName:  [laneDos  Hostame: [omaicervercom
E-mail Address: [janedoe@nattwestnet

Logon Information Test Settings

User Name: [laneDoz  After filing out all of the information on this

screen, it is recommended that you test your

Password: sssssssne seftings by using the buttons below. (Reguires

Network Connection)

Test E-ail Settings
More Sellings

aK LCancel

Enter the following information:
User Information:

Your Name - Enter your name here as you would like it to be seen by the people receiving
e-mails from the PhoneTree system.

E-mail Address - The e-mail address should be a valid e-mail address which corresponds to
all the other settings on this screen.

Logon Information:
User Name - This should be the exact user name you use to access this e-mail account.
Password - This should be the exact password you use to access this e-mail account.
Server Information:
Hostname - This should be exactly as you have it entered in your main e-mail program.

After you have completed each field, click Test E-Mail Settings. If everything is correct, you
should receive a “Test Succeeded” message, followed by a “Message Sent” dialog. Check your email
to make sure you received the sample message. If you receive a “Connection Failed” message, it
means that one or more of your settings are incorrect. Please access the help files for information
on how to troubleshoot this issue. When finished, click OK.
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Additional Icons

These icons refer to additional features you can use to further customize your PhoneTree. Below are
brief descriptions for each of these icons and what they do. Note: For a detailed explanation on how
to use and set up each of the icons, please reference the help files accessible via the Help button

located on any screen.
;@%

Central Databaze

Central Database is used to keep a master list of your contacts that may be used with the
PhoneTree system. Any time you wish to make a change to any of the contacts, you can make the
change here and then set individual PhoneTree icons to automatically sync with the Central
Database, so that changes need only to be made in one place.

Anzwering
M achine

Answering Machine allows you to set up your PhoneTree to act as an answering machine while it
is not making any outbound calls.

AugtoT azk
b anager

AutoTask Manager is part of setting up a Task. See page 93 for more information on Tasks.

Configure Remote
Cperation

Remote Operation lets you call in to PhoneTree and access most major functions including
recording your message, selecting whom to call, changing the calling times, and more (see page 107).

[ux]
[u]x]
0
O

Adrniniztrator
Pazswords

Administrator Passwords allows you to password-protect the Admin Tab.
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4)

Fecord Greeting
[Hella)

Record Greeting (Hello) allows you to create your own greetings or preview the pre-recorded
greetings shipped with the PhoneTree software.

Blocked Mumbers

Blocked Numbers stores any phone number hand-entered into this database or selected from the

List Editor screen (see page 172).

Configure
OnDemand
Service

Configure OnDemand Service allows you to set up an OnDemand account for times that you may
need to contact everyone on your call list quickly, for an emergency or other time-sensitive reason
(see page 113). Call sessions made with OnDemand carry a per-call charge and have message
time limits of 1 minute for calls placed with EasyCall and 2 minutes for the Call Wizard.

2500 SE and 3500 SE Users: If you have a PhoneTree 2500 SE or 3500 SE, it is required that
OnDemand is set up before you can make calls.

PhoneTree 2500 and up:

FPhoneT ree
Adrminiztrator

PhoneTree Administrator allows you to manage all of the PhoneTrees under the PhoneTree tab.
Here, you can rename, password-protect, lock and even change the number of PhoneTrees (up to
256) available.

2
Configure
Language Codes

Configure Language Codes allows you to program up to 99 different languages in your PhoneTree
for multi-lingual capability. You can use this feature with importing a file or by manually building
your call list in PhoneTree. This feature does not work for e-mail messaging.
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PhoneTree 3500 (and SE) only:

Configure Flex
Fields

Configure Flex Fields gives you the ability to configure parts of your message to change based on
the data PhoneTree reads from a file.

E
\K’D
Configure Test o
Speech

Configure Text-to-Speech gives you control over which Text-to-Speech engine you wish to use
(basic or advanced), the voice gender and voice quality settings (via the Advanced button).

Syste;n Conzole

System Console is an advanced feature that allows control over call options and other settings for
all the PhoneTrees in an expanded view. This feature should be used with caution! For more
information on how to successfully use System Console, please click the Help button.
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Your First Call Job

Your First Call Job

In the previous sections, you were shown the necessary steps to prepare your PhoneTree system to
make calls. Next, we suggest that you try making a test call to yourself to be sure your PhoneTree can
complete the call with no difficulty. This section will show you how to manually add yourself to the
call list, record a message and start calling using EasyCall, one of two ways to launch calls. After you
have completed this section, turn to the appropriate page number that covers the model of PhoneTree
you have purchased (see page 40) to access additional configurations. There you will find even more
configurations that will help you to customize your PhoneTree to meet your specific needs.

Note: The following screens may vary depending on your PhoneTree model.

"% PhoneTree V6
Navigation Help

o0 ||| Toos [ Tasks _|[ admin_ ] Phonelreg From the Desktop

View, click on the
. . PhoneTree tab, then,
=" Click the PhoneTree 1 icon. click on PhoneTree 1.

Name Mew File As...

s Save File ags:
PhoneTree X |Blue Ridge Group

\ Eisting Files:

You have no call list selected. Click OK to create a new file.

Click OK for the box that appears.
Then, enter a name for this
particular call list and click OK.

ak LCancel Help

'S PhoneTree

Fle Edt Tooks Wiew Search Setup Cal Import Help

You are now presented

Fe &a 4 i
Nlejw Open  Fint |, Add  Remove | Find liss  Fiter | Maibox o;?ms Easy‘)cau Wgrd :Sl( ngc Eﬁ 3 Wlth the List Editor
Blue Ridge Group
[ Tag[nam# [Phone [Translated [call Status [Replies Last Call Time__|Last Call Date SC.reen. From the tOp tOOIbar’
click Add.
Clck Add +
Add




Your First Call Job, continued

Add Person @

Enter required information:

Mame: |J0hn Doe

After the Add Person Phene:  [336-555-4444

window appears, enter
your name and corresponding
phone number for this test EM il |
call.](.)b. Repeat for any ' UriquelD |
additional entries you wish to
make. Click OK when
finished.

Enter optional information:

W Phone is required

S PhoneTree

File Edit Tools Yiew Search Setup Call Import Help

O @ @ =+ X | Q £ % @& ¢

MEw CIpEn Primk fdd  Remove Find Lisk Filker | Mailbox Opki
Blue Ridge Group
10| Tag|Hame Phone Tranzslated Call Status
p 1 O | John Doe 336-555-4444 1 336 555-4444 Mat Called et

You will now see your name and phone number added to the
list. You will also see a Translated phone number and a Call
Status displayed. The Translated phone number column shows exactly
how PhoneTree will dial that number by using the rules you set earlier

in the Configure Dialing Translator (see page 30). The Call Status
column shows whether or not an individual has been called and what
PhoneTree encountered during that phone call (i.e. Answered By
Person, Answered by Machine, Busy, etc.). For a complete list of call
statuses, see page 85.



Your First Call Jo, continued

n Click on the EasyCall icon from the top toolbar. K3

EasyiZall

Click Record to record EasyCall X

our message.
WL = ) j

b 7]
Re}j’l’lay Wolume | Help

. . H d d .............. )
lick Py listent |~ | Fesoidsounesageand [ Dk Cal 0 start

your message. your calls.

Call Tagged

Resume

Call Optionz

Cancel

N

[~ Use OnDemand service to make calls

To record your message, click Record and speak into the headset microphone after you hear
the beep. When you are finished, click Stop.

To review what was recorded, click Play.
Once you are ready to launch your call list, click Call.

Once Call is pressed, the PhoneTree will launch the Call Center. Turn to page 83 for more
information on what the Call Center is and how it operates.

If you would like to generate a report showing your call results once your call job is finished or
configure PhoneTree to automatically do this for you, turn to page 87.

Congratulations, you have completed your first call job!

As stated before, EasyCall is one of two methods for launching your call job. The other option
is using the Call Wizard - offering a walk-through interface, the option of saving your
message(s) and other call options such as e-mail messaging (2500 model and up). To take
advantage of the Call Wizard and additional configurations for any PhoneTree model, please
refer to the model number listings below and turn to its appropriate section. If you prefer to
use EasyCall to make your calls, please click Help for information on enabling additional call
options such as Night and Machine messages.

PhoneTree 2100 - Page 41
PhoneTree 2500 - Page 51
PhoneTree 3500 - Page 63
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2100: Let's Begin!

2100

Now that your PhoneTree 2100 is configured to work with your phone lines and dialing rules in
your area, you are now ready to set up your message. On the following pages you will be shown,
step-by-step, how to import your call list using a file, configure the call times, record a message and
start making outbound calls using the Call Wizard. If you prefer to use EasyCall to make your calls
once you have configured your call times and other options, please see page 40.

Note: Since this section only covers the basic call setup, some options and features are not
discussed thoroughly. For more information regarding any option or feature, please click a Help
button which will display information on that feature.

In order for PhoneTree to make or receive phone calls, the Call Center must be running
during your preset call times (see page 84).

Let’s Begin!



2100: Setting Up a Call Job

Setting Up a Call Job:

Navigation Help

ree | Tools [ Tasks [ Admin ][ Cal Centor | %&ﬁg 1 From the Desktop
View, click on the

~€———— (lick the PhoneTree 1 icon. PhoneTree tab, then,

Bl click on PhoneTree 1.

Name Mew File As...

Save File ax

PhoneTree2100

|B|ue Ridge Group

\ E xisting Files:

You have no call list selected. Click OK to create a new file.

Click OK for the box that appears.
Then, enter a name for this
particular call list and click OK.

Ok | LCancel Help

"5 PhoneTree2100 PhoneTree 1

File Edit Tools Yiew Search Setup Call BiysilEd Help ) 3 NOW lt iS time to
= Retrieve OnDemand Call Results . .
NEN OE‘I"I P%t »:!:I Regfove | T E 1mp9rt the flle
@ o v v /i EE that contains your name
Mailbox Options EasyCall Wizarg/ ASC ASCIT and numbers (Ol’ add
. E:;;at'::;:“ them one-by-one as
Click Import, |~ Ridge Group e described on page 38).
T o] 7agls| then choose Csv. [Translated [Call Status Replies | For this example, we
will use a CSV file. (If
your file requires a
different translator
other than CSV, please
choose that instead.)
Click Import at the top
of the screen and then
choose CSV.
KN 2
0/ ! Elue Fidge Yiew Sort: Mame MG |Calls Stopped [0




2100: Setting Up a Call Job, continued

Open Custom File for import

Browse to the file
to import. Click
Open.

Look in: | {2} Deskiop cF ER-
3. DM‘!' Documents
a '} My Computer
My Recent .*3 My Netwark Places
D°‘“"!e”“-‘ 2 eRidge.C5V
©
Desktop
My Documents
My Computer
3
My Network  File name [BlueFidge CSV Jd | Open
Places
Files of type: [ Al Files ) =l Cancel

Locate your file, then
click Open.

Click Overwrite existing file...

What would pou like to ith the imported data?

.Q\.t;rwrite
existing fil

Append to
existing file

Lreate new
file:

A window will appear asking you what

you would like to do, click Overwrite
existing file. When the next window appears,
click Configure before the timer runs out.

~—~

..then click Configure.

{8} Wait for Configy.re...

Click CONFAGURE to make changes

Impart wilf continue

7
autornagcally in

seconds...

Run Nove

CSV Configure

Click the drop-down hoxes to set
the data for each field.

44

Select Fils Type: ‘ Fied Fislds
2 Ski +] HeaderL s
 COMMA Separated  ( TAE Separated ip [0 eader Lines . = The CSV translator
Select how Name is imparted Select how Phone # imported e appearsA Using the
@ Last Fist ¢ FistLast ¢ Full ame " AC+Phone % PhonelINLY [rotised drop down boxes for Last

S Name, First Name and

Last/Ful Name: First Nuame: AresCods:  Phone ol used .
[Meghan + |adams - [336) 6489475 P Phone, .make the ChOIC§S
T ot used | appropriate to the data in
IMMAGADHL com N your file. Then, click OK.
123 Main Street Wiew Mt Line I I LCancel J

L —{w/inston-5alem
NC
27108 \ \ /
Midfield v



2100: Setting Up a Call Job, continued

ID] Tag|Hame Phone Translated Call 5ta
1 [|Adams, Meghan (336) 555-0475 Mot Calle
2| [O|Anderson, Rebecce|(336) 555-9949 Not Calk
3| [|Forester, Lauren (336) 555-3938 Not Calk
4| [J|Gonzalkes, Jessie | (336) 555-7911 Mot Calle
5| [|Horton, Maria (336) 555-5579 Mot Calle
6| [O|Morton, Carrie (336) 5554741 Mot Calk
7| O|Mory, Julia (336) 555-3354 Mot Callk
8| [J|Motzinger, Jenna | (336) 555-4354 Not Calk
9| [ |Mostitz, Carol (338) 555-2112 Mot Calle
10| [ Pirkle, Christina (336) 555-1410 Mot Calle
11| [J|Rabil, Emily (336) 555-6392 Mot Calle
12| [J|Rodgers, Sarah (336) 555-9513 Mot Calk
13| [O|Scott, Virginia (336) 555-3461 Mot Calk
14| [O|shaffner, Cynthia |(338) 555-3380 Mot Calle
15| [|Spangler, Katie (336) 5557677 Mot Calle
16| [ wWerkman, Anne (336) 555-0484 Not Calk

After your data

imports, you should
see your call list appear as
shown here. Make sure that
the data looks correct.

If you need to add another
entry to the list after the
file has been imported, click
the Add button from the
top toolbar. To remove an
entry, click on the name
and then click Remove.

n Click on the Options icon from the top toolbar.

@

Options

OnDemand
Times/ Diaps | Call Settings | Transfer | Adv Options | Adv Dialing | Remote| Copy | Cential Database |
Click on the Don't call —
B Allow calls ore W Sun Set Time e W wed W Thu v Fri v Sat
before/after times to St rrrearomeamros 3T v T e e ')i
when Phonelree starts | Dontealatter:  [E317M e ) [ e FE ETEN
and stops calling. et T [Ganrw [wane [Baor :
; ; o N et day Uncheck any day you don't
s she [~ Deldy start of call job untik ™ Temporarily Wam w make Ea"s on.

[Calicbisdone =]
Use the up and down arrows to
change the hour and minutes.

Make calls only between the DOM'T CALL BEFORE and DON'T CALL AFTER times. Check ALLOW DIFFERENT
TIMES FOR EACH DAY only if wou need ta call during different times for each day of the week.

The first tab of Call Options, Time/Days, allows you to tell PhoneTree which days of
the week and what time during those days you want to make calls.

Uncheck any day(s) you do not want to make calls on.

To change the Don’t call before and Don't call after times for all of the days of the
week, click on each of the time fields under Sun. A box will then appear. Use the four
arrows to adjust the hours and minutes. If you would like to set different times for each
day, select the Allow different times for each day box, then individually click on each
day to set the times.



2100: Setting Up a Call Job, continued

Call Options

OnDemand ]
Times/Days  CallSetings | Transfer | Adv Options | Adv Dising | Remote] Copy | Cential Datebase |
Call connection aptions: Job priority;
Max number of rings Choose priority: hid =
before mawing on ta nest call 3
Within call options:
Max number of call attempts
to unanswered numbers: % 15 v &llow star [%] key to repeat message
W Enable detection of early hang-Lps
Hang up if an Ans Machine = adtive for [0 nds of message
message is longer than [sec) I~ Bypass ans machines on first call sel m ] l]
wait this long after message [T Count "3 replies and stop calls;
for touch tone reply (sec) 2
oK ‘ e | Defauls ‘ Help

The Allow star (*) key to repeat message option allows the message to be repeated
if star is pressed by announcing it during your message. Uncheck if this is not desired.

Next, click on the Call Settings tab.

Leave the Call connection options to their default settings.

Set Enable detection of early hang-ups.... to 10 seconds.

Call Options

OrDemand

Don't call duplicates with same:
" Phone #
iMame and phore B

" Call all duplicates
Setto Name —" | °
Don't call numbers in
and phone #. ™ blacked rurber fst

Timnes! Days J Call Settings | Transfer  Adv Options l iy Disling | Pemate| Copp | Central Database |

Export data:
[ Create export file for use by another application

Call logging: ‘Log ALL Calls j

Deliver message to answering machines;

Alvays -
Daily caling:

™ Auto call each day

el | LCancel ‘

Help

Defaults |

Click on the Adv Options tab.

Set the Don’t call duplicates with same to Name and phone #.

Then, click OK.



2100: Setting Up a Call Job, continued

n Click on the Wizard icon from the top toolbar. ¥
Wizard

The Call Wizard will take you step-by-step through the various call options and how to record
your message(s) for your outbound calls. Unlike EasyCall, the Call Wizard allows you to save any
messages that you record for later use.

Call Wizard: Blue Ridge Group

The Call ‘wizaid will guide you through the advanced messaging options.

LCancel Help Lall Options:

m Upon opening the Call Wizard, click Next.

Call Wizard:, Blue Ridge Group

Select the message(s) you wish to record: [check all that apply).

Requied: [7 5tz ; [wour default meszage|

Optional: W Might [alternate message after hours)
W Machine [alternate message to ans. machines)
W Intro w/3 [request 'S to confirm call delivery|
W More Info [give more information after pressing #]
W Groups [use group messaging - see instractions]

LCancel Help LCall Options. . < Previous

Choose which message option(s) you would like to add in addition to your outgoing
message (for detailed information on each of these options, click Help), then, click Next.

4



2100: Setting Up a Call Job, continued

Call Wizard: Blue Ridge Group

= ® B B X J

Flay Record New Copy Delete | Wolume Help

Select each message type below and & corresponding message to play. Use the
controlz sbove to record and play, create a new meszage, or delete selected messages.

Cancel

Select:
" Greeting |Helln way j
@ Standard message w b
" Might | j
" Ans. machine | j
€ Intro [confim w9 | j
" More info | |

Lall Options...

<- Previous Nest >

The message options chosen on the previous screen will determine which and how many
of the drop-down boxes [i.e. Night, More Info] appear. Select the Standard message box.
Then, from the top toolbar, click New. A box will appear requesting a title for the message.
Enter a title for the message and then click OK. Repeat for each additional message option.

Call Wizard: Blue Ridge Group

F ® B B X

1| @

Play Record New

Copy  Delete

Wolume

Help

Arp messages in RED have not been recorded!

Select each meszage type below and a cormesponding message to play. Use the
contalz above to record and play, create a new message, or delete selected messages.

Cancel

Select

Gresting |He\|o.wav

O

Standard message

Might

Intro [confimn w.S)

|
Ang. maching |
|
|

R R R

Mare info

LCall Optionz...

<- Previoug Newt >

Next, one-by-one, you will need to record each message option. Click Record from the top
toolbar and speak into the headset microphone after you hear the beep. Click Stop when
finished. To review what was recorded, click Play. Repeat for each message option. When
finished, click Next.
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Call Wizard: Blue Ridge Group

Select whom to notify, and click "0OK" to start
Select:

@ MNotty [emiele  v]
" Resume |Tagged

™ Save changes and exit

[T Check if you wigh to use the OnDemand service to place your calls

Cancel Help LCall Options... <- Previous oK

In the Notify drop down box, either choose the Entire List view (all members will be
notified), or any custom view you have set up or Tagged (only the members checked on
the call list will be called). Then, click OK to launch your call job.

Confirm Start Job

“Y'ou are about to contact 16 people
usging the view: Entire List
of the Blue Ridge Group.mdb list.

[The final count may be reduced after removal of
duplic-ates, blocked numbers etc.)

Do you wizh to continue?

[ Dont show this dislog again.

Once you press OK, the Confirm Start Job window will appear showing how many people
you are about to call and asking if you wish to continue. If you are ready to start your calls,
click Yes. If you click No, you will exit the Call Wizard completely.

After you click Yes, this will launch the Call Center. Turn to page 83 for more information
on what the Call Center is and how it functions.

If you would like to generate a report showing your call results once your calls are finished
or configure PhoneTree to automatically do this for you, turn to page 87.
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2500: Let's Begin!

2500

Now that your PhoneTree 2500 is configured to work with your phone lines and dialing rules in your
area, you are now ready to set up your message. On the following pages you will be shown, step-by-
step, how to import your call list using a file, configure the call times, record a message, set up e-mail
messaging, set up multi-lingual messaging and start making outbound calls using the Call Wizard. If
you prefer to use EasyCall to make your calls once you have configured your call times and other
options, please see page 40 (EasyCall does not contain all of the call features that are available with
the Call Wizard).

2500 SE users: If you have the 2500 SE, you will use the same instructions supplied here to record
your message(s) and make your calls. Please make sure you have already set up your OnDemand
account before proceeding (see page 113).

Note: Some options and features are not discussed thoroughly. For more information regarding any
option or feature, please click a Help button which will display information on that feature.

The next page lists the additional Admin icons included with the 2500 and 3500 models.
Please review the information provided for these icons before you begin setting up your calls.

In order for PhoneTree to make or receive phone calls, the Call Center must be running
during your preset call times (see page 84).

Let’'s Begin!
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Additional Admin Desktop Features (2500 and up):

PhoneTree
Adrniniztrator

PhoneTree Administrator

The PhoneTree Administrator tool allows you to manage all of the PhoneTrees under the PhoneTree
tab. Here, you can rename, password-protect, lock or change the number of PhoneTrees available.
For more information regarding this icon, please click Help.

Configure
Language Codes

Configure Language Codes

Your PhoneTree has the ability to deliver vocal messages in different languages to members in your
call list (this feature does not work for e-mail messaging). You can use this feature with importing a
file or by manually building your call list in PhoneTree.

g | @
Print Help

#|Lang code Language s
0(E Englizh
1(5 Spanizh
2
2
F]
5
E
7
2
E]
10
1
17
13
14]
15!
18]
v -

aK

Each language that will be used with your PhoneTree will need to be entered and assigned a code to
represent it (i.e. “E” for English, “S” for Spanish, etc.) under the Lang code column. Then, under
the Language column, enter the name of the language as shown in the example above.

Note: If you plan on importing a file and have a field on the file that contains the language code, be
sure that the codes entered here match what appears on the file. If you are building your list by
adding members to the call list manually, you can set the language for each member by choosing
from what you have added here. If there is no language assigned to a member, then the default
language, #0, will be used for them.

For features not discussed for this icon or for more information, please click Help.
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Setting Up a Call Job:

5 PhoneTreez500 V6

Navigation Help

Phonelree

W

N 3

rencice e
PhonsTres 7 PhoneTres 8

Proretee
PhoneTree 1 PhoneTree 2 PhoneTree 3 PhoneTree 4 PhoneTree § PhoneTree §

From the Desktop

View, click the
PhoneTree tab, then, click
PhoneTree 1. The other
PhoneTree icons can be
used for additional call lists
(up to 256, using the
PhoneTree Administrator).
Repeat this section to set
up another PhoneTree for a
different list and message.

PhoneTree2500

You have no call list selected. Clidk OK to create a new file.

Click OK for the box that appears.
Then, enter a name for this
particular call list and click OK.

Name Mew File As...

Save File as:

|Blue Ridge Group

\ Existing Files:

LCancel Help

% PhoneTree2500
File Edit Tools View Search Setup Call BOsSESE Help
& ﬁ’f‘. ﬁ | + x Retrieve OnDemand Call Results
New Open Print Add Remave: et ok
@ 9 ¥ w4
Mailbox Options EasyCall Wizard  ASC ASCIT
Central database
Report Reader
Blue Ridge Group
] ID] Tag{l‘lama ]Phone 1Trans|ﬁted ]Cal\slatus Replies
| I
o/0 | Entire List | Sort: Mame Calls Stopped B

o4

3 Now it is time to
import the file that

contains the names and
numbers (or add them
one-by-one as described
on page 38). For this
example, we will use a
CSV file. (If your file
requires a different
translator other than
CSV, please choose that
instead.) Click Import at
the top of the screen and
then choose CSV.



2500: Setting Up a Call Job, continued

Open Custom File for import

Lock in @ Desktop
; 5 ﬁrJMy Documents
- '_e My Computer
My Recent ~~jl\“ly Metwork Places
DOWS ) y
@
Desktop
Browse to the file to
7} import. Click Open.
My Documents
My Computer
“
My Network  Fils niame: |BlueFidge CSV =l Open
Places
Files of type: | Al Files (") =l tamed

“What would pou like to do with the imported data?

Lreate new

Dwenarite fippend to
file:

i edisting file £ exigting file

\ I Wait for Configure. ..

A window will appear asking you what Click CONFIG URE to make changes
you would like to do, click Overwrite

existing file. When the next window appears,

click Configure before the timer runs out. Importwill continue 5 o Je
automatically in

Configure: Fun Mow

SV Configure
- Select File Type: | Fired Fields:
& COMMA Separated " TAB Separated Skip |0 ~| Header Lines I
= | er— The CSV trgnslator
Select how Name s imported Select how Phone # imported — appears. Usmg the
& Last.Fist © FirstLast ¢ Full Mame " AC+Phone & PhoneOMLY i d drop dOWl’l boxes for LaSt
P Name, First Name and
Last/Full Mame: First Mame: Area Code: Fhone: BiLzed :] Ph 1 h h .
[Meghan x| [adame | [336) £46-8475 = || M one, Ama ke the ¢ o1c§s
rotused = appropriate to the data in

33E) b55-9475 = | | 2 . .
IMMAGAGHL com J your file. Then, click OK.

123 Main Street iew Mext Line ] 147 0K I Lancel
Winston-S alem
NC

27108
Midfield
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After your data finishes
importing, you should

ID| Tag|Hame Phone Translated Call Sta see your call list appear as

1| [J|Adams, Meghan | (336) 555-0475 Not Calk shown here. Make sure all

2| [O|Anderson, Rebecce| (336) 555-9949 Not Calk intended fields re imported
3| [J|Forester, Lauren | (336) 555-3938 Notcale ~ Lrrrended hields were imported.
4| [O|Gonzakes, lessie |(336) 555-7911 Mot Calk Some fi lel‘%s are not available
5| [J/Horton, Maria (336) 555-5579 Not Calk in the Entire List view. To

6/ [J|Morton, Carrie (336) 555-4741 Not Calk create a custom view to

7| [O|Mery, Jula (336) 555-3354 Not Calk include or change which

8| [O|Motsinger, Jenna | (336) 555-4354 Mot Calk columnsyou see here, see

9| [J|Mostitz, Carol (336) 555-2112 Not Calk page 103
10| [J|Pirkle, Christina | (336) 555-1410 Not Calk
11| [|Rabil, Emiy (336) 5556392 Not Calk If you need to add another
12| []|Rodgers, Sarah  |(336) 555-9513 Not Calk entry to the list after the file
13 [|=cott, Virginia (336) 555-3451 Mot Calk has been imported, click the
14| [|shaffner, Cyr!thia (336) 555-3889 Mot Calk Add button from the top
15| [|Spangler, Katie (336) 555-7677 Not Calk toolbar. To remove an entry
16| [ werkman, Anne (336) 555-0464 Mot Calke ) ’

click on the name and then
click Remove.

n Click on the Options icon from the top toolbar.

@

Qptions

)ptions

Email I OnDemand I

Alowealson W Sun  EERUMUSNEN: [V Wed

Times/ Diays | Call Settings | Transter | Adv Optiors | Adv Dialing | Remmote| Gopy | Certral Databass |

W Thu

¥ Fii ¥ Sat

Don'tcall before: [D:30aM | =) = & B[00 5000

= =i
Dont call after:  [05:30 PM  e— PM, [ 8.2

Use Might [0530PM [T50 [05:3 [os:
Message after:
[ allow different times for each day

Sl s e [~ Delay start of call job unti:

Call job is dane -

[~ Temporarily pause calls:

Make calls only between the DON'T CALL BEFORE and DOM'T CALL AFTER times. Check ALLOW DIFFERENT
TIMES FOR EACH DAY only if you need to call during different times for each day of the week.

The first tab of Call Options, Time/Days, allows you to tell PhoneTree which days of
the week and what time during those days you want to make calls.

Uncheck any day(s) you do not want to make calls on.

To change the Don’t call before and Don't call after times for all of the days of the
week, click on each of the time fields under Sun. A box will then appear. Use the four
arrows to adjust the hours and minutes. If you would like to set different times for
each day, select the Allow different times for each day box, then individually click

on each day to set the times.
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Call Options

Ema\l] DnDemandl
Times/ Daye  Call Seflings | Trarster | Adv Options | Adv Disling | Remote| Copy | Certial Database |

Call connection aptions: Job priarity;

tid -

Man number af rings Chaase priority:

before maving on to nest call 3
Max number of call attempts i) OD“DHS;
to unanswered humbsrs: 15 v Allow star [%] key to repeat message

W Enahle detection of early hang-Lps
Hang up if an Ans Machine = adtivefor [0 seconds of message
message is longer than (sec) ™ Bypass ans machines on first call attempt
“Wait this long after message [T Count"3" replies and stop calls:
for touch tone reply (sec) 2

oK ‘ e | Defauls ‘ Help

Next, click on the Call Settings tab.
Leave all of the Call connection options to their default settings.

The Allow star (*) key to repeat message option allows the message to be repeated
if the star key is pressed by announcing it during your message. Uncheck if this is not
desired.

Set Enable detection of early hang-ups.... to 10 seconds.

Call Options

Email| OnDemand |
Timas/ Diays | Call Settings | Transter  Adv Options | Adv Dialing | Remote| Gopy | Certral Datsbacs |

Don't call duplicates with same: Export data:
" Phone # [ Create export file for use by another application
@ B d phore 1 : ;
5 EISNEE I Allow networl: clients to view call status of this list
= Call all duplicates

Calllgging: |Log ALL Calls =l
Dot call numbers in
blocked number list

<l

Deliver message to answering machines:
Always -

Daily calling
™ Auto call each day

Ok | LCancel | Defaults | Help

m Click on the Adv Options tab.
Set the Don’t call duplicates with same to Name and phone #.

Then, click OK.
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¥

n Click on the Wizard icon from the top toolbar.
Wizard

The Call Wizard allows many options for different types of messages (as opposed to using
EasyCall). Using the Call Wizard, you can create the standard recorded message or, add several
different message options such as a Night Message. You can set up e-mail messages, multi-lingual
messages and even use touch tone responses with your message for surveys or to have someone
respond to certain parts of your message.

This section covers three types of messages you can configure in the Call Wizard: Standard, Multi-
Lingual and E-mail. The instructions for each type of message have been separated for each screen
and allow you to set up one type of message or all three at once if you choose. Note: The Multi-
Lingual message requires the Standard message to be configured at the same time in order for it to
properly work; Standard and E-mail alone do not.

At any point during the setup of the Call Wizard you do not understand a specific function or want
more information, click the Help button.

Call Wizard: Blue Ridge Group

The Call ‘wizard will guide you through the advanced messaging options

[T Check if you wizh to create multi-ingual messages

[~ Check if vou wish to send an e-mail messags

LCancel Help Lall Options: A THE: Mext >

m To set up a Standard Message
Upon opening the Call Wizard, click Next.

To set up a Multi-Lingual Message
Upon opening the Call Wizard, click on Check if you wish to create multi-lingual
messages, then, click Next.

To set up an E-mail Message
Upon opening the Call Wizard, click on Check if you wish to send an e-mail message,
then, click Next.
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Call Wizard: Blue Ridge Group

The Call'wizard will guide yau through the advanced messaging options.

W Check it you wish to create multilingual messages

W Check. if you wish to send an e-mall message

% | want to zend a phone call and e-mail
™ | want to zend an e-mail only
" | want to zend e-mails (but call if e-mai iz blank]

Chooze one:

LCancel Help Call Options.. Brevious Hext -»

m E-mail Message continued...

Choose from one of the three choices for sending e-mail messages, then, click Next.

Call Wizard: Blue Ridge Group

Select the message(s] you wizh to record: [check all that apply)

Required: [7 Siand [wour default meszage)

Optional: [ Might (alternate message after hours)
W Machine [alternate message to ans. machines)
¥ Intro wg (request '9' to confirm call delivery]
¥ More Info [give mare information after pressing #)

W TT Response [Message change on TT receipt]

LCancel Help Lall Optians... <- Previous

m Standard Message continued...
Choose which message option(s) you would like to add in addition to your recorded
message (for detailed information on each of these options, click Help), then, click Next.

Multi-Lingual Message continued...
Choose which message option(s) you would like to add in addition to your recorded
message (for detailed information on each of these options, click Help), then, click Next.
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Call Wizard: Blue Ridge Group

- @ B B X J

Play Record MNew Copy Delete | “Yolume Help

Select each message type below and a corresponding message to play. Use the -
controls above to record and play, create a new message, or delete selected messages. | - English %

Create a mezzage of each type for each available language at the right,

- Giectng [Hello wav ~|
% Standard message e R

¢ Hight | =~
" &ns. machine | j
" Intro [confim wid) | j
" More info | j

LCancel Lall Options. . <- Previous Hext >

m Standard Message continued...

The message options chosen on the previous screen will determine which and how many
drop-down boxes [i.e. Night, More Info] appear. Select the Standard message box. Then,
from the top toolbar, click New. A box will appear requesting a title for the message. Enter
a title for the message and then click OK. Repeat for each additional message option.

Call Wizard: Blue Ridge Group
e x I @

Play Edit Mew Copy Delete | “olume Help

Any mezzages in RED have not been recorded!

Select each message type below and a coresponding messzage to play. Uze the
controls above to record and play, create a new message, of delete selected messages. | - English b
Create a mezsage of each type for each available language at the right.

Select:

Gresting | Hello.way :J

Standard meszage

~
&
" Might
~
~
~

Anz. machine

|
|
Intra [confirm w9) |
|

Maore info

LCancel LCall Dptionz. <- Previous Mext >

m Standard Message continued...

Next, one-by-one, you will need to record each message option. Click Record from the
top toolbar and speak into the headset microphone after you hear the beep. Click Stop
when finished. To review what was recorded, click Play. Repeat for each message option.
When finished, click Next.

Multi-Lingual Message continued...

First, change the language from English to a different language via the drop-down box in
the top right corner. Then, record each message option for that language. Repeat for each
language. When finished, click Next.
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Call Wizard: Blue Ridge Group

b
Play Fecord New  Copy

Select:

Touch Tone

185PONSe Messanes,
Choose which TT's
support alternate
messages and
create messages for
each.

LCancel

b 4 J

Delete | Yolume Help

& 111 [inset =] | ~|
T2 | i | Languages:
173 |Switch Ta - English -
T4
TTS |OFF :" Any messages in
e [or <] ot

7 [oFF ~
e [oFF ~
e [oFF ~

Call Options... <- Previous Hext -»

i

Standard Message continued...

If you chose TT Response as a message option, you will see this screen. The touch tone
reply numbers you choose here should coincide with what you mention in your message
(for detailed information on how to set up a touch tone reply, click the Help button from
the top toolbar). When finished, click Next.

Multi-Lingual Message continued...

If your multi-lingual messages use the touch tone reply feature too, you will need to record
those as well. First, change the Languages drop-down box from English to a different
language, then proceed with recording the touch tone replies as with the English message.
When finished, click Next.

Call Wizard: Blue Ridge Group

Enter a subject, optional attachment, and type your e-mail message in the space below.

Subject

Attachment
[optionall: | Browse

Message Text

|Blue Ridge heeting Feminder

Al

at Bpm

Cancel Help

This iz reminder about our meeting on June 3rd. Please make sure you can attend. ‘e wil start promptly

Thark yaul

Call Options.. <- Previous

E-mail Message continued...
Enter a subject and message for your e-mail here. If you wish to send an attachment, click
the Browse button to locate and include it with the e-mail. When finished, click Next.
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Call Wizard: Blue Ridge Group

Select whom to notify, and click "0K" to start.

Select:

T
" Hesume |Tagged

™ Save changes and exit

[T Check if vou wish to use the OnDemand service to place your calls

LCancel Help LCall Options... <- Previous oK

m All Messages
In the Notify drop down box, either choose the Entire List view (all members will be
notified), or any custom view you have set up or Tagged (only the members checked on
the call list will be called). Then, click OK to launch your call job.

Confinm Start Job

“Y'ou are about to contact 16 people
uszing the view: Entire List
of the Blue Ridge Group.mdb list

[The final count may be reduced after removal of
duplic-ates, blocked numbers etc.)

Do you wizh to continue?

[T Dont show this dialog again.

Once you press OK, the Confirm Start Job window will appear showing how many
people you are about to call and asking if you wish to continue. If you are ready to start
your calls, click Yes. If you click No, you will exit the Call Wizard completely.

After you click Yes, this will launch the Call Center for the 2500 or the OnDemand
Packager for the 2500 SE.

For information on what the Call Center is and how it functions, see page 83.
For information on how to initiate the OnDemand Packager, see pages 123-124.

If you would like to generate a report showing your call results once your calls are
finished or configure PhoneTree to automatically do this for you, turn to page 87.
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b4

3500

Now that your PhoneTree 3500 is configured to work with your phone lines and dialing rules in your
area, you are now ready to set up your message. On the following pages you will be shown, step-by-
step, how to import your call list via a file, configure flex fields, configure the call times, record a
message, set up e-mail messaging, set up multi-lingual messaging and start making outbound calls
using the Call Wizard.

If you do not need these advanced options and prefer to use EasyCall to make your calls once you
have configured your call times and other options, please see page 40 (EasyCall does not contain all
of the call features that are available with the Call Wizard).

3500 SE users: If you have the 3500 SE, you will use the same instructions supplied here to record
your message(s) and make your calls. Please make sure you have already set up your OnDemand
account before proceeding (see page 113).

Note: Some options and features are not discussed thoroughly. For more information regarding any
option or feature, please click a Help button which will display information on that feature.

The next page lists the additional Admin icons included with the 3500 model only. Please
review the information provided for these icons before you begin setting up your calls.

In order for PhoneTree to make or receive phone calls, the Call Center must be running
during your preset call times (see page 84).

Let's Begin!
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Additional Admin Desktop Features for 3500 (and SE) only:

Configure Flex
Fields

Configure Flex Fields

Flex Fields give you the ability to configure parts of your message to change based on the data
PhoneTree reads from a file. For instance, you could set up a Flex Field called “Location” and within
that Flex Field, have three different locations. In your message, you could insert the “Location” flex
field and depending on the location each member of your call list is listed with, that location would
play back during the message. The field would change based on the location the person was assigned
to either by a manual list build or by reading a file.

It is recommended that you first set up any Flex Fields you plan to use as part of your
message before you begin the instructions on the next page.

If you plan on using the Alternate Phone Numbers feature (page 71), which will allow you to try
two additional phone numbers per member (up to three phone numbers), you will need to set up a
flex field for each of those.

%

D:nnﬁgure'T ext b
Speech

Configure Text-to-Speech

The Text-to-Speech software included with your PhoneTree system allows you to have any part of
your message spoken by the Text-to-Speech software instead of your voice. Later in the Call Wizard,
you will be shown how to enable this option for your messages. For more information on how to use
Text-to-Speech, please click the Help button.

Syztem Conzole

System Console

This is an advanced feature that allows control over call options and other settings for all the
PhoneTrees in an expanded view. This feature should is for advanced users only! Please call
Customer Support for supervision or click the Help button.
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Configuring a Flex Field

It is recommended that if you plan on using a flex field with your message that you first configure
it before setting up PhoneTree to make calls. This section will discuss how to edit a flex field by
using an example called “Office Location.” This example will also be used later in the chapter to
illustrate how to use the flex field with your message. If you are not planning on using flex fields
with your message, proceed to page 68.

5 Configure Flex Fields

g =2 » |+ 7 X

Print  Scan Clearal Add  Modify Delete

@
Help

This flex field is bazed on a et list: & Yes Mo

Select & Flex Field:
[Right click to edit] Speak this field as:

< Flex Date » A | Text >| R
|< Flex Time > 3 I -‘J
Farmat zettings:

Mot uzed
Mot uzed
Mot uzed
Mot uzed |
Mot uzed E

Mot uzed &

Mot uzed ‘

Click
on an
item ko
reorder

e

Mot uzed
Mot uzed
Mot uzed
Mot uzed
Mot uzed
Mot uzed
Mot uzed
Mot uzed |

oK I

a) From the Admin Desktop, click on Configure Flex Fields.

Under the Select a Flex Field column, the first two flex fields listed are Flex Date and Flex Time.
These flex fields are preconfigured to allow the time and/or date from your file to be announced in
your message if you choose to include them. Skip to the third flex field, [Not used].

= A v | = B - -~
Print  Scan  ClearAll Add  Modify Delete

Thiz flex field iz based or
Select a Flex Field:

(Right click to edit] Speak this field as:

< Fler Date » | !Te:-:t r
< Flex Time » l =

=:
[ Mot used ] [ F

[Matused] | SettoNotUsed |

[ Mot uzed ]
[ Mot used ]

[ Mot uzed ] - |
[ Mot uzed =

rRl o (1

Office Location v X

b) Right click on [Not used] and then choose Edit. Enter a name for the flex field and then click
the green check mark.
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Configure Flex Fields.

g @ 2+ 7 X0

Print  Scan  Clearal Add  Modify Delete

This flex field is based on a et list: & Yes " MNo

Gelect a Flex Fisld:
[Right click to edit] BIEESGE 5 Add flex item

< Flex Date » | IText
< Flex Time > = ; e
Flex item description:
Faormat set

Mat used
NEt 3§:d lsmh Dffice

Mot used
Mot uzed Mapz to this value from source data:
Mot used
Mot used
Mot used
Mot used
Mot used
Mot used
Mot used
Mot used
Mot used
Mot used
Mot used

]su

Ok I LCancel

1=

oK

¢) Once you have created a name for the flex field, you will need to add the items for it. Using our
example, Office Location, we have four locations that will be added: South, North, East and West
Offices. Each of these locations will be given a name and a value that lets us know how to identify it
on the file that will be imported. For instance, the above example shows South Office in the Flex
item description box and “SO” for the Maps to this value... box. The Flex item description will
represent how the location appears on the call list and the Maps to this value... is the data we are
looking for from the file we import. Later in this chapter, we will discuss how to set a flex field to
look for the intended data from the file.

To add an item to a flex field, click Add from the top toolbar and then enter the Flex item
description and Maps to value... Repeat for each item.

W Configure Flex Fields

S = 9

Print  Scan  Clearall

+ » X‘O‘

Add  Modify Delete | Help
Thiz flex field is based on a set list: & Yes (" MNo

Gelect a Flex Field:
[Right click to edit) Speak this field as:

< E:E"‘ ?_ate : o) I_ '! Description [ Maps to:
Srpelre s . | South Office 150
Not used Bl o North Dfice N0

Mot uged East Office :J
Mot uged
Mot used
Mot uged
Mot uged
Mot uged
Mot uged
Mot uzed
Mot uged
Mot uged
Mot uged
Mot uged
Mot uzed
Mot used

I«

oK

In this example, we see how each item appears after being added. For more information on how to
set up Flex Fields, click the Help button located within.

Continue to the next page when you are ready to set up your PhoneTree to make calls.
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Setting Up a Call Job:

_5 PhoneTree3500 V6

Navigation Help

R R R TR Pholie

) )
Pronsies

0 M )
roncte | oo

)

raniee| rensies

&

)

M
oo

PhoneTree 7 FhoneTiee 8

PhoneTree 1 PhoneTree 2 PhoneTree 3 PhoneTree 4 PhoneTree § PhoneTree &

1 From the Desktop
View, click the

PhoneTree tab, then, click
PhoneTree 1. The other
PhoneTrees can be used for
additional call lists (up to
256 using the PhoneTree
Administrator). Repeat this
section to set up another
PhoneTree for a different
list and message.

PhoneTree3500

You have no call list selected. Click OK to create a new file.

Click OK for the box that appears.
Then, enter a name for this
particular call list and click OK.

Name Mew File As...

Save File as:

E xisting Files:

|Blue Ridge Group

LCancel Help

_5i PhoneTree3500

File Edit Tools View Search Setup Call Byl Help

D ﬁ ﬁ + x Retrieve OnDemand Call Results

New  Open  Print Add  Remove E—
@ 9 v v i [E=
Maibox Options EasyCall Wizard — ASC AscIl
Central database
Report Reader
Blue Ridge Group
0] Tag[unique D Name Fhone [Transiated Call Status [Replies <]

4 i K
0/0 Entire: List | Sort: Mame 45 Calls Stopped

A

| OnDemand: Idle

3 Now it is time to
import the file

that contains your name
and numbers (or add
them one-by-one as
described on page 38).
(If your file requires a
different translator
other than CSV, please
choose that instead.)
Click Import at the top
of the screen and then
choose CSV.



Open Custom File for import

3900: Setting Up a Call Job, continued

Look in: | (&} Deskiop j =
5. ﬁDMy Documents
.’ -} My Computer
My Recert ‘*3 My Network Places
WS JueRidge. C5Y
-
Desktop
My Documents
My Computer
.
My Network ~ File name: [BlueRidge C5V | Open
Places
Files of type: |N\ Files "7}

Browse to the file
to import. Click
Open.

What would pou like to do with the imported data?

Append to
existing file

Lreate new

file

A window will appear asking you what
you would like to do, click Overwrite

Wait for Configure...

Click CONFIGURE to make changes

existing file. When the next window appears,

click Configure before the timer runs out.

Irmpart will continue 7

seconds...

autornatically in

Run Nove

SV Configure

Select Fils Type:

(¢ COMMA Separated

" TAB Separated

|Sk\p 0 | Header Lines [[8]

Fixed Fislds:

not used b
Select how Mame is imported - Select how Phone # imported epmres
@ Last,Fist O FirstLast  Full Name * AC+Phone = PhonsONLY [rotues =]
E-Mail &ddress
Last/Full Name: First Name: Area Code: Phore: ot used :"
s | [Meghan ~| (336) BEG-0475 ~| || FIM
not used =
Select Flex Fields:
Flex Date Flex Time Mot used Not used Mot used
|notused _VJ |nolusad _'J |notused _'J ‘nulusad _'J |notused _'J
Mot used Notused Mot used Not used Mot used
[not used ~ Tnot used ~| [not used ~ Tnotused v [not used ~l

The CSV translator

appears. Using the
drop down boxes for Last
Name, First Name and
Phone, make the choices
appropriate to the data in
your file. Also, if your file
contains e-mail addresses,
multi-lingual codes or any
data that will act as a Flex
Field, set those fields as
well. When finished, click
OK.
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Iy Tag|Hame Phone Translated Call S5ta
1 | Adams, Meghan (336) 555-0475 Mot Calle
2| [O|Anderson, Rebecce| (336) 555-9949 Mot Calk
3| [O|Forester, Lauren (336) 5558038 Not Calk
4| [OJ|conzales, Jessie |(336) 555-7911 Mot Calk
5| [OJ|Horton, Maria (336) 555-5579 Mot Calk
& [J|Morton, Carrie (336) 555-4741 Not Calk
7| O|Mory, Julia (336) 555-3354 Mot Calle
8| [O|Motsinger, Jenna | (336) 555-4354 Not Calk
9| [|Mostitz, Carol (336) 555-2112 Mot Calk
10| [J|Pirkle, Chrigtina (336) 555-1410 Mot Calle
11 [ | Rabil, Emiky (336) 555-6302 Mot Calle
12| [O|Rodgers, Sarah (336) 555-9513 Mot Calle
13| [O|Scott, Virginia (336) 555-3461 Mot Calle
14| [J|Shaffner, Cynthia |(336) 555-3889 Mot Calk
15| [J|Spangler, Katie (336) 555-T677 Mot Calle
16| [J|Werkman, Anne (336) 555-0464 Mot Calk

Click on the Options icon from the top toolbar.

7 After your data imports,
you should see your call

list appear as shown here.
Make sure that the data looks
correct. Some fields are not
available in the Entire List
view. To create a custom
view to include or change
which columns you see here,
see page 103.

If you need to add another
entry to the list after the file
has been imported, click the
Add button from the top
toolbar. To remove an entry,
click on the name and then
click Remove.

Oplions

all Options.

OnDemand

Allow callson: W Sun

Don't call before: | 0530 AM
Don't call after: 08:30 PM

SetTime  [¥X] 3

Timesd Days \ Call Selt\ngs} Transfer I Adv Dplions] Adv Dialing] Hemote} CDDPI CentralDatabase}

¥ Thu

¥ Fii

v Sat

Use Might [0530PM |05 0PN

Meszage after,

[ Allow different times for each day

Call job stops when;

Call job is done A

[~ Delay statt of cal job unil

[~ Temporariy pause calk

Make calls only between the DON'T CALL BEFORE and DON'T CALL AFTER times. Check ALLOW DIFFERENT
TIMES FOR EACH DAY only if you need ta call during different times for each dap of the week.

The first tab of Call Options, Time/Days, allows you to tell PhoneTree which days of
the week and what time during those days you want to make calls.

Uncheck any day(s) you do not want to make calls on.

To change the Don’t call before and Don't call after times for all of the days of the
week, click on each of the time fields under Sun. A box will then appear. Use the four
arrows to adjust the hours and minutes. If you would like to set different times for each
day, select the Allow different times for each day box, then individually click on each
day to set the times.
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Call Options

Emalll DnDamand}
Times/ Days  Call Seftings 1 Trarister | Adv Optiors | Adv Disling | Pemate | Copy | Central Diatabass |

Call conniction options

Mas number of rings
before moving on ta next cal

tax number of call attempts
to unanswered numbers:

Hahg up if an Ans Machine
meszage iz longer than [sec]

Wait this long after message
for tauch tone repl (zec).

Jab pricrity
= Choose prioiy:~ |Mid il
“Within call options:
15 W Allaw star [7] key to repeat message
¥ Enable detection of early hang-ups
IT activefor  [10 seconds of message.
™ Bypass ans machines on first call attempt
Count "3 replies and stop calls:
rz i Pl P

' Hse aliemate phone numbers

Select Fles Field: Call this alternate number when

2nd Phone #: OFF [Wever call this number =l
3id Phone # OFF [Wever call this number = U
o | Cancel | Defauts | e |

Next, click on the Call Settings tab.
Leave all of the Call connection options to their default settings.

The Allow star (*) key to repeat message option allows the message to be repeated if
star is pressed by announcing it during your message. Uncheck if this is not desired.

Set Enable detection of early hang-ups.... to 10 seconds.

Enable Use alternate phone numbers if you have more than one phone number for
each member. For more information or how to set up the alternate phone number feature,
please click Help.

Call Options

OnDemand

Times/ Daps J CallSettings | Transter  Adv Options | Adv Disling | Remete| Capy | Contial Database |

Ewxport data:
[~ Create export file for use by anather applisation

Don't call duplicates with sarme:
" Phone #
(% Hleme and phone #
" Call all duplicates

Calllogging: [Log ALL Calls
Dot call numbers in

blocked number list 2 .
Deliver meszage ta answering machines:

Always -
Daily caling

[~ Auto call each day

Help

LCancel | Diefaults ‘

m Click on the Adv Options tab.
Set the Don’t call duplicates with same to Name and phone #.
Then, click OK.
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n Click on the Wizard icon from the top toolbar. X

Wyizard

The Call Wizard allows many options for different types of messages (as opposed to using EasyCall).
Here, you can create the standard recorded message or, add several different message options such as
a Night Message. You can set up an e-mail message, multi-lingual message and even request a touch-
tone response to your message.

This section covers three types of messages you can configure in the Wizard all at once; Standard,
Multi-Lingual and E-mail. The instructions for each type of message have been separated for each
screen. You can set up one type of message or all three at once using these instructions. Multi-Lingual
does require the Standard message to be configured; Standard and E-mail alone do not.

At any point during the Wizard you do not understand a specific function or want more information,
click the Help button.

Call Wizard: Blue Ridge Group

The Call Wizard wil guide you through the advanced messaging options.

[T Check if you wizh to create multi-ingual messages

™ Check if vou wizh to send an e-mail message

Cancel Help Lall Optians... (= laIT Hext >

m To set up a Standard Message
Upon opening the Call Wizard, click Next.

To set up a Multi-Lingual Message
Upon opening the Call Wizard, click on Check if you wish to create multi-lingual
messages, then, click Next.

To set up an E-mail Message
Upon opening the Call Wizard, click on Check if you wish to send an e-mail message,
then, click Next.
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Call Wizard: Blue Ridge Group

The Call'Wizard will guide you through the advanced messaging options.

[~ Check if you wish to create mult-ingual messages

fv Check if you wish to send an e-mail message

& | want to send a phone call and e-mail

£ | want to zend an e-mail only

£ | want to zend e-mails [but call if e-mail iz blank]
& tasimple text message

7 aconstiucted message

Choose one:

tdy email meszage will be:

Cancel Help LCall Options. . Preyviaus Hext ->

m E-mail Message continued...
Choose from one of the three choices for sending e-mail messages, then, choose to send
either a simple text message or a constructed message. Then, click Next.

Call Wizard: Blue Ridge Group

Select the message(s) pou wish ta record: [check all that apply).

Required: [& Gts 4 [your default meszage]

Optional: v Night [alternate message after hours)
W Machine [alternate message to ans. machines)
W Intro w/3 [request 'S to confirm call delivery]
W Morelnfo [give more information after pressing #)

¥ TT Response [Message change on TT receipt]

Cancel Help LCal Optionsg. . <- Previous

m Standard Message continued...
Choose which message option(s) you would like to add in addition to your recorded
message (for detailed information on each of these options, click Help), then, click Next.

Multi-Lingual Message continued...
Choose which message option(s) you would like to add in addition to your recorded
message (for detailed information on each of these options, click Help), then, click Next.
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Call Wizard: Blue Ridge Group

= @ B B X J

Play Record New Copy Delete | Yolume Help

Select each message type below and a corresponding message to play. Use the -
controls above to recard and play, create a new message, o delete selected messages. |- Endlish bt
Create a meszage of each tppe for each available language at the right.

- Giectng [Hello. wav |
' Standard message B
© Hight | =~
" &ns. machine | j
" Intro [confim w/S) | j
" More info | j

Cancel Lall Options... <- Previous Nest >

m Standard Message continued...

The message options chosen on the previous screen will determine which and how many
drop-down boxes [i.e. Night, More Info] appear. Select the Standard message box. Then,
from the top toolbar, click New. A box will appear requesting what type of message you
want and a title for the message:

Single-part (linear) message (.wav) - Choose this type if you do not want to
use Flex Fields in your message.

Individually constructed message (.vft) - Choose this type if you do want to
use Flex Fields in your message.

Next, type in the title you wish the message to be called and then click OK. Repeat for
any additional message options.

14



3900: Setting Up a Call Job, continued

Call Wizard: Blue Ridge Group

= oy W B X J

Flay Edit Mew Copy Delete = olume Help

Any mezzages in RED have not been recorded!

Select each message type belaw and a coresponding message to play. Use the

controls above to record and play, create a new message, or delele selected messages. |- Endlish =
Create a megzzage of each tupe for each available language at the right.

.{'“ Gresting | Helin way ﬂ
*  Standard message Feeting Rerninder way

" Hight | ﬂ
" &ns. machine | j
" Intro [confirm w/3) | j
" More info | j

Cancel LCall Options. . <- Previous Hext -»

m Standard Message continued...

If you chose Single-part (linear) message (.wav) as your message type:

To record a message option, click Record from the top toolbar and speak into the
headset/microphone after you hear the beep. Click Stop when finished. To review what
was recorded, click Play. Repeat for each message option. When finished, click Next
and proceed to page 80.

If you chose Individually constructed message (.vft) as your message type:

Click the Edit button from the top toolbar. The next proceeding pages will walk you
through setting up a message in the Constructed Message Editor.

Multi-Lingual Message continued...

First, change the language from English to a different language via the drop-down box in
the top right corner. Then, depending on what type of message you chose for each message
option, use the instructions listed above for the Standard Message and proceed accordingly.
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Creating a Constructed Message
(Individually Constructed Message (.vft))

Note: If you chose Individually Constructed Message for your message option(s), please
proceed with these instructions. If you chose Single Part (linear), please see the preceding page.

nstructed message editor

+ X 7 | > )

i r— play | Wome | Help

Cot current Date using Add, Delete and Edit ... English
#  First Name [ Seript

Full Name

Flex Date
Flex Time

Create a sample person to test pour message. .

Hame Flex Date Flex Time

and this iz the resulting message:

aK ] LCancel I TT5 Settings... I Flex Field Recordings... I Play Message

Upon clicking Edit from the previous screen, you are presented with the Constructed Message
Editor. Here, you will assemble your messages in pieces rather than one single recording. This
allows you to insert Flex Fields and other information into your message, so that everyone called by
PhoneTree will hear their own unique and customized message.

To start, click Add and choose New Snippet and then double click on Unrecorded Snippet.

To help you understand how a constructed

message really works, a sample message willbe | @ » T @
uSed _Bamrd Play Yalume “oice Help
Current zample: English

For this example, the message that will be
scripted will read as follows when pieced
together: “This message is to remind the north
office about our meeting on June 3rd. Please
make sure you can attend, we will start
promptly at 6pm. Thank you.”

This message is to remind

In the above sentence, “the north office” is our
flex field and will change based on the location
that each member on the call list is assigned to.
The rest of the sentence, once scripted, will
always stay the same. Remember that you can have more than just one flex field in your message,
this example just shows one.

The first snippet should represent what needs to be said up until the flex field part of the message.
For this example, the first snippet will be “This message is to remind.” The same principle applies
for your message. Start your message off with a snippet that stops where you want to insert a flex

field.

To record the snippet, click Record from the top toolbar. To review what was recorded, click Play.
When finished, click OK.
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s

Yolume Help

| -
Mew Snippet | Play

Current Date :using Add, Delete and Edit ...
First Name I

Full Name |

l Enalish

Flex Date

Flex Time AI

Create a sample person to test your message...

Mame Flex Date Flex Time ‘Dlln:e Lozation {?I

. and this is the resulting meszage:

This message is to remind

aK ! Cancel l TTS Seftings. | Flex Field Recordings... | Play Meszage I

Now the flex field can be added to the message. Click Add and insert a flex field that you have
already set up. For our example, this is where the Office Location flex field gets inserted.

4

Add  Delete Edit

Construct a message here using Add, Delete and Edit ... l English
# [ltem [Seript
1 Umiooided Srippet This message is to remind
> please select 5 zample

2 [ Office Lacation ]

stat promptly at 6 AI

Create a sample person to test pour message...

Mame Flex D ate Flex Time Office Location
Harth Office =

.. and thiz is the resuling message:

This message i to remind aboul our mesting on June 3rd. Please make sure you can altend, we will start promptly at Bpm.
Thank pou,

{17878 ettings. o

QK ! Cancel l

Flex Field Recordings... | Play Message I

Since the flex field has been inserted, we can add another New Snippet to complete the message.
Click Add and choose New Snippet again, then double click on it to insert text. You will need to
record the message after you have entered the text and click OK when finished. You can see in the
above screen shot, we have done the same with our example message.

It is now time to edit your flex fields. For our example, we will show you how we edit our Office
Location flex field. Click Flex Field Recordings....
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Flex Field Recordings

® )
Record Play | Yolume Help
Caution: Settings are common to all PhoneTrees using: Global Set
Flex Fields: Field Y alues: [~ Show muliple-languages
i
- Morth Office
- East Office
-‘wiest Office
the north office
oK
aK

To edit a flex field, first click on the name of the flex field and then under the Field Values box
select an entry for that flex field. For our Office Location example, we have four different offices:
South, North, East and West.

Once you have selected which flex field entry you want to edit, click on the Scripts box. An edit box
appears. Type in the text that the flex field should insert in the message, then click OK. For our
example message, we say “in our North office” for the North Office entry, because this is the section
of the message that the flex field is inserted. The other flex field entries would be scripted the same
way so when a different member on the call list has a location other than the North office, the flex
field within the message changes seamlessly.

Flex Field Recordings

I J
Record Play Walurne Help
Caution: Settings are common to all PhoneTrees using: Global Set
Flex Fields: Field alues: I Show multiple-languages
- South Difice Seripts:
:\E’\?:;FD”;’?:E e noth affice
|

Once all entries have been scripted, you can record them. First, click on the entry that you want to
record and then click Record from the top toolbar. Press Play to review what was recorded.

If you are also setting up a multi-lingual message, check the Show multiple-languages box and
repeat the scripting and recording process for each language.

When finished, click OK.
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+ X 7 > J

Add Delete  Edit Play | Yolume Help

Construct a message here using Add, Delete and Edit ... English
# | ltem Script

- el
[ Office Lacation ] the north office
-Urrecorded Snippet about our meeting on June 3rd. Please make sure you can attend, we will start prompty at B s

Create a sample person to test your message... [~ Allow independent voice selection for each message item.

Hame Flex Date Flex Time: ‘Woice is set bo Kate anly. 5 ee Advanced

Woice: IE;IE—E
.. and thiz is the resuling message:
Thiz message is ko remind the noith office about our meeting on Jur For times and dates use: Test To Speech =

pramptly &t Gpm. Thank pou. : i
For [list tupe] flew fields use: User Recordings =
Foor snippets uge: User Recordings +

ok Cancel TTS Seftings [Test ToSpeech |
TTS is present Engire: | VT TTS
oK ] LCaneel ] Advanced... ] Help ]

This completes our example message. At this point, both snippets and all of the flex field entries
have been recorded.

You do have the choice of using your voice recordings to play back the message or switching to
Text-to-Speech. If you would like to switch to Text-to-Speech, click TTS Settings... and then click
Help for more information on how to use this feature.

Click OK to exit the Constructed Message Editor.

Note: If you have selected other message options to be Individually Constructed Messages as well,
you can use these same instructions to create those messages.



3900: Setting Up a Call Job, continued

Call Wizard: Blue Ridge Group

- @ X J
Play Fecord MNew  Copy Delete | Wolume Help
Select:
& 171 [inset =] | -]
T2 Languages:
TT3 - English hd
TT4 |OFF b
Touch Tone TT5 |OFF :" Any messages in
[esponse messages. 176 [oFF = RED have nat
Choose which TT's been recorded!
support alernate 177 [OFF =
messages and
create messages for T8 |OFF -
each.
TT4 |OFF =
LCancel Call Options.. <- Previous Hext -»

m Standard Message continued...

If you chose TT Response as a message option, you will see this screen. The touch tone
reply numbers you choose here should coincide with what you mention in your message (for
detailed information on how to set up a touch tone reply, click the Help button from the top
toolbar). When finished, click Next.

Multi-Lingual Message continued...

If your multi-lingual messages use the touch tone reply feature, you will need to record those
as well. First, change the Languages drop-down box from English to a different language,
then proceed with recording the touch tone replies as with the English message. When
finished, click Next.

Call Wizard: Blue Ridge Group

Enter a subject, optional attachment, and type your e-mail message in the space below.

Subject: |B|ue Ridge Meeting Reminder
Attachment

[optionall: | Browse
Meszage Text:
A,

This iz reminder about our meeting on June 3id. Please make sure you can attend. ‘e wil start promptly
at Bpm.

Thark. you!

LCancel Help Lall Dptionz. <- Previous

m E-mail Message continued...
Enter a subject and message for your e-mail here. If you wish to send an attachment, click
the Browse button to locate and include it with the e-mail. When finished, click Next.

Note: If you chose a constructed message for your email message, please click Help for
instructions on how to use that feature.
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Call Wizard: Blue Ridge Group

Select whom to notify, and click "0K" to start.
Select:

& Motify ’m
¢ Hesune |Tagged

™ Save changes and exit

[T Check if pou with to use the OnDemand service to place pour calls

LCancel Help Lall Options... <- Previous Ok

m All Messages
In the Notify drop down box, either choose the Entire List view (all members will be
notified), or any custom view you have set up or Tagged (only the members checked on
the call list will be called). Then, click OK to launch your call job.

Confirm Start Job

“Y'ou are about to contact 16 people
uszing the view: Entire List
of the Blue Ridge Group.mdb list.

[The final count may be reduced after removal of
duplicates, blocked numbers etc.]

Do you wizh to continue?

[ Dont show this dislog again.

Once you press OK, the Confirm Start Job window will appear showing how many
people you are about to call and asking if you wish to continue. If you are ready to start
your calls, click Yes. If you click No, you will exit the Call Wizard completely.

After you click Yes, this will launch the Call Center for the 3500 or the OnDemand
Packager for the 3500 SE.

For information on what the Call Center is and how it functions, see page 83.
For information on how to initiate the OnDemand Packager, see pages 123-124.

If you would like to generate a report showing your call results once your calls are
finished or configure PhoneTree to automatically do this for you, turn to page 87.
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Call Center

Call Center

Once you have initiated your calls from either EasyCall or the Call Wizard, the PhoneTree software
will launch the Call Center. The Call Center is where phone calls actually take place. In addition to
making calls, the Call Center is also utilized for features like AutoReports and Auto Tasks.

In order for the Call Center to malke or receive phone calls, it must be running during your
preset call times. This means that you can minimize the Call Center while it is making calls - just
don’t close the software!

While the Call Center is operating, you will need to know the functionality of some of its features:

"% PhoneTree
Navigation Help
[ PhonoTroo || Tools 1| Tasks | Infolno ]| Admin 7 Phoneree
CallCenter x|
Lines1tod | 5108 91012 131015
e ——— E
PhoneTree 1 < | Not Available: Line 2 -
Adams, Meghan —
m 1336 555-9475 ——
Start Call Line is not Enabled
: : ——O
PhoneTree: Line 3 o« PhoneTree: Line 4 4 e
=
Mute:
Line Card is nat Present Line Card is not Present
11:08 &M
PhoneTree Information/ Status & Moelnfo =
# PhoneTree Status P Placed Completed Mot Before Mot After  Call Days
E 1 PhoneTree 1 Calling Mid 1 /18 08:20AM 02:30PM SMTWTFS
[Mo ermars
To edit call lists or change settings. click PAUSE ta leave the CallCenter.
== i e,

The Call Center provides a dynamic call status:
A. Call Status Boxes: Each box shows the status of an installed phone line (four at a time). The

contents of each box change as calls progress. Click the Speaker icon in the top right of any box to
monitor calls for that line.

B. Volume Control Slider: Use to adjust the volume of the speaker while calls are being made.
Click the Mute button if you do not want to hear calls in progress at all.

C. Pause Button: Use to stop calling. In-progress calls are finished before returning to the Main
Menu. You can return here to finish the call job later by clicking the Resume Calls button.

D. Stop Calls Button: Use to stop calling immediately. In-progress calls are interrupted and you
will be taken back to the Main Menu. You can return here to finish the call job later by clicking the
Resume Calls button.

E. Job Status Window: Provides summary information about the calling session in progress. Click
on the More Info Arrows to see additional summary information.



Call Center: Call Statuses

Call Statuses:

Every member on a your call list receives a call status. Below is a listing of every call status and its
definition. You can view the call status either by opening the call list under the PhoneTree desktop
or by reviewing your report (see page 87).

Completed Call Statuses (message delivered)

Ans by Person Message was delivered to a person

Ans by Machine Message was delivered to a person’s answering machine

Ans by +Machine Message was delivered to a person’s answering machine after a definite
beep was detected by PhoneTree

Ans by Pager Message was delivered to a person’s paging device

Call Transferred Person transferred by pressing “0”

Uncompleted Call Statuses (PhoneTree will re-attempt to deliver message)

Busy Phone was busy on last call to person

Not Called Yet Person has not been called yet

Learned Machine Person’s answering machine is “unique” and was learned
No Answer Person did not answer last call

9 Not Confirmed Did not confirm delivery when asked to dial “9”

Final Call Statuses (PhoneTree will not re-attempt to deliver message)

Hung Up Early Call was answered but responder hung up before message finished

Busy After Voice Telephone company busy or off-hook service message

Max No Answers Line was busy or not answered for max attempts (up to 15) set by user
[2100: see 8b on page 46, 2500: see 8b on page 57, 3500: see 8b on page 71]

Not Accepted Did not confirm delivery (by pressing “9”) after 3 call attempts

Not Selected Call Statuses
Not Selected Person is not selected for calling

Removed as Dup Person was removed from the call list by checking one of the options
on the Advanced tab of the Call Options dialog
[2100: see 8c on page 46, 2500: see 8¢ on page 57, 3500: see 8c on page 71]

Blocked Number Person is on the master Blocked Number list (see page 172)

Error Call Statuses (please check the phone number)

Call Failed! Error detected during call (check for disconnected/changed number)

OGM Too Long Call was answered by a machine, but its OGM (outgoing message) was
too long

Telco Message Call was answered with a telephone company (Tri-Tone) S.I.T. tone
(disconnect/change)

No Connect No signal detected after dialing (phone number is probably not valid)

Fax or Modem Call was answered by a FAX machine or modem



Call Center; Call Statuses, continued

In addition to the call statuses, a number may appear to the right of the status, in the Replies
column. This indicates a TouchTone was pressed by the person during the call:

0 Indicates call was transferred to a voice mailbox or other extension on your
phone system. See the Transfer tab of the Call Options dialog.

1thru 9 Meaning will vary depending on message. you may request that the person
respond to a question with any touch-tone digit (ie, press “5” if you can come to
this Thursday’s meeting, press “3” if you need transportation, etc...)



Reports



Reports: Manual Reports

Reports

After your call job has completed, you have the option of creating a report showing the results of
those calls. PhoneTree offers an array of reports that show various data regarding your calls. Also,
you have the option of either creating the reports manually or configuring PhoneTree to automatically
do it for you. There are four choices for creating a report: print-out, file export, e-mail (AutoReport

only) and fax (AutoReport only).

Manual Reports:

a) Go to the PhoneTree desktop and click on the PhoneTree icon you wish to generate a report for.

3 M Edit Tools View Search Setup Call Import Help
New... Cirl+ Q <
Open... Ctrl+0 Find List Filter
Save As... Cirl+5 Zl
Rename As... A 5
Delete File e =5
Crve o ]
Blue Ridge Group.mdb RldgE GTUUP
| Phone Transiated Call Status _ «
Monthly Call Logs...
Gy M“” ﬂ" CE'" LDQS e han ||(2361555. 9475 |1336555.9475  |Not Called Y&t
ey oty Collogy by ddh.: lebecce|[(336) 555-9949 |1 3365559949 |Not Called Yei
View ooty Cal Lags:.« liren  [[(336)555-8938  |1336555-8938  |Not Called Yet
Exit to Desktop View issle |(336)555-7911 13365557911  |Not Calied Yet
T Torg, g (336) 5555579 |1 3365555579 |Not Called Yet
8 O Morton, Carrie (336) 5554741 |13365554741  |Not Called Yet
7. & Mory, Julia (338) 555-3354  |1336555-3354  |Not Called Yet
8 O inger, Jenna_|(336) 5554354 |1 3365554354 |Not Called Yet
s O Nostitz, Carol (336) 5552112 |13365552112  |Not Called Yet
= Pirkle, Christina__ ||(336) 555-1410 |1 336555-1410 | Not Calied Yet
= Rabi, Emily (336) 5556392 |13365556302 Mot Called et
4 ™ Dadaare Qarah AR RER OB17% 4 A7 RER OE17 Kt Pallad W bt
»

4 _b_ 4
16716 | Entire List Soit, Name

Cal: Blue F\idﬁe Gruup 2

b) Click File and choose Print (or click the Print
icon from the toolbar).

¢) The Make Print Selections window appears.
Here, you can use the Report format drop-down
box to select which report you would like to use.

To preview the layout of each report, click
Preview/Export.

To print a report, select the report you want and
click Print. To make sure your report goes to the
correct printer, click Setup to select a printer.

Make Print Selections

Report farmat:

|Standa|d Report
Send report to:

|F‘rinter

Print ]

LCancel ]




Reports: Manual Reports, continued

To export your report to a file instead of printing it, click Preview/Export to open a preview
of the report.

B Preview: C:\Program FilesiPhone TreeMVPuiUsert21004001 B lue Ridge G...

g,@ F5% - 1 oft 4
/' ~
q .
/ PhoneTres: FhosTres 1
; : BN Blue Ridge Grou bl
Click the Export icon. PhoneTree g9 P sl s
PHorelnx S Aot

Hame 21 At Fhone Hu ms Remlies LTI LaaITine
Adume, khen ot Calbod it ) FEEagE Nt Callod
ol e ey

Fopenter, Leren Nt Calbod it 36 FERenie Mot Calkd

e S e

Horten, b Mot Calbed it 6D FEELDTn Mt Calbed
e el il e

oy, e Mot Caled it () FEE RS Mt Calbed
. il e el

Moatkx, Cared Mt Calbed it G PEEAiE Mt Calbed

Fiik, Chrbtim: Nk Caller] it i) -1 Nt Callerd

Fnbl, Emiy Mot Cald it (6 ey ot Caled.

Fiodgerm, Sarsh. Nt Callod it GEENEEE At Nt Calbod
e —— pteg

S, Comihe Mt Callod it [k R Feen Mt Calkd
D R e

Uhrhmen, Ame Mot Calbed it ) FEEaNy Wt Calbed

d) At the top of the preview screen, click on the Export icon &8 (blue envelope with red arrow).

The Export window appears. From the Format
drop-down box, choose the file format then click

OK. You will be asked where you would like to Foimat

save the file. Make sure you choose a location ['wiord for Windows document =l
that is easy to locate such as your Desktop. Acrobat Format [PDF] A Cancel

Character-separated values
Comma-ze

Crypstal Reports [RPT)
Crypstal Reports 7.0 [RPT]




Reports: AutoReports

AutoReports:
AutoReports allow you to generate your call result reports automatically, instead of manually, after
your call job(s) have completed.

a) Go to the PhoneTree desktop and click the PhoneTree icon you wish to generate a report for.

File Edit Tools View Search BEE®M Cal Import Help
0 re =) o  Preferences..,

b) Then, click Setup and choose | Me* O Pt | A¢ Deskioeicon.. |
Autoreport... 9 P ¥
Maibox Options EasyCall Wizag Call Options...
Flex Field Recordings...
| AutoReport... I
' oiues rauye Sroup
I} Tag|Unique ID Name Phone Translated Call Status =«
» n O Adams, Meghan (336) 555-9475 1 336 555-9475 Not Called Yet
2l O Anderson, Rebeccs || (336) 555-9948 1336 555-9949 Not Called et
3 O Forester, Lauren (336) 555-8938 1 336 555-8938 Not Called et
4 O Gonzales, Jessie  ||(338) 555-7911 1336 555-7911 Not Called Yet
5 O Horton, Maria (336) 555-5579 1 336 555-5579 Not Called Yet
6 [ Morton, Carrie (336) 5554741 1 336 555-4741 Not Called et
7 O Mory, Julia (336) 555-3354 ‘1 336 555-3354 Not Called Yet
8 O Jenna  (|(336) 555-4354 1.336 555-4354 ot Called Yet™
8 O Mostitz, Carol (336) 555-2112 1336 555-2112 Not Called Yet
10 O Pirkle, Christina (336) 555-1410 4 336 555-1410 Not Called Yet
11 O Rabil, Emify (336) 555-6352 ‘1.336 555-6392 Not Called Yet
A e e T e rwﬁj
4 3

: |
16 /16 | Entire List Sort Name ~[TNE Call Blue Fidge Group |

The Setup AutoReports window opens. Click Add.

AutoReport Setup

General | E-bdail Detals

NS EE|

-Select AutoRepart aptions: -

[Type [Fomat [Dutp ubject |eMessag [Fax ¢
Repoit formal: | 5tandard Report |
Output to: |P|inler j
Wiew: i
File
Etdail
w/inFax PRO
Select printer for this report:
Microsoft Office Document Image ‘witer j
% Daily repart

£ Final report |

Kl
ok Modify Help
akK Lancel Help

c¢) The AutoReport Setup window opens. There are four different types of AutoReports that
PhoneTree can generate: print-out, file export, e-mail and fax (requires WinFax PRO software - see
below). Also, you can set up more than one AutoReport to run at a time, so if you wanted the
report printed and e-mailed, you would need to set up an AutoReport for each type. Below is a
description for each field for this setup:

Report format: List of different report templates available. (to preview the layout of each report,
see Manual Reports on page 88).

Output: List of different output options for the reports. Each output option varies in setup. Click
Help for more information.

Printer - Sends the call results to a printer of your choice.

File - Generates the call results into one of several file formats to a path designated by you
on your local computer or network.



Reports: AutoReports, continued

Email - Sends the call results as an attachment from one of several file formats. Requires
you to enter your e-mail server information. See page 32 for more information.

WinFax PRO - Sends the report via fax machine. Requires installation of WinFax PRO
software [not sold or supported by PhoneTree].

View: Choose which view you want to represent the report. This is a useful option when custom
views have been created with special sorting properties. The report will obey any sorting or filtering
rules set for a custom view (see page 103).

The report can be processed automatically, at the time you specify in Configure Global Settings
under the Misc tab (see page 29), by one of two ways:

Daily Report - This report will generate at the same time regardless if the call job is complete.

Final Report - This report will only generate when the call job is complete or the call times have
expired.
d) After all options have been set, click OK. Then, click OK to exit the Setup AutoReports window.



Notes
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Tasks: Creating a Manual Task

Tasks

Tasks allow you to string together several commands for a single application and complete them all
with a single click on the Tasks Desktop. In addition, you can set an AutoTask to be triggered at a
certain time or by the appearance of the creation file. In this case, you wouldn’t need to click an
icon on the Tasks Desktop to initiate the task - it would start automatically.

Creating a Manual Task:

PhoneTree V6
Navigation Help

PhoneTree 1 PhoneTres 2 PhoneTree 3 PhoneTree 4 PhoneTree & PhoneTree B

PhoneTree 7 PhoneTree &

a) On the PhoneTree desktop, choose the icon for which you would like to create an Task. This
takes you to the List Editor for that icon.

PhoneTree
Fle Edit Tools View Search " call Import Help
0D B & o  Preferences... =
Mew  Open  Print | List Filter
@ o P .
Mailbox Options EasyCall Wizag Call Options... Exit
AutoReport...
Blue Ridge Group
0] Tag[Hame Phone Translated Call Status Replies -
» [1|Adams, WMeghan  |(336) 555-8475 Not Called Vet
2| [O/Anderson, Rebeccz|(336) 555-9949 Not Called Yet
3| [O|Forester, Lauren  |(336) 555-8938 Not Called Vet
4| [0|Gonzakes, Jessie |(336) 555-7911 Not Called Yet
5| [O|Horton, Maria (336) 555-5579 Not Called et
6 [ Worton, Carrie (336) 5554741 Not Calied Yet
7| O/Wory, Julia (336) 555-3354 Not Called et
8 [ Wotsinger, Jenna | (336) 555-4354 Not Calied Yet o
8| [J|Nostitz, Carol (336) 555-2112 Not Calied Yet
10| []|Pirkle, Christina___ | (336) 555-1410 Not Calied Yet
11 [J|Rabi, Emiy (336) 5556392 Not Called et
12[ [1/Rodgers, Sarah  |(336) 5559513 Not Called Yet >
4 »
16/16 ! [ Hidge isw Sork: N‘ﬂe IME Ei\s Sldpped {0

b) From the Setup menu, choose Task Icons...



Tasks: Creating a Manual Task, continued

- Bwvalable Tasks: -

Enter a name for a new task lcon:

Call Blue Ridge Group

File ta Open:

Wie:

Tranzlatar:

|
|
Report Template; |
|
|

Chain To:

oK ‘ Modify Task ‘ Help

¢) Next, click the Add button, then enter a name for your new Task Icon, and click OK.

MNaw dick the Modify Task button to modify the action of this task

d) Click OK on this screen. Now click the Modify Task button.

Modify Task Content: Call Blue Ridge Group.

Edticon | Edt Task]
PhoneT ree: [
e) Under the Edit Icon tab, choose an
available icon from the list on the left, [ecztieeens s oppiEret
then type in a name in the Enter a name DR B
box. Next, click the Edit Task tab. Caw‘ =

oup

|&

“DacPrint.ica

~Enter a name: -

Call Blug Ridge Group

v Visible

QK Cancel Help




Tasks: Creating a Manual Task, continued

s Modify Task Content: Call Blue Ridge Group

Editloon  Edit Task |
- Task Content: e \

H A00D dtos s
i acommand o View ¥ |
T

Print | Import NOFILE {Spedial Case)
Select Different Message (Optional!) » Prompt for File
cal v
File System »
Tools 3
»
»

Seripk

Skip

f) Click the ADD a |
command to script button.
Choose Import, then File.

ouble-Click arw item in list above to edit, Right-Click to delete

File ta Open: |Eurrent File _:_J
Wiew: ICurrent Wiew _:_J
Report Template: ]NUI’]E _:_J
Translator: INnnE :_J
Chain To: ]Nuna _'J

I Use OnDemand Service

oK Cancel Help

PhoneTree

\:.:’) Choose YES to specify the file to import or NO if the AutoTask trigger file and the data file are the same.

Yes Mo

g) Click the Yes button.

Look in: | [ PhoneTreeMVPu j - £ Ef-
: @ ckMailer.exe E] PhoneTreeNames. bt
‘_"\5 ClientHeaderFile.Bin 3. Printernterface.exe
My Recent ClientPhonetrees.Bin Elrrobox.exe
Documents |y pc exe Bl soccer Team.CsV
T[‘- I3 EZCombiner. exe Elsoupserver.exe
E] InstallRequired. txt E“ThlsS\te.dat
Eeddon B LsHelper.exe (&) TT5Test.way
MAPIMessageMailer, exe o WebServiceConnectivityTester.exe

WinFaxProFaxxer.exe
WinFaxProXPFaxxer.exe

EDnDamandServar.exe
(2 pesadddb.mdb

My Documents. |33 o spastecd DlzoExtractexe
2 (2] pCspastedb.mdb = PhoneTree Call File.csv
- EPhnnaTreeMl‘Pu.exe
My Computer 2 |
@ File name: |FhuneTrBe Call File csv A'J Open |
My Networle  Files of type |1“_'j :_J Cancel
Places

I Open as read-only

=l

h) Specify the file PhoneTree should look for every time this Task is initiated. When you have
found and selected it, click Open.



Tasks: Creating a Manual Task, continued

PhoneTree

\:.:/ Choose YES if you want to delete the import file after it has been used.

Yes Mo

i) Make the appropriate choice on this box (Yes will delete the import file after use, No will preserve
the file).

PhoneTree

Fleaze zpecify file creation made by tpping the first letter
of chiice:
Ovenanite, Append, Mew or Prompt

Cancel

o

j) Choose whether the creation of this file should Overwrite the existing file, Append to the
existing file, create a New file or Prompt (ask each time for a choice) by typing in the first letter
of your desired operation. (“O”, “A”, “N” or “P”). “O” is recommended.

IMPORT /O /D C:\Program Files\PhoneTreeMyPu\PhoneTree Call File.csv command was added to the end of your script.

Use UP/DOWN arrows to move it if necessary.

k) Click OK. Now your Import command shows up in the Task Content window of the Modify
Task Icon screen.

"5 Modify Task Content: Call Blue Ridge Group

Editlcon  Edit Task

i~ Task Content
Scipt: L4
»
Select Different Message (Optionalt) ¥
Stop
File System b List
o »
1) Now click the Add command skip *| Grows
. . Exit 3 EasyCal
to script button again, and g
. izard
choose Call » View. Resume
Tagged
ouble-Click any item in list above ta edit, Right-Click to delete Resume {orList if new)

Resume {orview if new)

Resume {or Groups if new)

Resume {or Tagged if new)

File ta Oper: lCunenl File _:_]
Wigw: lEunenl Wiew _V_] |
Repaort Template: JNone :J )
Translator: JNUHE _:_]
Chain To: JNnne :J

I Use OnDemand Service

oK Cancel

Help




Tasks: Creating a Manual Task, continued

CALL VIEW command was added to the end of your script.
Use UP/DOWN arrows to move it if necessary.

m) Click OK.

Modify Task Content: Call Blue Ridge Group

Editlcon Edit Task
1~ Task Content:

ADD a command to script.

Script

IMPORT /0 /D C:\Program Files\PhoneTreekVPUA\PhoneTree Call File

n) Make sure your view, whether custom A
or Entire List, is selected in the View: ﬂ
drop-down menu and CSV (or your other
translator) is selected in the Translator

drop-down menu, then click OK. Double-Click any item in st sbove to sdi, Right-Clic Lo delets
File to Dpen: JEIue Ridge Group _VJ
Wiew: JCurrant Wiew _'J
Report Template: JNDHE _VJ
Trerslaer e -
Chain To; JNDne _'J

I~ Use OnDemand Service

0K Cancel Help

Task Icons
- &wailable Tasks: -
001 Call Blue Ridge Group. kst Ty
w| B
% Call Blue Ridge
— Group
- Task Cortent Preview: -
IMPORT /0 /D C:\Program Files'PhoneT reetyPutPhoneTree Call File.cav
CaLL VIEW
0) Repeat this process for any other
Task Icons you would like to create,
then click OK.
File: to Dpen: |Blue Ridge Group.mdb
Wiew: [Current View
Fieport Template; [Mane
Translatar: IEsY
Chain Ta: Mone [F Wisible
ok | Help




Tasks: Creating a Manual Task, continued

% Phonelree V6
Navigation Tasks Help

ey

[ Admin_|

Phoneltee

LCall Blue Ridge
toup

£l calling is stopped. The CallCenter must be active for PhoneT ree to send or receive calls
e — —

The Task icons you've created will now appear on the Task desktop, and when you click an icon,

PhoneTree will execute the commands you selected for that Task.



Tasks: Automating a Task

Automating a Task:

Suppose you set up a Task and you need to click the icon every day to initiate the actions associated
with that task. But what if you will be out on vacation for the rest of the week and you still need to
make calls (or print a report, etc.) each day?

PhoneTree allows you to initiate the actions of a Task automatically, based on a trigger you set (like
a certain time of day, or the appearance of a certain file). Once this is set up, the task will run
automatically only if PhoneTree is in the Call Center (like all other automated features). Here’s
how to do this:

a) From the Admin Desktop, click the AutoTask Manager icon. -
AutoT ask
ranager

[ S Configure AutoTasks
Trigger Description Tazk Last Fun Date
3
*
| »
Llear last run date
ok | medy | add | Deee | Rim | Heb |

b) The Configure AutoTasks dialog appears. Click the Add button.

i AutoTask Item

Select task to run automatically:

B,

Call Blue Ridge
Group

Automated task description:

‘Ca\l Blue Ridge Group

Select task trigger mode:
& Time-Trigger " File-Trigger

Task will run at this specific time and day(s):
Click on day(s] task will run: [green = enabled)
[Su] fwel

oK LCancel Help

c) A list of the configured Task icons will appear. Select the one you would like to automate from
the list. Type a description directly in the Automated Task Description box. The task you selected
will now be displayed in the upper right corner.

Fiun task at:




Tasks: Automating a Task, continued

i AutoTask Item

Select task to run automatically:

=N

Call Blue Ridge
Group

Automated task description:

‘Ea\l Blue Ridge Group

Select task trigger mode:
f« Time-Trigger " File-Trigger

Task will n at thiz specific time and day(s]:
Click, on da[z] tazk will run: [green = enabled]
[5u] five]
Fiun task at:

Ok LCancel Help

d) Next, decide which type of Trigger you want to use to initiate this Task - either a Time Trigger
(PhoneTree will activate the task at the time you designate) or a File Trigger (PhoneTree will
activate the task whenever it detects the presence of a file whose location you designate). Choose
the appropriate radio button for either a Time Trigger or a File Trigger.

For a Time Trigger, click the days you want in the Time Trigger box (the selected days will be
shown in green). Click on the Time to change it (a pop-up box will appear allowing you to make
changes). When you are finished specifying the day(s) and time, click OK. You will see the day(s)
you selected and the time appear next to the name of the tasks in the list under the Trigger column.

S AutoTask ltem

Select task ta run autarmatically:

01 Call Blue Ridae Group. bt

Call Blue Ridge
Group

Automated task description:
|Cal\ Blue Ridge Group

Select task trigger mode:
" Time-Trigger &+ File-Trigger

Taskwill run when this file appears. ..

|C:\P|0gram Filez\PhoneT reebPuhPhoneT ree Call File.cav

Ok LCaneel Help

e) For a File Trigger, you will show PhoneTree where to find a file that will be placed in the same
location each time it is updated (PhoneTree will use this file when completing the Task you have set

up). Click the Browse for a Trigger File... button. Then locate your file by navigating to it with

the Locate Trigger File dialog. Click OK when done. Be aware that when using the File Trigger, your
source file will be deleted. ™




Tasks: Automating a Task, continued

AutoTask Manager
Trigger Description T ask Last Run Date Last
C:\Program Files'Pho|Call Blue Ridge Group (001 Call Blue Ridge Gro
*
K Iz
LClear last run date
ak ] Modify ] Delete ] Print ] Help ]

f) Now, back on the Configure AutoTasks screen, you will see that the file pathname (or the days that
you selected and the time for a Time Trigger) is shown in the Trigger column. Click OK. This Task
will now be performed automatically without your needing to click its icon on the Tasks Desktop.

PhoneTree
Navigation Help
[ Phoneten | Toos || Tasko ]| imotno | dwin ] Cllcomar JRALULC 1)
Automation | Lines 1104 ] 5t08| 9t012| 131018 |
Desription [ Job Trigaer [ Last Fiun Time [ Status
»/ Doaily M aintenance at 1/28/2008 1:00:00 AM 1/28/2008 9:27:07 M ¥
+ 001 Call Blue Ridge Group. “MTWTF= 10.00 AW m
|
Wolure:
=
Mute
< | >
= 09:.42 AM
PhoneTree Infarmation/ Status & Morelnfo =
# PhoreTree Status Pi  Placed Completed Not Befare Mot After  Call Daps
1 PhoneTree 1 Caling Mid 2 2/30 08:30AM  08:30PM  SMTWTFS
[Na errars
Toedit calllists or change settings, click PAUSE to leave the CallCenter. ]

g) When you return to the Call Center after creating an AutoTask, you will see information
regarding your AutoTask(s) and Daily Maintenance appear in the Automation tab.
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Views: Creating a Custom View

Views

The View feature allows you to pick and choose which fields you see on your call list, as well as
sort or filter your call list, based on a number of different criteria. By default, the Entire List view
is loaded for every new PhoneTree icon. While Entire List contains the basic columns such as
Name, Phone Number, etc., it does not contain special fields such as Flex Fields. This section will
walk you through creating your own view so you can select what data you need to see and even
filter out certain data within a field if you choose. Keep in mind, you can always create more than
one view per call list if needed. Note: With whatever view you use, that same exact view will not
translate on any reports you generate, since those reports are created by preset templates and may
or may not use the same fields.

Creating a Custom View:

PhoneTree V6
Navigation Help

) R R I T Phonefred

Prondtse
PhoneTree 1 PhoneTree 2 PhoneTree 3 PhoneTree 4 PhoneTree § PhoneTree §

PhoneTree 7 FhoneTiee 8

|l ealling s stopped, The CallCenter must be active for PhoneT ree3500 to send or eoelve cals. 7

a) Start by going to the PhoneTree desktop and choosing the icon for which you would like to
create a custom view. This takes you to the List Editor for that icon.

¥

Filker

b) Click on the Filter icon from the top toolbar.

- Chooss a view:- Filter/Sort ] Appearance

Name New Filter

C) The Filter/sort Menu Enter a name far the new filter
appears. Click Add. You will be
asked to choose a name for the
new view. Type in a name and

. JNEW View
then click OK. _
.Nﬂl uzed Hung up =aily
| Mot used Leamed Machine
Click add to create Mot used tan No Answers
a custom view | Mot used No Answer o)

Dal Metused 1| gctal | Select none
NOTE. In E e List View onlp sort arder, highlight preference and font may be changed
0K “You must add a new view to access all other fiker/sort options, Help




Filter/Sort Menu

-~ Choose a view: -

Enitire List

Click add to create
a custom view

Add Del

x|

Views: Creating a Custom View, continued

Appearance ]

i~ Check filker category(z]:
— =

Sort arder:

1~ ...then click criteria bo view: -

9 Mot Confirmed

e

[ Groups
Feplies
| Language
[_1Flex Date
" | Flex Time
1 Office Location
Mot used
1Mot uzed
1Mot uzed
Mot uged
I Mat used
1Mot used
| Mot uzed
1Mot uzed
Mot used

I re— Y]

Anz by +Machine
Ans by Machine
Anz By Pager
Ans by Perzon
Bad Mame/Phone
Blocked Mumber
BUSY

BUSY After Woice
Call Failed!

Call Transfered
= Ebdailed only

Fax or Modem
Hung up early
Leamed Machine
Max Mo Answers
Mo Anzwer ]

|
= Select all Select none

Help

d) The Filter/Sort tab allows you to filter out certain entries in for certain fields. For instance, the
Call Status field shows a list of all possible call statuses. If you wanted to only view certain call
statuses, you could check the Call Status box and in the next column choose which statuses you
wanted to view. Any member that falling under a call status that is not selected would be removed
from the new View, but not the call list. To see everyone again, choose Entire List from the View

menu.

Also, to sort your call list by a certain field, choose up to three different fields and the order to be
arranged in under Sort Order.

- Choose a view: -

Click add to create
3 cusham view

Add Del

_x |

E nire List

FilterSort

Call Courter
Tatal Call Counter
Anstdachine Type
Anstachine 0GM
CallTimer

HMo 9z

Al Default Clear

1~ Select columns to display: -

i Dizplay options: -

[~ Highlight removed persons in red

l Small Font ¥ ]

Faont size:

I

Help

e) The Appearance tab allows you to select which fields you want visible in your view. Click to
select a field. Click again to deselect. When finished. click OK.
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Operation



Remote Operation

Remote Operation

Remote Access lets you call in to your PhoneTree system and access most major functions, including

recording your message, selecting whom to call, changing the calling times, and more.

Enabling Remote Operation:

1.

On the PhoneTree Desktop, determine which PhoneTree icon(s) to call remotely. If you choose

to enable this feature for all of your icons, repeat steps 2-7 for each one.

. Next, identify and make note of the icon’s number (hover mouse pointer over the icon and the

number will appear, e.g. “PhoneTree 001”).
Go to the List Editor (click on the desired PhoneTree icon).

Click Options icon from the top toolbar, then click the Remote tab. %

Qptions

Call Options

OnDemand

Times/ Days

Call Settings ] Transfer ] Adv Optionz I Adv Digling  Remate I Copy ] Central Database I

Femaote aocess:

W Enable iemate caling Override ''"Time/Daps'' tab

I¥ settings to allow remate call
PIN code: £257 session lo begin immediately
Specify file to usze for remote access:

Select file: [Rlue FRidge Group.mdb Browse ...

o Default to "Cal List"
" Default to "Call Groups™

ok | Cancel | Defaults | Help

Under Remote access, check Enable Remote Calling.

Enter a PIN code for user access to the Remote feature (required).

Check the Override “Time/Days” tab settings to allow remote call session to begin
immediately box only if you know that you will want to use Remote Operation outside the
preset call window settings you entered on the Time/Days tab.

To select the Calling List file to be used when PhoneTree calls remotely, click the Browse
button to select a file from your computer’s hard drive (the Lists available to PhoneTree will
appear in the box at right). Note: This file must be selected in advance (i.e. now, while using
this tab) and will be used for remote calling regardless of which file was last loaded into
PhoneTree.

Select the default call mode from Call List (call the entire List) or Call Groups (call one or
more Groups in the List). This can be changed when you call in using the Remote Menu.

Click OK.



Enabling a Line as a Call-In Line:

From the Admin desktop, click on the Configure Phone Lines icon.

Remote Operation, continued

Configure Phone
Lines

Configure Phone Lines

Select line:
Mtcd | | [ Use different settings at night ‘ ‘ N
1
Lire use:
™ Anawer callz anly
[¥ Enablethizlnets & Make calls

W Line may answer when not making calls

¥ Wwait for disltone before dialing

fe Touchtone diaing  © Pulze disling

Optional line access and biling codes:

Prefiv: ‘
Suffix: ‘

If phone number iz {11 digits or more, use:

Under Select line, choose one or more of the available line(s) to be used as call-in line(s) from the

list on the left.

In the Line Use area, select Make calls if the line will be used to place calls and check “Line may
answer when not making calls” if you want the line to automatically switch to being a call-in line
whenever it is not being used to make calls. With this method you may not be able to call-in on this
line while calls are being made. Select this option if you have only one line installed. Select Answer
calls only if the line will be used only for incoming calls, like Remote Access (or InfoLines or the

Answering Machine feature, page 33).

Make a note of the phone number associated with this line so you can access it when calling remotely.

PhoneTree
Navigation Help

[ Tous [ Tasks [ infoine_ ][ Admin_[[
Lines 1104 | 5108 81012 131015
Pause
PhoneTree 1 492 | Not Available: Line 2 !
Adams, Meghan o
1 336 B65-8475
Start Call Line is not Enabled
PhoneTree: Line 3 L] PhoneTree: Line 4 4 st
=
Mute
Line Card is not Present Line Card is not Present
11:084M

PhoneTree Infarmation/ Status
# PhoneTree Status P Placed Completed
1 PhoneTres 1 Caling Mid 1 0/16

& Morelnta 2
Mot Before NetAfter  Call Days
08:30.6M 0830PM_SMTWIFS

Mo emars

Ta edit calllists or change settings. dlick PALSE to leave the CallCenter.

Note: Make sure you leave the PhoneTree software in the Call Center in Calling Mode (see
page 84). If you attempt to call in from another phone and PhoneTree is not in its Call Center, you

will not be able to use Remote Access.



Remote Operation, continued

Configuring Remote Options:
From the Admin Desktop, click on the Configure Remote Operation icon.

Configure Remate
Operation

Configure Remote Operation @

Basic l Advanced ]

-Remate access configuration:

v Fiequire caller to confirm [ when calling in

Record qualty: Best :"
Murnber of rings till answer: 1

Lancel | Defaults | Help |

Check Require caller to confirm ID when calling in if you want PhoneTree to verbally confirm
your Remote PIN Code (ID) prior to granting access to the Remote Menu (recommended).

Leave the Record quality set to Best for your recordings (choose Economy or Middle only if
hard drive space is an issue).

Set the Number of rings till answer to determine how long the Remote feature should wait
before answering.

Note: The values under the Advanced tab do not need modification unless you are directed to do
so by PhoneTree Customer Support. Click OK.



Remote Operation, continued

Calling In
When calling in you must select your PhoneTree by typing in its icon number, and then enter the
appropriate PIN code. Example: To select PhoneTree 001 with PIN code 5678:

a. Call in to your PhoneTree system and wait for an answer

b. At the voice prompt press [*] [1] [#] on your touch-tone keypad*
c. Press 1 to confirm your selection (or press 2 to try again)

d. Enter your PIN Code (5] [6] [7] [8] [#]

e. You will be greeted with the Remote Main Menu (see below)

PhoneTree Remote Menu
(Some items play only if enabled)

[1] Message Menu
[1] Record Message
(2] Play Menu
[3] Record Introduction
[4] Play Introduction

[5] Record More Information

[2] Call Menu
[1] Call List
[2] Call Group(s)
[3] Resume CallsT
[4] Say Call Mode
[5] Clear GroupsT

[3] Mailbox Menu
[1] Previous Message
[2] Current Message
[3] Next Message
[5] Delete Current Message

[7] Time Menu
[1] Say Settings
[2] Enter Don'’t Call Before:

[1] AM [2] PM
[3] Enter Don'’t Call After:
(1] AM [2] PM

[8] Exit & Call
[1] Call All Selected
[2] Resume Calling
[3] Call Using OnDemand”
[*] Repeat Menu
[#] Main Menu

[9] Quit (No Call)

[*] Repeat Main Menu

[6] Play More Information

[7] On/Off Introduction

[8] On/Off More Information
[*] Repeat Menu

[#] Main Menu

[6] Add GroupsT
[7] Delete Groupt
[8] List Groupst
[*] Repeat Menu
[#] Main Menu

[8] Play Outgoing Message
[9] Record Outgoing Message
[*] Repeat Menu

[#] Main Menu

[*] Repeat Menu
[#] Main Menu

*PhoneTree plays the Standard InfoLine Greeting and
requires you to press the Star (*) key to identify you as
a Remote user and to prevent unauthorized use of your
Remote system.

"Requires an active OnDemand account and the
OnDemand option must be enabled in EasyCall or the
Call Wizard (see pages 114, 121 and 125).



Remote Operation, continued

T The GROUP menu items are not played unless Call Group is selected. Also, since there are 36
groups to choose from, the following table may be of assistance in selecting the proper group(s)
to call:

0=0  10=A 20-=K 30=U
1=1 11=B 21-L 31=V

2=2 12-C 2-M 32-W
3-3  13-D 23=N 33-X

4-4  14=E 24-0 34-Y
5-5  15=F 25-P 35-7

6=6  16=G 26=Q

7=7 17=-H 27-R

8=8  18-I 28-S

9-9  19-] 29-T

If you try to access your PhoneTree remotely and:

Your PhoneTree is currently calling:

* You will be asked to “Please wait”

* Once the calling has stopped, you will be asked to select:
[1] To stop the current call session
[2] To Exit and allow calls to resume

Note: You will interrupt any calls in progress and the call job you enable remotely will be initiated
instead.

Your PhoneTree is not remote enabled:
* You will be instructed to use the PhoneTree software to enable Remote Operation.
+ This must be done in advance from the PhoneTree computer and may not be done remotely.



OnDemand



OnDemand: Setting Up an Account

OnDemand

To use PhoneTree OnDemand, you need the following components in addition to the requirements

found in the Check System Requirements section (see page 8):

* Correctly-configured internet connection (high-speed connection preferable but not required)

* External PC speakers and microphone (headset included with purchase)

* A valid e-mail address for each account and for each user you wish to create

* If you are using the OnDemand service with the PhoneTree hardware connected, your PC

must have an internal sound card for recording and playback of messages.

Setting Up an Account:

Launch the PhoneTree software. Click the Admin tab. Click

the Configure OnDemand Service icon.

OnDemand Service Administrator

Configure
Onlemand
Service

Account Summary:

Account Mumber ..o
Activation Coda ... oo0 o
Email Address . .. |

Enter &ctivation Code

Account Status:

Dialing:
Use this area code for &l 7
digit phone numbers:

—

M anage Account;

Create Mew ‘ M odify |

Re-Open | GetLDstF’IN|

You must Create a new account bo use the OnDemand service,

Help

n Click the Create New button.



OnDemand: Setting Up an Account, continued

OnDemand Account SignUp (1/9)

Tems of service:

IMPORTAMT: By clicking on the | ACCEPT button below and/or accessing any part of the &
PhaoneTree OnDemand(tm] service (the "Service'] pou are representing that you are either

over the age of 18 or have obtained pour parent's congent ta register for the Service, and you
are agreeing to all the terms and conditions of this Service Agreement, and congent to be

bound by and become a party to this service agreement, If you do not agree to all the terms

and conditions of thiz Service Agreement, or cannot comply with these terms and conditions,
click the CAMCEL button; the registration process will not continue and pou will stop all uze of
the Service and will have no authority to uze the Service.

If you are deemed to have ordered the Service, PhoneTree's acceptance is expressly
conditioned upon azzent ta all the terms and conditions of thiz Service Agreement, to the
excluzion of all other terms; if these terms are conzsidered an offer by PhoneTree, acceptance
iz expressly limited to these terms.

TERMS AND COMDITIONS
1. THE SERVICE
The Ser\fice cohsizts of synchrpnizatic-n softwarg, an interactive_ vpice Iesponse syshem, a e

Cancel Help Hest

Read the Terms of Service, and click the box next to I accept the terms above.
Click Next.

OnDemand Account SignUp (3/9)

- Contact Info
Org Hame: Acme Corporation
* First M arme: * Last Mame:
Jane |D 0E
* Phane: Faw:
|66 555.1212 |966.555.1234
* Email |iane. dosi@acmecorp.com *4 digit PIN: 1234
* Confirm Email: |iane.doe@acmecorp.com * Confirm PIN: 1234
*Address 1: |'I 234 Anywhere Street
Address 2 ]Suite E
* City: [&rptown
Promo Code:
* Slate: [Morth Carolina | CEP [ 27104 [PS-0-BARA00S0MMYPT
LCancel | Help | Frevious | Mest

Fill out the form that follows (items in red are required fields). A valid e-mail address is
required to use PhoneTree OnDemand. Choose a four-digit account PIN, type in a
Promo Code if you have one, then click Next.



OnDemand: Setting Up an Account, continued

nDemand Account SignUp (4/%)

Account plan options:

|Basic Pay Per Call j

Compare Plans

Basic Pay-Per-f=
Mo marthly charge, | Call Vizard and
all of its enhanced funciionality to make your calls -0r fake ad'u'antage of the afiordable and
simple EasyCall feature. Ether way, pay only for te calls you subimi.

Basic Pay-Per-Gall Plan Details

A walid credit card [MasterCard, Visa, Discover or bretican Express] is required to use this option. Your
account infornation and all tansactions ave protected by 128-hit encryption. Calls are billed o 2 major
credit card at the time the call job is subrmitted, &t the rate appearing on the current OnDemared Rate Sheet.
Calls submitted with Easy Call are billed at a dizcount as compared to those submitted with the adwanced
funictionality of the Call Wizard [3ee curent OnDematd Rate Sheet for the latest prices).

PhoneTree will atterpt each call several fimes before deeming the call completed or not deliverable.
Check your call status 10 see how PhoneTree handled each call, See the PhoneTree manual or the

bt

Cancel Help Previous | Hext |

E) Read the descriptions of the available OnDemand account plans (switch from plan to
plan by choosing a plan in the drop-down box at the top of the window). Choose a plan
that fits your organization, then click Next.

i OnDemand Account SignUp (5/9)

- Basic Pay Per Call plan details: -

T e O KA L MR L 1.

LCancel Help Previous MHext

This next screen summarizes the current rates for the plan you selected. To continue,
click Next.




OnDemand: Setting Up an Account, continued

OnDemand Account SignUp (649)

—lsers - il
User Nare | UserPIN | Calllimit | Monthly Call Limit
< E
Add ‘ todify Bemove ‘
Lancel Help ‘ Brevious ‘ Hext |

On this screen, you have the opportunity to create users for this account. You must
create at least one user for an account. Your users will have the ability to place calls that
will be charged back to this account, but you (as the account administrator) can limit
how many calls they are able to place (both as a total user limit and as a monthly limit).
Click the Add button to create a user.

~Users:
User Mame = EL Al Lirci Fanthly Call Limit
OnDemand User: %] :_]

User Marne: |Jahn Doe J
Uszer PIN: 5789
Uszer Call Lirnit [erpty = na limit): 5000
User Monthly Call Lirit [empty = no limit): 50000

£ | &

— Ok Cancel —

| Add I Madify J Bemave J
Cancel ‘ Help ‘ Previous ‘ Hest ‘

m Type in the user’s name, assign a User PIN (not the same as the account PIN - users will
need to type in their own User PINs before being allowed to place calls), and set a
Maximum Job Size and/or a Monthly Call Limit if desired. Click OK. Repeat for other
users you wish to create then click Next.



OnDemand: Setting Up an Account, continued

OnDemand Account SignUp (7/9)

- Credit Card Info: -
Cardhalder's First/Lazt M ame:

|Jane |Doe

¥ Credit Card Address iz same a3 contact address

Payment Method: Credit Card Mumber: Expiration D ate:
|MasterCard _~| |oo00-0000-0000-0000 (06 | {2008 |

Payment information will be
']E. ﬂ encrypted before transmission
| | | | === over the [nternet.

Cancel ‘ Help ‘ PBrevious ‘

Enter the cardholder’s first and last name, then choose the Payment Method (Visa,
MC, AMEX or Discover) from the drop-down box. If the credit card address is different
from the address you entered in Step Two, un-check the box next to Credit Card
Address is same as contact address and enter the address expiration date (month
then year), then click Next.

OnDemand Account SignUp (8/9)

- Subrnit:

“¥ou have selected the Basic Pay-PerCall plan. There is no monthly fee far thiz plat.

Mo charges will be applied to your Credit Card at thiz time.

Choose Submit to Accept, Previous to make changes or Cancel bo quit.

LCancel Help Previous

This screen summarizes the options chosen for the account you are about to create. If
the information is correct, click Submit. To go back and make changes, click Previous.



OnDemand: Setting Up an Account, continued

nDemand Account SignUp (39)

= Submitted

and instructions.

Your requestfor an accountis being processed. You will receive an
email that will contain your new Account Murmber, an Activation Code

Help Brewion Daone

Now, using your regular e-mail program, check for a new e-mail message for the account

you typed in Step Two.

™ PhoneTree OnDemand Account Created - Message {Plain Text)

File Edit Wew Insert Format  Tools  Actions  Help -
CoReply  SReply to a8 Forward 72
From; Ondemand@Phonetres, com Sent: Fri5j7f2004 1;45 PM
To: jane doef@acmecorp. com
Cot
Subject:  PhoneTree OnDemand Account Created

Success! Your PhoneTree OnDemand account is ready for activation! s
Four PhoneTree OnDemand account has been successfully created.  Your
Aocount Number is: EEEEE., Your Activation Code is: HE-EEE. To activate
YOUE acCcount:

1) Launch the PhoneTree software.

2) Go to the Admin desktop (click on the Adwin tab) .

3] Click the Configure OnDemand icon.

4) On the Onlkemand S3ervice Adwministrator screen, click the "Enter
Aetivation Code™ button.

5) Enter your Account Nuwber (if it does not appear in the box) and your
Aotivation Code: EE-EEX. Click OK.

Congratulations! Now you are ready to start using PhoneTree OnDemand! You
can do this using Easy Call or the Call Wizard.

=From the Easy Call screen: vy

You will receive an e-mail message similar to this one, containing your Account
Number and Activation Code. KEEP this e-mail, in case you ever need to re-install
your software or if you decide to use the account on another computer. Also make note
of your account and user PIN codes.



OnDemand: Setting Up an Account, continued

OnDemand Service Administrator,

- Account Surmary: 1 Dialing:
Use this area code for all 7
Account Mumber ... L HERRE digit phone numbers:
Activation Code . ... ... ... W W 338
. = - Manage Account:
Email &ddress ... | jane. doe@acrmecorp. con
Create Mew ‘ Fdodify ]

Enter Activation Code Re-Open ‘ Get Lozt PIM ]
- Account Shatug: -

Account has not been activated.

Help

7 Enter your local area code in the My local area code box. Click the Enter Activation
Code button on the main screen of the OnDemand Service Administrator (the same
screen from step one).

Enter, Activation Code: g|

The Activation Code is supplied
by an ernall message from the
CnDemand Systerm in response
to a SignlJp or Change request.

Account Mumber: R
Activation Code: S

0k Cancel

7a Enter your Activation Code in the box under the Account Number. Click OK when
done. Now, the main screen of the OnDemand Service Administrator says “Account is
active.” Congratulations! Your account has been activated.




OnDemand: Submitting a Call Job

Submitting a Call Job:

Si PhoneTree [Z] |E|rg]

Mavigation Help

Publicity FhoneTree 2 FhoneTree 3 PhoneTree 4 PhoneTree 5
Committee

FhoneTres B FhoneTree 7 FPhoneTres 8

All calling is stopped. The CallCenter must be active for PhaneTree to send or receive calls.

Using EasyCall

a) Click on the icon on the PhoneTree desktop to go to the List Editor for the PhoneTree you wish
to use.

S PhoneTree
File Edit

D l; H ﬁ Llsirng :

Tools View Search Setup Import  Help

: #h
Mew Jpen Save Prink Using Call Wizard. .. Find
Beqgin Mew Calls ... |
IL ilimer
Tag|Name Phone | Stop Status

O | Tupper, Red AEE-B936 Mot Lalled et
[O| Graham, Linda 555-3345 Mot Called et
| Ziegler, Martin 5E5-7310 Mot Called et
| Evelvn, James 5E5-8152 Mat Called et
O|Faust. Mathan 5E5-7542 Mot Called et
MIMadiznn Heszter RRR-RRAZ Mat Called Y'et

b) Choose Using EasyCall... from the Call Menu.



OnDemand: Submitting a Call Job, continued

EasyCall

Record

Record your meszzage and
click [Call] or [Call Tagged].

[ Usze multiple languages

Call Tagged
Call Dptions
DOnDemand service to Cancel
e calls

]
Wolurme Help

¢) Record your message and use the controls on the EasyCall screen as described in the Your First Call
Job section (see page 40) of this user guide. Be sure the check box next to Use OnDemand service to
make calls is checked. Click the Call or Call Tagged button to continue.

Note: OnDemand messages have a maximum time limit of 1 minute when using Easy Call (time
subject to change). Please make sure your message's total length, including any and all message

content such as the More Info option, does not exceed this time limit.

Confirm Start Calls

You are about to call 1222 peoplz
uzing the view: Entire List
of the allmembers. mdb fist.

[The final count may be reduced after remawval of
duplicates, blocked numbers ete ]

Do you wish to continue?

[~ Dant show this dialag again.

d) This next screen summarizes the call job you are about to submit. If the information shown is

correct, click Yes.

Note: You can choose not to show this window in the future by checking the box next to Don’t

show this dialog again.




OnDemand: Submitting a Call Job, continued

OnDemand Packager .

- Uzer input:

Enter a walid Email Address and PIN code. &l notifications
related to this job will be directed to thiz address.

Email Address:
| jdoe@acmecarp. com

Uszer PIN:

E729

Lancel Help Freviols ‘ Mest ‘

e) Enter the correct User PIN created for a user in step four on page 117 (Step 4a), and the e-mail
address associated with this user. When done, click Next.

OnDemand Packager .

~“our Account: -

- Basic Pay Per Call-

Easzy Call Rate: Call'wizard Rate:
[ %8 [ 5.8

Minirmum Purchase: $H KK

User John Doe
tax Job Size: | 5000
M onthly b ax Calls: Wﬁ_
Calls this month: 1]
LCancel Help Previous

f) This screen summarizes the information for your account, including your call rate and allowable
calls for the month. When done, click Next.




OnDemand: Submitting a Call Job, continued

OnDemand Packager. E|

= Submit Calls: -
Your calls are scheduled to begin now.

Calls will be placed as Easy Call
Murnber of calls 1222
Less Call Credits (0) = 1222
1222 calls @ 588 = EESES
Min Charge (5544 Applies MO
Charge = $E.XX

Click Subrnitto accept these charges to your credit card and
begin calls.

LCancel Previous Submit

g) Now you will see a summary of the charges to be billed for this call job. If the information is
correct, click Submit.

- Subrnit Job: -

Sending your job to the OnDemand system...

OnDemand Connection

| Send PackageFile ...
L

LCancel Help

Next, the PhoneTree software will “package” the information for your call job and submit it to the
Call Center. You will receive a confirmation e-mail with a tracking number for your call job.




OnDemand: Submitting a Call Job: Call, continued

Call Wizard: Members @l

Dorel Select whom to notify, and click "Start Calls”

Select:
& Notfy | Lang View -

£ Resume

" Save changes and exit

v Check if you wish to uze the OnDemand service to place your calls

LCancel Help Cal Options... <- Previous

Using the Call Wizard

To use the OnDemand service with the Call Wizard, follow the steps you normally would to set up a
call job with the Call Wizard [read the Call Wizard section for the PhoneTree model you own: 2500
(pages 58-62) or 3500 (pages 72-81)]. On the last screen, make sure the box next to Check if you
wish to use the OnDemand service to place your calls is checked. After you click the OK
button, the remaining steps are the same as Steps d-g in the previous section, Using Easy Call
(pages 121-124).

Note: OnDemand messages have a maximum time limit of 2 minutes when using the Call
Wizard (time subject to change). Please make sure your message's total length, including any and
all message content such as the More Info option, does not exceed this time limit.



OnDemand: Getting Call Results

Getting Call Results:

S PhoneTree

File Edit WEEEN Yiew Search Setup  Call Import  Help
D onDemand Se Bt - ) Active Job ..,

Clear Call Skatus Campleted Jabs ...

Blocked Mumbers b

Trim List ko Match Filker. ..

Mew

a d Phon]Call Stalus_[Re

LE: Clear Entire List f
B H Redvnc this List to the Central database. ., g?ég 3232:223 E:::
: O FRelndex (remove unused ID numbers) 57-‘542 OnDemand cal
|| OJeveln. James Hhh-HTE 4q1-585-5152 OnDemand call
__ 1l O|Faust, Nathan 555-7542 440-555-7542 OnDemand cal
M/ badiznn Hester FRA-FRAD Adr-RRAR-RRE? MrNemand call

Active Jobs
To check the status of your submitted OnDemand call job or to stop it from calling, choose
OnDemand Service Jobs » Active Job... from the Tools menu.

S Active OnDemand Service Job

004 1241 P ShATY 5

Job waiting reason:

Hob iz not waiting
Wob iz calling

Placed: 0 Completed: 0 /12

g I Refrezh Stop Help

Here you can see your job number and file name, time and date of submission, selected call options
for the job, and number of placed and completed calls. Click the Refresh button to get updated
information, click Stop to stop a call job in progress, or click OK when finished.

Note: If you choose this option and receive a message that says “There are no active jobs for
this PhoneTree,” then your call job has been completed.



OnDemand: Getting Call Results, continued

i Phonelree
File Edit Tools View Search Setup  Cal

D w W 3

T Open Save Print ' Fixed Column
| csv
ID| Tag|Hame Phone | ASCI
> 1 [OQlJones, Brooks 338-955-8  Central database

Merging Results
Once your call job has been completed, choose Merge OnDemand Service Call Results from the

Import menu.

PhoneTree

Onbemand results have been merged ko:

allmermbers

You should receive a message that says OnDemand results have been merged to: name of your
file here>. Now, you can view, sort and print your results just as if you had placed the calls with the
PhoneTree hardware. Read more about the different PhoneTree Call Statuses in the Call Center

section (see page 85).

Note: If you choose this option and receive a message that says “Call Results for name of your
file here> are not available at this time,” then your call job has not been completed yet. Read the
previous step for instructions.




OnDemand: Getting Call Results, continued

Active Job ..,
Comple

allmemb:

= Clear Call Status 3
Blocked Mumbers
Trim List ko Match Filker. ..

D A |ated Phone |Call Statu:
yE g Coebbelat FRA308  |Ans by Pers
10 Resync this List to the Central database. .. EE.[526 &ns by Pers
4 Relndex (remove unused ID numbers) FR-S44F Ainz by Mac
14] || [Jenders','\ilncent a1 [E‘M’ Hhb202 ]"I EBT4 bEE-0202 Ang by +Me
Completed Jobs

To check the status of your submitted OnDemand call job, choose OnDemand Service Jobs »
Completed Jobs... from the Tools menu of the PhoneTree List Editor.

Completed OnDemand Service Jobs

Submitted
4

_ CallOnDays |

|A

| 2

ok Get Results Wiew Help

Here you can see the job number and file name, time and date of submission, and the selected call
options for the completed OnDemand jobs for this PhoneTree. Now click the View button.

OnDemand Job Viewer

k3 MName Phone Call Status LastCallTimeD ate Feplies CallCounter -
P |12 Fannagio, Mike E14 BB5-8808 Az by Person 05-10-2004 1113 Ak
15 Filler, Geoffrey £14 555-4005 Ang by Machine | 05-10-2004 11:13 AM) 1 Fees]
12 Smith, Fenton 14 555-0451 Ang by +haching | 05-10-2004 11:13 AM) 1
3 Streetman, Kay 614 555-0071 Ans by Perzon 05-10-2004 11:13 Ak 1
8 “ogel, Scolt E14 B55-0046 Az by Perzon 05-10-2004 11:13 Ak 1
9 Anderzon, Suzan | §14 BE5-5601 Az by Perzon 05-10-2004 11:13 Ak 1
10 Dallas, Jamie E14 B55-F200 Ans by Machine 05-10-2004 11:13 Ak 1
4 Darmell. Raquel 614 555-6074 Ans by Person 05-10-2004 11:13 Ak 1
14 Jenders, Vincent  |514 BR5-05Z26 Az by Perzon 05-10-2004 11:13 Ak 1
1 Jones, Brooks E14 B55-B446 Az by +hachine | 05-10-2004 11:13 Abd 1
& Kepler, Michael £14 555-0202 Ane by Machine 05-10-2004 11:13 A 1
7 LeFebure, Richard | £14 B55-2061 Ans by Perzon 05-10-2004 11:13 Ak 1
2 May, Sidrey 14 555-0076 Ans by Person 05-10-2004 11:13 &M 1
5 Nalan, Chris £14 555-1401 Ang by +hachine | 05-10-2004 11:13 &M 1
11 OfCcrner Karen | G14 BREONTA e by Parenn OR 102004 1113 fbd 1 ad

Here you can view the specific status information for this completed job. When you are finished
viewing, click the cancel X in the upper right corner.



OnDemand: Getting Call Results, continued

Completed OnDemand Service Jobs

Submitted
2004 11

= Call On Diays

Sl

|d\

2

5] Get Results Yiew Help

If desired, click the Get Results button to merge call status information back into this PhoneTree.
However if you have more recent call status information in this PhoneTree (from a subsequent call
job), doing so could overwrite the more recent data.

Click OK when done.
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PhoneTree Client: Initial Setup: Host PC Configurations

PhoneTree Client

The PhoneTree Client is a remote operation tool for your PhoneTree system which allows limited
control from other computers in your network. While it doesn't allow full access to all features, it
does let you start, pause, stop or cancel call jobs, record messages, import data, change call options
(such as the time and day your calls should go out), and view call results after your calls have
finished.

Note: PhoneTree Client does not provide the ability to view the List Editor (see page 38, step 3) or
make any changes therein.

Before use of the PhoneTree Client can take place, you must follow the steps in the Initial Setup
(Host & Remote) portion of this chapter. Proper connectivity and operation of PhoneTree

Client are reliant on these required steps. It is recommended that you consult your Network
Administrator to ensure the correct permissions are in place for your Windows login.

Initial Setup: Host PC Configurations:

8% Program Files B
File Edt Wew Favortes Tools Help
Qe - @ [F PO oeann Folders  [T11]~
Address |3 Cr\Program Files Rl = <3
| Hame Size  Type Date Modified )
CIMSHML 4.0 File Foldzr 11{14/2006 5:16 PM
e [ |Dmsmeo File Folder 8/14/2007 1:41 PM
St Folder [EaMetteeting File Folder 6/11/2004 5:12PM
b Add o remoue Eonine services File Folder 8/11/2004 5:11 PM
programs C530utlook Express File Folder 6/L3{2007 7:55 AM
J’) Search for files or =Pcs File Folder 12/5/2007 10:07 AM
folders File: Folder 12{6/2007 2:16 FM
ChQuickTime|  OPeEN File Folder 4/10/2006 2:06 PM
[ i s Folder Ta iR __J alesLogix ;::'f: File Folder 11/29/2007 1:33 PM
Seagate 5 File Folder 6122006 10:27 AM
1) Rename this Folder i5ervice Me File Folder 4/18/2007 2:42 PM
{5 Move thisFokder 5000t T Badd to srchive. File Folder 2/16/2006 3:05 PM
2) Conthis Fder 95ymantec B Add to "PhoneTreshiPu,rar” File Folder 1/23/2007 12:21 PH
5. CSymentet B compress and ema... File Folder 11f14/2007 10:33 A
the Web L ToniArts | B compress to "PhoneTreeMyPu.rar” and email File Folder 6/342006 1:33 PM
| &2 shere this foider ) Uninstall Tr File Folder &11/2004 5:20 PM
| |\ Chvoicewars.  9end To ¥ File Folder 10j12/2007 3:27 P
- ‘ () Email this folder’ fles ST — File Folder 8/3(2008 1,33 PM
i ‘ X Delete this Folder | Dwndowsl g, File Folder 5/21/2007 7145 A
R} [Chwindams & File Folder 12502007 3:16 PM
S——— | Cywindowsp  Creake Shorkout File Folder 1/25/2007 3:18 PM
Other Places & Windows | Delete File Folder 8/11/2004 5:11 PM
<o Loce| Dk (G 2 whindowsl]  Renams File Folder &/11/2004 513 PM
i A — File Folder 8/4/2006 11:41 AM
C3yWs_FTP File Folder 10{19/2006 2:53 PM
;’ ity Computer C5xerox File Falder §/11/2004 5115 PM a
W My Netwark Places v s

n First, the PhoneTreeMVPu folder must be shared on the PC where PhoneTree is installed
(Host PC). Browse to C:\Program Files and right-click on the PhoneTreeMVPu folder,
then click Sharing and Security....
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PhoneTreeM¥Pu Properties

__.GeneraIJ. Sharing _Security Eustomize-

*Y'ou can share this folder with other uzers on your
network. To enable sharing for thiz folder, click Share this
folder.

() Do not share this foldsr

{(®) Share this folder i i
Share name: [PhoneTreeMVF’u Select this U[]t"]"
Comment: | |
User limit: () Mavimum allowed

() Allows this number of users: [ "\_i

To zet permizssions for uzers who access this
falder over the netwark, click Permissions.

To configure settings for offline access Aick .
aching, Eaching
Set up access for individual -
Mew Share

users here this folder to be shared

T O e SO DT T T

“Wigw your Windows Firewall settings

Permissions

[ Ok H Cancel ]

n On the Sharing tab, click Share this folder, then click Permissions.

Permissions for PhoneTreeM¥Pu

[ Share Permissions |
Group or user names:
ﬂ Todd Jones [TJones@PCS. LOCAL]
| !ﬁ Everyone I
|
[ Add... ] [ Remove ]
Permizzions for Todd Jones Allow Deny
Full Cantrol ¥
Change fF
Read / O
Set all these
to Allow
[ 0K, i [ Cancel ] [ Apply ]

3 Select or add a Group or User and then set each permission to Allow. When finished,
click OK.

The Host PC is now configured to work with PhoneTree Client. Next, go to the Remote
PC (where you plan to operate PhoneTree Client from) and configure its mapped drive
settings.
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Initial Setup: Remote PC Configurations:

Open
Explore
Search...
Manage

Disconnect Network Drive...

Create Shorkcut
Delete
Renarne

Properties

Map Network Drive gl

Windows can help you connect to a shared network Folder

and assign & drive Istter b the connection so that you can
gl access the Folder Using My Computer.
__—
] Speify the drive letter for the connection and the folder

that you want to connect to:

Drive; [Pt v

Folder: [V Browse. ..

Example: Visarver\share
Reconnect at logon
Connect using a different user name,

Sign up for online storage or connect ko g
network server,

Cancel

n From the Drive drop-down box, choose an unused drive letter and click Browse....

Browse For. Folder

Select a shared netwark Folder

=R e Treervy

# I3 CustomImport
) Debug

) [5 User
2 Printers and Faxes
1) scheduled Tasks ~
3 |

[MakenewFolder | ok ][ cancel |

This window displays all the available networked folders seen from this PC. Browse to the
'"PhoneTreeMVPu' located on your Host PC that you set up in the previous section. Once
you find it, select it and then click OK.
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Map Network Drive @

Windows can help you connect to a shared network Folder
and assign & drive Ietter to the connection so that you can

gl access the Folder using My Computer.

__—

] Specify the drive letter for the connection and the folder

that you want to conneck to:

Drive; [Pt v

Folder: | UMATNPCYPhonaTrastPi v |
Example: iserverishare
Reconnect at logon

Connect using a different user name.

Sign up For online storage or connect ko g
network server,

The Folder drop-down box now displays the path of what you selected from the previous
step. To save the mapped drive you just configured, click Finish.

The Host and Remote PCs are now configured to work with PhoneTree Client. Please proceed to
configure PhoneTree Client to work with the PhoneTree system.
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Initial Setup: Client Configurations (Remote PC):

PhoneTreeMVP Network Client:

' The PhoneTrest¥Pu ssrver maching is not responding ...
y or

= The path to PhoneTreetMyPu exe is not valid!

PhoneTreeMVP Network Client

CustomImport,dat on the PhoneTreeMYP system is not available at this time, ‘You cannot configure the Translator,

After installing the PhoneTree Client on the Remote PC (see page 9), launch it by clicking
on the PhoneTree Client icon on your PC’s desktop. The first time PhoneTree Client runs,
you will see these two warning messages appear, one after the other. Click OK for each of
them to proceed. The following configurations will address these warnings.

Configure PhoneTree ¥1.1.16 @
Path to PhoneTieebd'Pu.gxe [look in...\Program Files\PhoneT ieehd'/Pu]

|\ Browse Sever

Path...
Path ta Folder for PhoneTree LOCAL DATA [ C:\Program Files\PhoneTreeClient] \ [:ll[:k hErE to |ﬂ|:ﬂle Ihe

|\ Make Dt PhoneTreeMVPu.exe file

Chaose the tranglator that matches this application's file format.

| =

™ Delay stop after record. Check thiz if the end of vour recording is being clipped.

LCancel

n The Configure window will now appear. Click the Browse Server Path... button.

Find Phone TreeMYPu.exe

Look in: [ 52 PhoneTreehvPu on MAINPC [MAINPC) [P v | 4= = BB~
. I asPml B} EzCombiner.exe
L.ﬁ IC5 AP mISend 5 L5Helper exe
My Recent |75 CustomImpart, MAPIMessageMailer. exe
B e OnDemandServer exe
rc; (el
IEInstallcache B PrinterInterface exe
Deskiop |5 065 Brrobos exe
i Temp Elzoupserver.exe

ICyUser (@ webServiceCannsctivity Tester.axe
B utoreportPracessor.exe WinFaxProFaxxer.exe

B ctReportGenerator exe WinFaxProfPFaxer exe

(@) ckiMailer . exe [zipExtract.exe

55 DMC.exe

=

£
L B
CAHE

RN

3

=

My Computer

‘“1; File name: [ProneTreehvPu exe =] Open
My Netwok  Flles of types [Fese) =] Cancel

Fl
laces [ Open as read-only

3 Browse to the PhoneTreeMVPu.exe file located on the mapped drive you set up in the
Initial Setup (Remote PC) step, select it and then click Open.
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Configure PhoneTree ¥1.1.16 ]

Path to PhoneT reebPu.exe [look in ... \Frogram FilestPhoneT reebdyFu]
|P:\

OHEE SEVE
Fath...

Path to Folder for PhoneTree LOCAL DATA [ C:\Program Files'PhoneT reeClient]

C:\Program Files\PhoneTreeClient', Make Default
Local Path
Click here to set

Chaose the tranglator that matches this application's file format.

= default path
Select your /ESV = e

[ Delay stop after record. Check this if the end of your recarding iz being clipped,
translator

oK LCancel

The Configure window reappears. You will now see in the Path to PhoneTreeMVPu.exe
field that only the mapped drive letter appears. This confirms that you have the correct
path set.

Next, to create a default folder where all your calling preferences and other data will be
kept, click the Make Default Local Path button. A folder will be created on your hard
drive in the location shown, and this is where all data generated by the PhoneTree Client
software will be stored.

Next, select your translator type from the Choose the B clientlist.txt - WordPad A=

translator drop-down box. This translator will be used if | & eu it fomt reb
you generate a calling list locally, on your Remote PC, and |EZ® S& & B %

. . Roberts, Mike, 5555656
you want to send it to PhoneTree to use when starting a e
call session. CSV will translate any comma-delimited text SR A el
. : B . Elwood, 5555261
(ASCII) file that follows the format to the right (last el
s 1 P ton, Moel, 5555822
name, first name, phone). Use this unless you commonly ermingon Bosl oo

use a member database program and its translator appears | unierons, Ransy, 3325550095
in the dropfdown box. Wihite, Charles, 13305652372
Zimmerman, Taylor, 13365551256
. . Brown, Zigay, 5555261
Click OK. You are now ready to start calling. Carter Vintbnt, 13568555975
Coldway, Greg, 13365554213
Fisher, Burt, 5552345
Fartas, lke, 13365561450
O'John, William, 13365553987
Pruitt, Steve, 5558695
Richard, Roy, 13365566235
Alabaster, Stanley, 3365552222
Biltless, Dora, 558955
Bishops, Cory, 5652372
Elrod, Myma, 13365551274
Flemma, Jimmy, 5550521
Heckman, Ken, 5551243
Kilebrew, Harmaon, 5559506
Kiles, Audrey, 5556185
Kilgore, Dave, 13365557100
Phillips, Caroline, 5555201
Roberts, Bob, 5552365

For Help, press FL / 7

This is a sample ASCII
file, viewed in WordPad.
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Initial Setup: Call Options (Remote PC):

Once you are finished with configuration, you will see the Call Status window, which is the main
window for the PhoneTree Network Client. To initiate a call session:

PhoneTree Call Status I'S( |

Fil=  Help

PhoneTree Mame Status i  Placed Complated

Blood Drive: Calling
Softball Team Calling
Murgery Done

SERVER Status @ Calling & Moelnfo =
2 Paused
o 0ff PhoneTree E it

Click on the PhoneTree button.

Choose a PhoneTree I$_<|

Blue Ridge Graup
Event Committze
Admiristrative
Mizzion Trip
Elood Drive
Meals On Wheel:
Grounds Committes
Greeters

g
Caretakers
“Fouth Softbal
“olunteers
Band
Yauth Study
Adulk Study Lancel

News Letter

Softball Team
Girls Basketbal oK

Choose the PhoneTree you would like to access from the menu, then click the OK button.
PhoneTrees protected by a password will be marked with an asterisk (*). Note: Be sure
the PhoneTree you select already has a Call List file created for it (see page 38, step 2).

|

[

§:{\ Easy Call: Fund Raising

| -~ Call-
Speaker

Valume B
Hecord = = Stop

Seconds: 0.0

@ Callthe new list | have selected: Use File>Select!
" Call the list PhoreTree already has: Fund R aising mdb

F‘iease un .S.étup-E;I.I .El.:;t.\onsuio creéte an opt‘lons‘ f‘\‘l‘e‘ for“t‘ﬁlé ﬁhnnéhee.

The Easy Call dialog will appear. From the Setup menu, choose Call Options.
138
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Call Options

Call Times T Call Options T Transfer Options TAdvanced I]ptionsT :

Call On Days: ™ 5un W Mon v Tue [T Wwed W Thu v Fri [ Sat

Don't Call Before: | 08:30 AM| 08:30 AM| D8:30 AM| 08:30 AM| 08:30 AM| 10:00 AM| 08:30 AM
Don't Call After 08:30 PM| 08:30 PM| 08:30 PM| 08:30 PM| 08:30 PW| 07:30 PW| D8:30 PH

Start Night 05:30 PM| 05:30 PM| 05:30 PM| 05:30 PM| 05:30 PM| 05:30 PM| 05:30 PH
Meszages Al

v Use Pause/Resume ™ Use Scheduled Start Date/Time
Pauge Call At: 05:00 P
Fesume Call At 06:00 PM

Ok | Lancel | Diefaults |

n The Call Times tab will be active. Choose days to call by clicking the box(es) next to

each day. Change the Don’t Call Before and the Don’t Call After times by clicking on
them. A Set Time box will appear, allowing you to make changes. There is a checkbox
called Allow Different Times for Each Day. If you choose this option you can change
the Don’t Call Before and the Don’t Call After times to something different each day.
Also, you can choose to use Pause/Resume (to pause calling when people are eating
dinner, for instance). Turning this option ON brings up the pause/resume times.

Call Options
Call Times i T Transfer Options TAdvanced DpliunsT :

\ {
B S~ N v Hangup Detection
T~ I &llow Star to Repeat tax Rings to Ma Answer 7 m
E I~ Play Message Twice to Every Person
|~ | Buick Cal Mode Vi 15 n
/ L |~ CountRepliestods
1
X tdax Length of Answering
E /// Jab Pricrity: Wid = Machine Message (secs) 25 n
/ / R G Pauze thiz many seconds 0
E d OFF = after the message finishes ta
/ peimit uger time to press
ok | LCancel | Defaults

Click on the Call Options tab.

A. Selecting the Hangup Detection option means that if the called party hangs up early,
PhoneTree will note this is in the status report (Recommended setting: ON).

B. Allow Star To Repeat gives the listener the option to repeat the message by pressing
the Star (*) key on their phone. If you choose this option, you will need to add “To hear

this message again, press the star key now” toward the end of your message, followed by
a pause to give the listener time to press (*) (Recommended setting: ON).

C. Play Message Twice to Every Person means that each time PhoneTree delivers a
message, it will play the same message twice. This option significantly lengthens the time
ti takes to finish a call job (Recommended setting: OFF).
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D. Quick Call Mode speeds message delivery by calling only people who answer right away.
During the first round of calling, PhoneTree will only ring 3 times at a number before
hanging up and going to the next number. The result is that answering machines or voice
mail, which typically pick up after the 4th ring, will be called last. During subsequent rounds
of calling, PhoneTree will revert to its normal calling setups (Recommended setting: OFF).

E. Count Replies Mode tells PhoneTree to stop calling after the desired number of people
press 9 in response to your question. For example: “Hi this is Steve. I'm calling to get three
volunteers to help paint the gym. If you can help, please press 9 now. --pause-- Thanks!” If
this option is selected, a Replies Needed number appears (default: 5) where you can change
the number of “yes” (9) replies from 1 to 1000. This mode only recognizes 9 when dialed on
touch-tone phones. This feature is especially good for seeking a limited number of
volunteers, because PhoneTree will stop calling after the number of desired 9 replies are
received (Recommended setting: OFF').

F. Job Priority enables you to specify whether your job is Low, Medium (Mid), or High
priority. Use Medium (Mid) for most call jobs, High for when a job is urgent and needs to be
completed quickly, and Low for call jobs that aren't as time-sensitive as most. If you select
High, your call job will precede all other current jobs and will be completed first
(Recommended setting: Mid).

G. Automatic Job Expiration lets you specify how long a call job should be active before it
expires. This is useful for large call jobs that can’t be completed in one day. Use Specify
Days to select a set number of days between 1 and 255 or Specify Date to select a specific
date from the time you launch the call job (Recommended setting: OFF).

H. Max Rings to No Answer refers to the number of rings before PhoneTree considers the
call to be not answered. Select a value between 3 and 8, keeping in mind that most
answering machines will pick up after the 4th ring (Recommended setting: 7).

I. Max No Answers can be set from 1 to 15. PhoneTree will call a number back this many
times if it gets a busy signal or no answer. PhoneTree automatically spreads reattempts to
these numbers throughout the day (Recommended setting: 15).

J. Max Length of Answering Machine Message (secs) can be set between 25 and 80
seconds. Change this only if you see “OGM Too Long” in the status report (Recommended
setting: 25).

K. Pause this many seconds after the message finishes to permit user time to press is
helpful if you are using the “Star to Repeat” option. Use it to assure that the recipient has
enough time to press the Star key (Recommended setting: O, when using Star to Repeat: 2).
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Call Options

Call Times T Call Options T Transfer Options TAdvanced I]pliunsT £

Call Transfer Method:

m Phone System

3wap Call
E r Check to use a different transfer
methad at night.

oK | Lancel | Diefaults |

Click on the Transfer Options tab. There are four options in the drop-down menu: Off,
Mailbox, Phone System and 3-Way Call. Unless set to Off, any time recipients press O
during a PhoneTree message they will be transferred to the location you specify here.

A. Mailbox: This option allows your members to leave you a voice mail message, just as if
you had an answering machine hooked up to PhoneTree. You will need to record an OGM
(outgoing message) on the Host PC that will be played after a member presses 0. To do
this, click OK on this screen and read the help files for Mailbox Messages on the Host PC.
Don't forget to tell your members in your PhoneTree message to press O if they want to
leave a message.

B. Phone System: This allows your members to be transferred to a live operator in your
office. You will be prompted to specify the extension to where the call will be transferred,
and also to specify a hook flash delay (leave at 3 unless you experience problems). This
option requires that PhoneTree be connected to an analog extension on your phone system.

C. 3-Way Calling: Choose this option if you subscribe to 3-Way Calling through the phone
company and you’d like your recipients to be able to be transferred to another number.
You will need to specify the number to where the recipient will be transferred, and also to
specify a hook flash delay (leave at 3 unless you experience problems).
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7

E Pager. Call Logging: Call Logging Off h J g

Call Options

Call Times T Call Dptions T Transfer Options T,A ced Op “ST €

m Gslng Duplicates'Blocked Numbers: Daily Calling: m

Prefiz: ,7
sulw [ * Keep Duplicates E [~ Auto Call Each Day
) " Same Phone

£ Same Nane and Phans e
L1 Newver hd
L2 Femove Blocked
i Numbers
15 -

[~ Create Results File [Jobxx.out] for another application. /

L4 3 :
I Lllovs Client to View Call Status E

~

oK | Lancel | Diefaults |

Click the Advanced Options tab. In general, we recommend you not change these
options unless directed to do so by a PhoneTree technician. However, you may need to
adjust these settings in special cases.

A. These dialing settings are included here if you need to make adjustments on a
per-PhoneTree basis. For example, suppose you want this PhoneTree only to talk to
people who are at home (i.e., to never leave a message on an answering machine). You
would put an “A” in the Suffix box (which tells PhoneTree to hang up when it detects an
answering machine). Remember, any Prefixes, Suffixes, and Library numbers you type
here will be in addition to any others typed on the Configure Phone Lines dialog on the
Admin Desktop of the Host PC (which are system-wide).

B. If this PhoneTree will be calling any pager numbers, type in the callback number here
in the Pager box, and be sure to put a “C” in your list after any pager phone number (i.e.
722-5992C). Doing this will ensure that PhoneTree will leave your callback number on the
pagers it calls.

C. Duplicates/Blocked Numbers: PhoneTree will remove duplicates automatically, if you
check one of the two options here. Selecting Keep Duplicates (default) will keep your list
unchanged. Keep Removed Blocked Numbers ON (default) unless you would not like
PhoneTree to remove the people on the Blocked Number list (see page 172).

D. Daily Calling: If you would like this PhoneTree to call the same list each day (during
the call window(s) you set on the Call Times tab), check this option. You can also print
your call status report automatically (choose from Never, No Answer/Not Confirmed or
After Max Tries). Default: OFF

E. Create Results File (Jobxx.out) for another application: If you would like to save a
call status file that another application (e.g. your member management program) can use
later, check this option. Default: OFF

F. Allow Client to View Call Status permits the client to view the call job results after a
call job is complete. Note: This same setting must also be enabled on the Host PC in order
to work (see page 145).

G. Call Logging: To have calls made with this PhoneTree included in the system-wide call
log, choose either Log Completed Calls or Log All Calls from the drop-down box.
Default: OFF

Click the OK button.
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Fa Easy Call: Fund Raising

File Setup

Message Call

Speaker
Play ,.M.olume
]
Becord T Stop

Call List

e |t

Seconds: 1.4

" Call the new list | have selected: Use File-» Select]
i+ Call the list PhoneTree already has: Fund Raizing.mdb

You will be returned to the Easy Call screen. To record your message, press the Record
button. After you hear the beep, immediately start speaking your message into your
microphone headset. You will see a counter displaying the time elapsed. Once you have
completed your message, press the Stop button. To preview your message, click the Play
button. If you don't like your message, press the Record button again and record over the
old message (if the voice quality is too soft, check the mixer settings for your sound card).

When you are happy with your message, click one of the radio buttons at the bottom of
the screen:

a. Call the new list I have selected: Use File » Select!: Use this if you have generated a
new list locally (on your computer) using third-party software. Turn to the Importing Data
section (page 148) for instructions on how to do this.

b. Call the PhoneTree already has: <name of file>.mdb: Use this if you want PhoneTree
to call using the file that is currently active on the server machine for this PhoneTree. The
correct name of this file will appear here (if you see No list available! then you will need
to go to the PhoneTree host computer and select a list for this PhoneTree).
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Daily Operation: Starting a Call Job (Remote PC):

:‘:\\ Easy Call: Fund Raising

File  Setup
Meszage Call
Speaker
Play Pause
Record Stop Click here to
| start calls.
Seconds: 1.9 CallList
~ Callthe new list | have selected: Use File->Select!
& Call the ligt PhoneTree already has: Fund Raising.mdb

n To start calling, click the Call List button on the Easy Call screen:

PhoneTree Call Status El

File Help

PhoneTree Mame Placed  Completed
Blue Ridae ¥ Calling 70 EF #1127
Blood Drive Calling i 42780
Fund Raizing Call i 0/26

Softbal Team g 0/16
iy Calls will be paused as 51
your new job is added.

SERYER Status @ Calling & Momelnfo =
2 Pauged

o of Esit |

The light on the Server Status will turn from green (Calling) to orange (Pausing!), to
yellow (Paused) and finally back to green again, when you will see your new call job
appear in the list of PhoneTrees.

You can monitor calls for the currently active PhoneTrees right here from your own
computer. The information shown is updated every few seconds.
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Daily Operation: Checking Call Status (Remote PC):

Before you can access the Call Statuses from the Client, you must do the following:

On the Host PC, browse to this folder: C:\Program Files\Windows NT. Locate the folder named

Accessories, right-click on it and choose Copy. Next, go back to C:\Program Files, right-click in
that folder and choose Paste. This will copy the Accessories folder into the Program Files folder.

Once your call job is complete, you can check the Call Status, for a complete report on the call job.
Here’s how:

Call Options

Email| OnDemand |
Times/ Days | CallSettings | Transter  Ad Options | Adv Disling | Remate] Copy | Cential Database |

Dion't call duplicates with same: |~ Export data
¢ Phone [ Create expot file for use by ancther application
€ Mame and phane #

@ Callal duplicates v Allow network clients to view call status of this list:

- Calllogging: [Loaging is OFF ~|
Dantt call numbers in
w
blacked number list :
Deliver message t answering machines:

Make sure this Dai callng

I Auto call each day

hox is checked.

o | Concel | Defauts | Help

First, you must contact your PhoneTree Administrator or visit the Host PC. Open the
PhoneTree icon you are planning to use and choose Call Options from the Setup menu
or tool bar. Click on the Advanced Options tab and make sure the Allow Client to
View Call Status box is checked. This must be done on the Host PC and on the Remote
PC in the client (see page 142). You will only need to do this once for each PhoneTree.

PhoneTree Call Status

File Help

PhioreTree Name Placed
Blue Fidge Group Calling 36
Blaod Dirive Calling id 42
Softball Team Calling 1]
Murzeny Done 12

SERVER Status @ Calling &= More Info =
3 Paused
o 0ff EhnnaTreE| Exit |

Now, go back to the PhoneTree Client on your Remote PC and click the PhoneTree
button on the Call Status screen.
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Choose a PhoneTree [szl

EBlue Ridge Group ~
Event Committee =
Administrative

Mizssion Trip

Blood Drive

Meals On Wheel:

Grounds Committes

Caretakers
‘Youth Softbal
Wolunteers
Band

“routh Study
Adult Study LCancel

Mews Letter

Saftball Team
Girls Basketball i Ok

Call

Wiew Call List Speaker
Select: Call List Walume
Exit - -

Pause

Stop

Seconds: 2.0

U

&+ Call the nev list | have selected: Use File->Select!
¢ Call the list PhoneT ree alieady has: Fund R aising. mdb

Now you are back on the Easy Call screen for that PhoneTree. Choose Update Call
Results from the File menu.

PhoneTreeM¥P Metwork Client

<2

‘u",/ This action will kemporarily pause all calls at PhoneTreeMYP, Do you wank bo continue?

== |

B Click the Yes button on the dialog box that appears.

PhoneTreeM¥P Network Client

‘Your call request has been succesfully sent ko PhoneTree.
It mav take a minute or mare before PhoneTree acts upon this request,
‘fou will be able to view new results after PhoneTreeMyP Pauses & then resumes Calling,

n Now you should get a notification that looks like the one above. Click the OK button.
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You will be taken back to the PhoneTree Call Status screen (the main Client screen) and
you can watch as calls are temporarily paused while an up-to-date call list is generated on
the Host PC.

n Once calls have resumed and the green light is back on, click on the PhoneTree button
again, and choose your PhoneTree from the Choose a PhoneTree screen again (repeat
steps 2 and 3).

T Easy Call: Blue Ridge Group

=8 Setup

Update Call Resulks Cal
Speaker

Select: Call List Walure

Exit - -

Seconds: 0.0

(& Call the new list | have selected: Uss File->Select!
 Call the list PhoneTree already has: Blue Ridge Group.mdb

n Choose View Call List from the File menu of the Easy Call screen.

ob.txt - WordPad

File Edit ‘iew Insert Format Help

el S #A B

PhoneTreeSEDD Call Status results as of: 12-06-2007 at 03:03 PN

Name Phone Translated Phone Last Call Status Date Time R
Adams, Meghan (336) E555-9047E5 Ans by Person 12-06-2007 01:43 PHM
Anderson, Rebecca [336) 555-9949 Ans by Person 12-06-2007 01:45 PH
Forester, Lauren (336) 555-5935 Ains by Person 12-05-2007 01:47 FH
Gonzales, Jessie [336) 555-7911 Ans by Person 12-06-2007 01:50 PH
Horton, HMaria [(3368) 555-5579 Ans by Ferson 12-06-2007 01:52 FH
Morton, Carrie [336) 555-4741 Ans by Person 12-06-2007 0O1:54 PH
Mory, Julia [336) 555-3354 Ans by Person 12-06-2007 0O1:58 PH
Motsinger, Jenna [336) 555-4354 Ans by Person 12-06-2007 02:01 PH
Nostitz, Carol [336) 555-2112 Ans by Person 12-06-2007 02:04 PH
Pirkle, Christina [336) 555-1410 Ans by Person 12-06-2007 02:06 PH
Rabil, Emily (336) 555-8392 Ans by Person 1z-06-2007 02:05 PH
Fodgers, Sarah [(336) 555-9513 Iins by Person 12-06-2007 02:11 PM

The Call List (including the most recent Call Statuses) for this PhoneTree will be opened
automatically as a text file (Job.txt) in WordPad. This is a new text file generated by
PhoneTree and now resides in your PhoneTree Client folder locally, on your PC. It should
look like the picture above.
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Reference: Importing Data (Remote PC):

Before you can import data using the Client software, the translator for your file type must be

configured for PhoneTree on the Host PC. If this is not done beforehand, the file import may fail.

PhoneTree can use data generated by any data management software.
If your database application can produce an ASCII (.dat or .txt), or a
Comma Delimited (.txt), CSV file, then you will be able to import

H| clientlist. txt - WordPad
File Edit View Insert Format Help

EBX

DEH &0 # -

the data into a list that your PhoneTree can use. Different applications
(such as Microsoft Word, Excel, etc.) will have different ways of
saving data into one of these formats. Look for an Export or Save As
command in the file menu. Read the documentation that came with
your database application instructions. For simplicity, save the
exported data in the PhoneTree Client folder. In addition, your
application may have a Custom Translator (that will appear on the
Configure PhoneTree screen - see page 137) Following is an example
using the most common translator, CSV, assuming that you have
placed the exported file in the PhoneTree Client folder.

PhoneTree Call Status
File Help

PhoreTree Mame Placed
Calling a6
Calling

Calling

Done

Completed

Blus Ridos Group
Elood Drive
Softball Team
MNursery

SERYER Status @ Calling
O Paused
< 0ff

& Mo lnfo >

PhoneTree I Exit I

&)

Roberts, Mike, 5559856
Sherman, Stuart, 5554512
Sherman, Tracy, 13365550633
Smith, John, 8551772

Brown, Elwood, 5555261
Fischer, Russell, 5559821
Pennington, Noel, 5555822
Smith, Paul, 13365555589
Underwood, Randy, 3365550096
Welch, Luther, 5551212

White, Charles, 13355582372
Zimmerman, Taylor, 13
Erown, Ziggy, 5555251
Carter, Vincent, 133655590958
Coldway, Greg, 1336555413
Fisher, Burt, 5552345
Fortas, lke, 13365551450
Q'John, William, 133655539
Pruitt, Steve. 5550695

This is the exact format
that your data will
need to be in to work
with the CSV translator.

First, confirm that CSV is chosen on the Configure PhoneTree screen (see page 137).
This translator is actually stored on the Host PC, not locally on your computer. Now,
click the PhoneTree button on the main screen (PhoneTree Call Status).

Choose a PhoneTree

Blue Ridae Group A
Evert Committze =
Admiristrative

Mizgion Trip

Elood Drive

Meals On‘wWheels

Grounds Committes

i i
Caretakers

‘Youth Softbal

Volunteers

Band

Youth Study

Adult Study

Lancel
MNews Letter
Softball Team
Girls Baskethal bl Ok

n Choose the PhoneTree for which you would like to import a file

and click OK.



Phonelree Client: Reference: Importing Data (Remote PC), cont.

§‘\\ Easy Call: Fund Raising
File: =i}
Update Call Resulks Cal

Wigw Call List Speaker
Walurne

Stop

e |:

Seconds: 0.0

(& Call the new list | have selected: Uss File->Select!
 Call the list PhoneTree already has: No list available!

E) Choose the “Call the new list I have selected” radio button, then choose Select Call
List from the File menu.

Select a Call List to send to PhoneTree. .. E]

Look in: [ PhoreTres Cliert =l e BB
: IEDocuments
! EacsrhoneTresdlient.exe
My Recent | EBlPhoneTresclient. exe
D““’""‘S [®IPTrecexternalctrl.acx
Desktop
s,
My Documents
49
My Computer
My Network — File riame: [chisntist ta =l Open
Places
Files of type: [User ) =] Cancel

Choose the list you would like to use from the following dialog, then click the Open button.

Note: This assumes you were able to export your file from the application that created it as
a comma-delimited text file (.txt, .dat or .csv) and that you placed the exported file in the
PhoneTree Client folder.

T\ Preview: clientlist.txt

|[Ficterts. Mike, 5559555
Sherman, Stuart, 5554512
Sherman. Tracy, 13365550633
Smith, John, 5551772

Browin, Evood, 5555261

Fizcher, Russel, 5553321
Pennington, Moel, 5555322
Smith, Paul, 13365555589
Underwood, R andy, 3365550035
wielch, Luther, 5561212

‘white, Charles, 13365552372
Zimmerman, Taylor, 13365551256
N|Broven, Ziggy, 5555261

Carter, Yincent, 13365555958

E3

You will now be given the opportunity to preview the file before sending it to PhoneTree
for translation. Click OK if you are satisfied that this is the correct file.
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§‘\\ Easy Call: Fund Raising

File Setup

Meszage Call
Speaker
Play Walurne

Stop

Now the name of your

Call List . )
imported file shows up here.

Seconds: 0.0

bl

& Call the new list | have selected: clientlist.tt
" Call the list PhoneT ree aleady has: No list available!

You will be taken back to the Easy Call screen. Record a message if you haven't already
(follow Step 8 on page 143) and click the Call List button. Notice that the name of your
list now shows up on the screen.

PhoneTree Call Status

Fille  Help

Placed  Completed
Calling 7n 7

Calling
Fund Raizing Calling
Softball Team =
MNurgery

SERYER Status 3 Calfig & Morelnfo =5
0 Paused

< 0if Exit I

7 The light on the Server Status will turn from green (Calling) to orange (Pausing!), to
yellow (Paused) and finally back to green again, when you will see your new call job
appear in the list of PhoneTrees.
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Reference: The Call Status Screen (Remote PC):

)

PhoneTree Call Status

m —tFile Help

FhoneTree Mame Status Pri Placed Completed
Bluz Ridgs Group Caling Hi 70 57 /127

| Blood Drive Calling Mid 42 42 /80
Fund Raising Calling Mid 0O 0/26
Softball Team Caliing Mid 0O 0/16
Murzery Dione

E —1  SERVER Statws O Caling & Moelte = 4— m
2 Paused
O o

Esit ‘

A. The File Menu: Allows you to Configure your Client settings (page 136) or to Exit the program.

B. The PhoneTree List: Displays a list of all the PhoneTrees currently calling. Check the entries in
the Status, Pri(ority), Placed and Completed columns for information about what is happening
with each PhoneTree.

C. More Info: Click these arrows to see more information about each PhoneTree, including Start
Date, Start Time, Call From, Till, Call Days, Pause At, Resume At, Night, Call File, MaxRings,
MaxNo9s, and Xfer To.

D. Server Status: There are three options: Calling (green light), Paused (yellow light), and Off
(red light). Calling means the PhoneTree software is running and is currently in its call mode (the
Call Center on the Host PC). Pausing! or Paused means that the PhoneTree software is running,
but not in call mode (one of the other Desktops may be displayed). Off means that the PhoneTree
software is not running on the Host PC.

Call Status Screen Headers

Status: Will show Calling (calls are currently in progress), Done (call job is complete) or Idle (no
current call job scheduled).

Priority: Either Low, Mid (the default) or Hi. See pages 138-139 for instructions on how to change
the priority for a call job.

Placed: Will display the number of calls placed. This number is often larger than the number of
completed calls because PhoneTree will call back if no one answers the phone or if the line is busy.

Completed: Shows two numbers: the first is the number of people in your list who have been
completed. The second number is the total number of people in your list.

Start Date: The day on which the current call job was initiated.
Start Time: The time (on the Start Date) when the current call job was initiated.

Call From: Displays the Don’t Call Before time you specified on the Call Times tab of the Call
Options dialog (page 139).

Till: Displays the Don’t Call After time you specified on the Call Times tab of the Call Options
dialog (page 139).

Call Days: Displays the Call On Days you specified on the Call Times tab of the Call Options
dialog (page 139).
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Pause At: Displays the Pause Call At time you specified on the Call Times tab of the Call Options
dialog (page 139).

Resume At: Displays the Resume Call At time you specified on the Call Times tab of the Call
Options dialog (page 139).

Night: Displays the Start Night Messages At time you specified on the Call Times tab of the Call
Options dialog (page 139).

Call File: Shows the file that each PhoneTree is currently using for calling. Note: Any file sent from
the the Client will show up here as “ClientImport” (regardless of the name you gave it locally).

Max Rings: Displays the Max Rings to No Answer number you entered on the Call Options tab
of the Call Options dialog (page 139).

MaxNo9s: Displays the number of attempts PhoneTree will make if you have turned Intro w/9 ON
using the Call Wizard (must be done of the Host PC). Default is 3.

Xfer To: Shows the Transfer extension number (not the Method) you specified on the Transfer
Options tab of the Call Options dialog (page 141). Note: Will only display a number if you chose
Phone System as the Method.



Troubleshooting



Troubleshooting: Line Card Not Found

PhoneTree @

Line Card 1 was not Found, but is required For this operation.

The PhoneTree hardware is not responding. Please quit the program and
check the 1USE cable connection. Unplug and reconnect power to the LSE
unit. Wait 30 seconds and restart the progran.

Line Card Not Found
Q. I keep getting an error message that says “Line Card Not Found.”

A. This error always means that the PhoneTree software is having trouble recognizing the
PhoneTree hardware. This common problem of the PC not recognizing a USB peripheral can
occur with any USB device, not just PhoneTree. To resolve this, try the following steps in order:

Cause: Power Management is enabled under Windows XP AND/OR the PC is set to hibernate.

Remedy: To manage power, Windows XP will attempt to disable USB when a device is not
used. As the default behavior, this often does not work properly and may cause Windows to not
properly recognize a USB device (including PhoneTree). Fix this problem by following the
instructions on pages 18-20, then:

1. Disconnect the power cable from PhoneTree, wait 20 seconds, then reconnect the
power cable.

2. WAIT for Windows to recognize your new hardware and load the drivers. This step
may take several minutes.

Cause: The PhoneTree unit is not receiving power.

Remedy: Confirm that the PhoneTree wall transformer is plugged into the power adapter jack
on the back of the unit, and that the other end is plugged into an operational wall outlet. The
green power indicator light on the front of the unit will be on.

Cause: Electrical glitch, upgrade of PhoneTree or Windows software, installing any new
Windows program, or any other Windows anomaly.

Remedy: Reboot the PhoneTree USB unit (Disconnect the black power cable for 15 seconds)
then reboot your PC (start » shutdown » restart). Reconnect the black power cable directly
after you choose restart.

Cause: Starting PhoneTree software before Windows finishes booting.

Remedy: Whenever restarting your PC, be sure all boot activity has completed prior to starting
the PhoneTree software. Be sure your mouse pointer is NOT showing the “hourglass” for at
least 10 seconds prior to starting the PhoneTree program.

Cause: PhoneTree’s USB cable is not properly connected or is faulty.
Remedy:

1. Confirm that the PhoneTree USB cable is firmly plugged into both the USB port on the
back of the PhoneTree unit (please note: this cable should not be forced to sit flush with
the USB port on the unit), and the other end is plugged into an available USB port on the
back (or front) of your PC.

2. Unplug the PhoneTree USB cable from the back (or front) of your computer and try
plugging it into a different USB port.

3. Replace the PhoneTree USB cable with a different USB cable.

4.Connect a different USB device to the same USB port on your PC and check to see if the
device is recognized in the Windows Device Manager (see page 18).
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Cause: Improperly installed PhoneTree USB driver software.

Remedy: Uninstall PhoneTree software using the Control Panel “Add/Remove Software”
dialogue. Then reinstall PhoneTree software from the original disk. Note: Any calling lists and
settings will be retained and will not be affected by this procedure.

Cause: Improperly installed or corrupted PhoneTree USB driver software

Remedy: Disconnect your PhoneTree’s USB cable from the PC and the PhoneTree power
transformer. Then remove your USB root hub by right-clicking on the “My Computer” icon,
selecting the Device Manager under Hardware, then right-clicking on “USB Root Hub” under
“Universal Serial Bus controllers” and choosing “Uninstall” from the pop-up menu. Restart
your PC, then reconnect the PhoneTree power transformer and the USB cable to the PC.

If you have tried all these suggestions and you are still receiving the error, please contact
PhoneTree Customer Support at 866.234.2943.

Q. I connected the USB cable before installing the PhoneTree software. I've got the software
installed now. How should I fix this?

A. Follow these steps in order:

1. Open the Device Manager (see page 18) and remove the unrecognized devices
(designated by exclamation points) by right-clicking on them, then choose Uninstall from
the drop-down menu. Repeat for each unrecognized device.

2. Unplug the PhoneTree power transformer.
3. Reconnect the PhoneTree power transformer.

4. Wait as Windows recognizes your new hardware and loads the drivers. This step may
take several minutes.
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“SiPhoneTree
Mavigation Help

CallCenter ]

Lines 114 |

2 [ Remote: Line 2 4

Flease Connect Telephone Card ard is not Present

PhoneTree: Line 3 oneTree: Line 4 4

Wolume

-
tute:

Line Card is not Present Line Card is not Present

09:25 A
PhoneTree Infarmation/ Status & Moelnfo =
# FhoneTree Status Fi  Placed Completed Not Before Mot After  Call Days
1 Social Committee: Calling Mid 2 1/38 03:30AM  08:30PM  SMTWTFS
3 FRiesearch and Development Calling Mid 0 0/4 07:30PM 0330PM SMTWTFS

Mo ermors

To edit call lists or change seftings. click PALISE ta leave the CalCenter

Please Connect Telephone Cord
Q. I keep getting a message that says Please Connect Telephone Cord. How can I fix this?

A. This error message means that the PhoneTree software is not recognizing an operational and
correctly connected analog phone line, and therefore cannot make calls. There are several
reasons why you might experience this. After exiting from the PhoneTree software, try the
following steps in order:

1. Connect a Standard (Analog) Telephone 1 = /ﬁ/

Disconnect the PhoneTree phone line from the wall outlet.
Connect a known working analog telephone to this wall outlet, A
using the phone cable provided with PhoneTree. ‘

If the connector does not fit, contact your telephone provider to
obtain the correct wall connector for your line.

\
Note: PhoneTree requires a standard analog telephone line or an \/
RJ-11

analog extension on a digital phone system.
2. Verify Dial Tone

Lift the receiver and listen. If you hear a dial tone, proceed with the next step. If no dial tone is
heard:

Try a different phone cable instead of the one provided with PhoneTree. If you hear a dial tone
with the new cable, proceed with the next step (and continue to use the working phone cable). If
no dial tone is heard with the new cable, contact your telephone provider and ask for the
problem to be corrected.



Troubleshooting: Please Connect Telephone Cord, continued

3. Repeat For All Purchased Phone Lines

If you have a multi-line system, repeat steps 1 and 2 for all installed phone lines. Note that for
each line installed, you will need to have an analog phone line installed by the phone company
for PhoneTree to use in making calls.

4. Disconnect, then Reconnect the PhoneTree Power Cord

Disconnect the black power cable from the back of the PhoneTree unit. Wait a few seconds,
then reconnect the cable, confirming that the green light on the front of the PhoneTree unit is
on.

5. Reconnect the Phone Line Cable(s) to PhoneTree

Disconnect the analog telephone from the wall outlet and reconnect the phone cable(s) to the
phone port(s) on the back of the PhoneTree unit. Confirm that all other cables (USB, etc.) for
PhoneTree are connected.

6. Test Line

From the Admin desktop, click on

. ; T e o '
the Configure Phone Lines 2veute Ione e ]

Select line: | ‘

icon. @ Datected || [ Use diferent setlings at night A0 B
]

In the Select Line box, confirm 3 T ol ol ol
s v E = Make nals

that the lines purchased and
connected are displayed without
hyphens appearing before or after
the line number, and that each
line shows up as “Detected” with

Iv Wait for dialtone before dialing

f* Touchtone disling Pulse dialing

Optional line access and biling codes: 6

Prefis:

the green dot when selected (as
shown on Line 1 in the picture at
right). If one or more lines are
not Detected as shown on this

Suffis:

If phane numberis [77 digits or more, use:

Prefis:

Suffir:

screen, follow the instructions in
the Line Card Not Found

oK | T ‘ Defauls ‘

Help

troubleshooting section on page
154.

Select the line in question in the Select Line box, then click
the Test Line button.

On the Test Line Number dialog, use these controls to
determine if PhoneTree can detect a dial tone (click the Get
dialtone button) and make a test call (enter a number for
PhoneTree to dial, then click the Dial number button). If a
successful test call was made, click OK and repeat the
process with any other active lines.

Call Customer Support

If you have tried all these steps and none have worked, it’s
possible there is an issue with the line card inside your

Test Line Number: 1

Get dialtane

Mumber to dial:

Dial number

Say Hello
ok

i
= Wolumne

200 555 5555

PhoneTree unit or other hardware. Please call Customer Support at 866.234.2943.
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'S PhoneTree
Navigation Help

Lines 1104 | 5t 8] 81012| 131015
Pause
PhoneTree 1 = [ Not Avail Line 2 g
Adams, Meghan ——
1336 555-9475 | Son
Start Call Line is not Enabled
o ] - i ]
PhoneTree: Line 3 §_ [ PhoneTree: Line 4 € T
=
Mutz
Line Card is not Prasent Line Cardis not Prasent
11:08 AM

PhoneTree Information/ Status & Moelnfo =
% PhoneTree Status Fri Placed Completed Not Before NotAfter Call Days

1 PhoneTree 1 Caling Mid 1 0/18 08304M O0Z30PM SMTWTFS

Mo enars

To edit call lists or change settings. click PALISE to leave the CallCenter

Call Remote Won't Answer

Q. Why won't PhoneTree answer when I try to call in to configure a calling job?

A. The Remote Access feature allows you to access your PhoneTree using any touch-tone telephone
to change call settings and to initiate a calling job. If not configured correctly, your PhoneTree

may not answer when you attempt to access it by calling in. First, be sure you have set up the
Remote Access feature correctly (page 107). Following are some common causes for this problem:

1. Check to make sure that the PhoneTree computer is on, and that your PhoneTree is
correctly connected to the computer with the PhoneTree software running and in its calling

mode (i.e. the Call Center.

This needs to be the case anytime you try to call in, otherwise the PhoneTree
software will not answer, even if Remote is correctly configured.

Call Options

OnDemand
Times Days | CallSettings | Transfer | Adv Dpiions | Adv Diding  Remote | Copy | Cenral Database |

Remate access:

e B Dveride " Time/Days" tab
QT e B ¥ settings o alow remote call

ode: E8S7 session to begin immediately

Specify fils to usiNpr remats acces:

Be sure “Enable remote calling” and —
“Override Times/Days...” are hoth checked.

0K | Lancel | Defaults | Help

2. Be sure that Remote Access is enabled. click on the PhoneTree you wish to use from the
PhoneTree desktop, then choose Call Options from the Setup menu. Click on the Remote
tab. Make sure the box next to “Enable remote calling” is checked.
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3. Make sure the box next to “Override Time/Days tab settings to allow remote call
session to begin immediately” is checked. This will allow you to remotely initiate a call
session anytime, as in the case of an emergency.

Configure Phone Lines @|
Select line:
@ Detected [ Use different settings at night | ‘ s from [05:30 P il Joe
. 3
] Lire Lise:
Bl ™ Anzwer calls only
& ¥ Enat o Make cals

v Line may answer when not making calls
v ‘wait for disltone before dialing
f* Touchtone dialng  © Pulze disling

Optional line access and billing codes:

Prefix: |ET
Suiffix: |

If phone number iz {17 digits or more, use:

Prefix: |5'[

Suffiv: |

0K | LCancel | Diefaults | Test Line | Help

4. Check to see that the line assigned to PhoneTree is correctly configured for answering

calls. From the main screen, click on the Admin tab. Click on the Configure Phone
Lines icon.

a) In the Select line box, choose the line you wish to designate as a call-in line. Confirm
that the line is recognized by the PhoneTree software (check for the green Detected icon
at the top of the Select line box).

b) Be sure that the line is set to answer calls by clicking the radio button next to Answer
calls only or if Make calls is selected, check the box next to Line may answer when
not making calls.

5. Confirm that you are using the correct telephone number for the line assigned to PhoneTree.

6. Make sure the line assigned to PhoneTree is not shared with another device that may be set
to answer calls (fax machine, etc.).
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OnDemand

Q. I'm trying to send a calling job but I get a message saying that my account isn’t valid
anymore. How did this happen and what should I do?

A. If you receive the following message when trying to send an OnDemand calling job:

“OnDemand plan is no longer valid! Please return to the OnDemand signup wizard to select
a new plan.”

PhoneTree

OnDemand plan is no longer valid! Flease return to the OnDemand signup wizard o select a new plan.

The most likely cause is that the Promo Code that was entered when the account was created
has expired.

Here’s how to address the message and continue your calling job:
1. Click OK on the above screen.
. Return to the PhoneTree desktop [click the Exit button on the toolbar].
. Click on the Admin tab.
. Click the Configure OnDemand icon.
. Click the Modify button.
. Enter the Account PIN.
. Check the box next to Billing Plan.
. Click Next.

. Choose an Account Plan from the drop-down menu, then click Next.

© ® N O U1l A W N

10.You will see a window that says “Caution: you are changing your account type.” Click OK.
11.The next screen will summarize the details of your chosen Account Plan. Click Next.

12.0n the Submit screen, it will say “You have elected to change your plan type” with details
about any possible credit card charges. Click the Submit button.

13.The last screen says “Submitted: Your changes have been accepted. You will receive a
confirmation email.” Click the Done button.

14 .Click OK on the OnDemand Service Administrator window.
15.Click on the PhoneTree tab and click on the PhoneTree icon you were using.

16.Return to either the Call Wizard or the EasyCall screen and re-send the call job (the
recording(s) you made will still be there).
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Q. Can I initiate an OnDemand calling job remotely?
A. Yes, as long as you have the PhoneTree hardware. To do this:

1. Configure your PhoneTree for remote call-in by following the directions in the Configure
Remote Operation section of the help files.

2. Call in using any touch-tone phone and follow the instructions as described in the
Configure Remote Operation help files.

3. When you get to the Call Menu [8], press [3] to start the job using the OnDemand service.

Q. How many times will the PhoneTree OnDemand service retry numbers for unanswered calls
if nobody answers the phone?

A. The OnDemand service is designed for jobs that need to be delivered very quickly and as such,
will retry a maximum of 3 times (versus the default of 15 for the PhoneTree hardware).

S Active OnDemand Service Job

i Sl S i Rl e 0

Jaob waiting reason:

Job iz not waiting
Job iz calling

Flaced: 0 Completed: 0/ 12

aF. Fiefrazh Stop Help

Q. I sent a calling job but it appears to be ‘stuck’—nobody is being called. What should I do?

A. The first thing to try is to check the status of your job by following the directions on page 126 of
this user guide. On the Active OnDemand Service Job screen, check to see:

1. That under Job Waiting Reason you see “Job is not waiting, Job is calling”

2. That the Call Times and Days are the ones you wanted for this call job and that the job
was set to start calling immediately

3. How many calls, if any, have been Placed and/or Completed

If the information on this screen indicates that calls should be in progress but aren't, call our
Customer Support Department at 866.234.2943.
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Q. We've installed the PhoneTree software at work and are using the system, however I need to

install the PhoneTree software on my PC at home also. Is it possible for me to do this, and if
so, how do I activate the account I've already created?

. When you purchase a PhoneTree product with OnDemand, you are entitled to install and use

the software for OnDemand calls on an unlimited number of other PCs. To do this, use the
original disk and installation key to install the software on one or more other PCs.

If you purchased a hardware product, the first time you run the software on a PC without the
PhoneTree hardware connected you may see the following message:

PhoneTree

‘will you only be using the OnDemand service For making calls?
Recommend: [Ma]

“Will you only be using the OnDemand service for making calls? Recommend: [No]”

You should click Yes if you intend to use the OnDemand service (and not the PhoneTree
hardware) for all calls made from this PC. Clicking Yes will do two things: first, it will enable
you to use EasyCall and the Call Wizard to submit a calling job using OnDemand. Second, it
tells the system you will be using the sound card in your PC for message recording and
playback (so be sure to connect a microphone to the microphone jack on the back of your PC
and use it for your PhoneTree recordings).

Click the No button if you intend to connect the PhoneTree hardware to this PC later. Keep in
mind that you will not be able to use EasyCall or the Call Wizard to make recordings, etc. until
the hardware is connected.

Next, to activate an account you've already created, you will need the account number and the
activation code from your original e-mail confirmation (see page 119). When you have that
information:

1. Launch the PhoneTree software.

2. Click the Admin tab.

3. Click the Configure OnDemand icon.

4. Click the Enter Activation Code button.

5. Enter your account number and activation code on the dialog below:
6. Click OK.

i Enter Activation Code: g|

The Activation Code is supplied
by an email message from the
OnDemand System inresponse
to a SignUp or Change request.

Account Mumber: W
Activation Code: W

] Lancel
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7. You should now see the words “Account is activated” on the OnDemand Service
Administrator screen. Now you are ready to use the system on this PC. Follow the
instructions elsewhere in this user guide to initiate a calling job.

. Is it necessary to have a high-speed Internet connection in order to use the OnDemand
service?

A. Tt is recommended but not required to have a high-speed Internet connection for using
OnDemand. If you are using a dial-up connection, just be sure you have dialed in before
submitting an OnDemand call job.

Q. I tried to send a call job but got a message saying that there was no response from the
OnDemand server. What should I do?

A. The most common reason you might see this message is if your Internet connection is inactive
or incorrectly configured. Verify that you have an active Internet connection by checking e-mail
or bringing up a non-cached web page in your Internet browser.

Occasionally you may experience this message if there is a temporary issue with the main
OnDemand system. If you have verified that your Internet connection is working correctly, wait
a few minutes and then try to send the call job again.

Q. I closed an account I created and now I want to create another account using the same
e-mail address. Why can’t I do this?

A. For security reasons, the OnDemand system identifies each account with a single e-mail
address, even accounts that have been closed. This way, if you ever wish to re-open a closed
account, your account information will be restored, including the original e-mail address
associated with the account.

You may not have more than one account associated with a single e-mail address, however you
can re-open the closed account, change the account e-mail to a different e-mail address, save the
changes, close the account again, then use the now-free e-mail for your new account.

Q. I typed in my PIN code and e-mail when sending a call job and it keeps saying the PIN code
is not valid. What am I doing wrong?

A. Remember that the PIN code for the account and the PIN code for each of the users on an
account are different. When you are prompted for a PIN code each time you submit a call job
(see page 123) you need to enter the User PIN associated with one of the Users on the account
(see page 117). You will only need the Account PIN when activating or changing an account (see
page 162).

Q. How quickly will my calls be made with the OnDemand system?

A. The OnDemand server is a multi-line, high-capacity system and is being expanded on an
ongoing basis. In addition, depending on the usage of the system, availability of the telephone
lines can vary. At any given time, your call job will be completed in a matter of minutes vs. 60
calls per hour per phone line using the PhoneTree hardware. Check your call status reports to
see when the first call was completed and when the last call was completed — this time frame
will give you an accurate figure for future call sessions of the same length.



Troubleshooting: PhoneTree Client

PhoneTree Client

Q. I have chosen a PhoneTree, selected my calling preferences in Call Options, recorded a
message and clicked the Call List button but my new call job has not been sent to the
PhoneTree Host PC. Why?

A. Make sure the PhoneTree Host PC is network enabled.

Q. I have chosen View Call List to look at the Call Status for a PhoneTree, but it only brings up
a text file that says “PhoneTree Call Status results are not available for this PhoneTree.”
Why?

A. Make sure that Allow Client to View Call Status is checked on the Advanced Options tab of
the Call Options dialog for that PhoneTree on the Host PC and the Remote PC (see pages 142
and 143). Also, make sure you have first chosen Update Call Results (page 146) - this pauses
calls temporarily to update the call statuses for all PhoneTrees.

PhoneTreeMVP Network Client

i The PhoneTreeMYPu server maching is not responding ...

The path ko PhaneTreeMYPU.exe is nak valid!

'Path Not Valid' Error Message
This message will appear if:
a) The Client software is being launched for the first time.

b) Any of the Initial Setup steps on pages 132-135 have not been completed (the PhoneTreeMVPu
folder must be shared, the proper permissions must be set, and the path to the PhoneTreeMVPu
must be set as a mapped drive).

c) Either the Host PC or the PhoneTree hardware are not properly connected or powered up, or the
PhoneTree software is not in the Call Center.

PhoneTreeMVP Network Client

CustomImport.dak on the PhoneTreeMyP system is not available at this time. ¥ou cannot configure the Translator,

'No Translator' Error Message
This message will appear if:
a) The Client software is being launched for the first time.

b) Any of the Initial Setup steps on pages 132-135 have not been completed (the PhoneTreeMVPu
folder must be shared, the proper permissions must be set, and the path to the PhoneTreeMVPu
must be set as a mapped drive).

c) Either the Host PC or the PhoneTree hardware are not properly connected or powered up, or the
PhoneTree software is not in the Call Center.

d) The CustomImport.dat file on the Host PC has been moved, deleted or corrupted.



Troubleshooting: PhoneTree Client, continued

PhoneTreeMVP Network Client g|

! E YiInfolines\PhoneTreetyPul Does not exist!
L

'Does Not Exist’' Error Message

This message will appear if the path to the PhoneTreeMVPu folder is not set as a mapped drive
(see page 134).

:3':{\ Easy Call: Collections

File Setup

Meszzage Call
Speaker
: Valurme

{ BRecod

Stop

Seconds: 0.0

il

"No List Availahle'
message

Call U[lliUﬂS' o Call the new list | have selected: Usze File->Select!

\

- ¢ Call the list PhoneTres alieady has: Ma list available!
Wﬂm"]g \ =l £ [I2 el ree already nast Mo st avanable:

S Please Tun .Setup-i:all. dptions to create an Dptionsl file 'for thié F'hone:Tree.

Easy Call Screen: 'Call Options' Warning Message

This message will appear if this is the first time the user has viewed this screen. Choose Call Options
from the Setup menu to create the options file needed to continue.

Easy Call Screen: 'No List Available!" Message

This message will appear if there are no lists associated with the PhoneTree selected by the user
(“Collections” in the example above). Usually this means that this PhoneTree has not yet been used
for calling. To remove this message, use File » Select to choose a local file for importing.

Note that once a file has been sent to (and used by) the PhoneTree in question on the Host PC, the
words 'ClientImport.mdb’ will appear here.

'Paused’ Indicator Stays On After Sending a Job to a Never-Before-Used PhoneTree

The PhoneTree chosen by the Client has to have already been set up on the Host PC to import a file
using the chosen translator and format. If not, the host software will “hang” in the configure screen
of the chosen translator. To address this, either a) ahead of time, import a like file into the specific
PhoneTree to be used on the Host PC, utilizing the desired translator, or b) send the job using the
Client software, then go to the Host PC and configure the translator, allowing the job to continue.
This is a one-time step.



Troubleshooting: Checking DIP Switches

Checking DIP Switches (G2PT)

If have purchased 2 lines or less, you will not need to complete this step. If you have purchased
more than 2 lines AND if you cannot get your PC to recognize one or more of your correctly
connected phone lines, read the following:

Each PhoneTree unit has a 4 position DIP switch located on the back. The switches must be set to
properly identify the unit as Lines 1-2, Lines 3-4, etc. Where possible, PhoneTree presets these
switches so that you do not need to do so. If your unit is not set correctly, you will not see the lines
appear correctly in your computer’s Device Manager (see page 18), and you will need to follow
these instructions:

To set DIP switches:

1.

2.
3.

Shut down the PhoneTree software.
Disconnect power and all cables to your PhoneTree unit(s).

Position the PhoneTree upright on its base (see picture on page 10). Using the reference chart
below, change the switches with a sharp, pointed object. For instance, if you have two PhoneTree
units, set one unit to Lines 1-2 and the other to Lines 3-4.

After reconnecting all cables, use the Device Manager as described on page 18 to verify that the
unit has in fact been properly identified.

DIP Switch Configurations:

Lines 1-2 Lines 3-4 Lines 5-6 Lines 7-8




Troubleshooting: Checking DIP Switches, continued

Checking DIP Switches (PT-400)

If you have purchased four lines or less, you will never need to complete this step. If you have
purchased more than four lines AND if you cannot get your PC to recognize one or more of your
correctly connected phone lines, read the following:

Each PhoneTree unit has a 4 position DIP switch inside. The switches must be set to properly
identify the unit as Lines 1-4, Lines 5-9, etc. Where possible, PhoneTree presets these switches so
that you do not need to do so. If your unit is not set correctly, you will not see the lines appear
correctly in your computer’s Device Manager (see page 18), and you will need to follow these
instructions:

To set dip switches:

1. Shut down the PhoneTree
application.

2. Disconnect power and all cables
to your PhoneTree units.

3. Remove 4 screws from the back
cover.

4. Slide the circuit board out only
far enough to see the switches.

5. Change the switches with a
sharp pointed object, following
the directions printed directly on
the circuit board in white (see flus-pro 2
photograph at right). Bl ¢ : ——

6. Slide the circuit board back in, [ 1 E ISWItchCnnllquratluns . -
making sure that the circuit T & AT, 2 l!

board is flush with the housing PhoneTree USB

before replacing the back cover.

FCS, IRC 1999 — "

7. After reconnecting all cables,
use the Device Manager as
described on page 18 to verify
that the unit has in fact been
properly identified.
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Appendices: Editing an lcon

Editing an Icon:

You can change the name and/or graphic for any icon. To do this, follow the instructions below:

PhoneTree V6
Mavigation Help

e Ecit This 1o

- Fhot

First, right click on the icon you wish to change, then click Edit This Icon.

Desktop lcon

~ Select anicon: - 1 1 Enter a narne: 1
“Calculate?.ico ] Blue Ridge
“Calculate3.ico = Group
“Calendar.ico = : |
“Calendar ico

I

“Calendarf.ico Deskiop preview:

Calendark. ico
“Calendario.ico
“Calendart'es.ico
“Cardindex.ico
“Cardwrite.ico Blue Bidage Grou
“CD Cross.ico 2 2
“Check.ico b

(]S Lancel I Help

Next, choose a icon graphic from the Select an icon box. A preview will appear for each icon
clicked. If you would like to change the name of the icon, enter a new name in the Enter a name
box. When finished, click OK.




Appendices: Text Messaging

Text Messaging:
Q. How do I send text messages to cell phones or other devices (pagers, etc.)?

A. Sending text messages to cell phones or other wireless devices is as easy as sending an email with
your PhoneTree message — all you need is the proper address in the proper format. For a list of
address formats of major carriers, please visit www.phonetree.com/texting. These may change
without notice, so be sure to verify the address with your message recipient if possible.

Example:

Verizon Wireless: 10digitphonenumber @vtext.com (i.e. 555-555-5555@vtext.com)



Appendices: Blocking Numbers

Blocking Numbers:

If there is a person that is part of your list or if you have a phone number that PhoneTree should
never call, you can add them to the Blocked Numbers database. As long as the phone number is
stored here, PhoneTree will always block it. If you ever wish to resume calling a number, click on
the grey box beside the entry you wish to remove and then click Delete.

There are two methods to blocking a phone number in PhoneTree:

Blocked Numbers

= v 7 X @
Prink By Mame ByPhone | Refresh  Delete Help
I ame Phore Comment
Edison, Freddy 555-8445 noizy phone line
Flowser, *avier 555-9442 hard of hearing
*|l
< | -+
i~ Find a name or phone number in this list [enter complete name or number only): —
* Mame " Phone ; : :
Loak for: | Find Find Again

From the Admin tab:

From the Desktop View, click the Admin tab, then click Blocked Numbers. Enter the name of the
person in the Name field, their phone number in the Phone field, and a comment stating why they
are blocked in the Comment field (optional).

File Edit G view Search Setup Call Import Help
(] OnDemand Service Jobs ... [ ? @ @ n
Tew Translate Phone Mumbers. .. List Filcer Maibox  Options East
Clear Call Status LA

Tag|Hame
[ Jane Does

Change Job Expiration, .,
Check Mailbox Messages. ..

[Repii

» 2 ed Numbers ¥
1 D John Dioe ; : _:IrJurut_r_ -
| Trirn List to Match Fileer... Remove From Blocked Nurnbers
| 3 D Mark Doed Jil Clear Entire List Add Tagged to Blocked Mumbers L

Clear Calls 'Placed' and 'Completed' Counters
F.eSync this List to the Central dakabase. ..
ReeIndex (remove unused 1D numbers)

Process Blocked Numbers

Test Cal...

From the List Editor:

Find the person that you wish to block and click on the grey box beside their name. A black arrow
should appear to the left of their name and highlight all of their information. Next, from the top of
the List Editor screen, click Tools » Blocked Numbers » Add to Blocked Numbers. This will
automatically add the name and the phone number of the person you just selected to the Blocked
Numbers database.



Appendices: Activating Line 2 for G2PT Hardware

Activating Line 2 for G2PT Hardware:

If your PhoneTree G2PT hardware is a one line system, you can purchase an Activation Code to
enable Line 2 (which will double your calling capacity) by following these instructions.

i PhonelTree Yo

Mavigation EE=s

- | PhoneTree Help 5
LD contents... asks || A

About... =
—
H.,';.Hl
Enble Fet..lrs i
e R
Activate Line 2., Ploetasa

Elue Fiil:l!:
| Chedk for updates...

Click Help, then Activate Line 2... from any desktop view.

S Enable Second Line

Activating your zecond line and doubling your calling capacity is quick
and easy.
~ Purchase Online

Far quick, ondine payment to activate vour second port, choose:  Purchaze Howl

i~ Purchase by Phone

To purchase by phaore, call 800.957.8733 » 2026 and provide
wour Uit 1D ,—‘

Enter your second port ACTIVATION CODE below and click [Activate]:

| Achivate

You can purchase an Activation Code to enable Line 2 either by clicking the Purchase Now! link
(Internet connectivity required) and filling out the order form that appears or by calling us directly.
Once you have the purchased the code, enter it in the ACTIVATION CODE box below and click
Activate. This permanently updates the firmware in the PhoneTree unit.




Appendices: Backing Up/Restoring Your PhoneTree System

Backing Up Your PhoneTree System

Once you have finalized your configurations, we recommend creating a backup. This section will
walk you through the suggested way to backup the PhoneTree files, but you should also consult
with your IT Administrator for any specific methods your office may use. It is a good idea to repeat
these steps every time you make changes to your PhoneTree configurations.

Please Note: Keep your current PhoneTree Installation CD in a safe place. In the event you ever
need to restore your PhoneTree system, or move it to another PC, you MUST use the same version
of the PhoneTree software your backup files were created from (to identify your PhoneTree
software’s version, click Help » About from any Desktop view).

& program Files E”E|E|
32 Edit View Favorites Tools Help -.1.'
i 2 . | @ Shorteut
_ -
@ Briefcase B ' Go
[*4 Bitmap Image Size | Type A
- | B microsoft Word Document File Folder
| Close 2] Microsoft Office Access Application File Folder

é Publish this fol @] Microsoft PowerPoint Presentation e Folder
Web

File Folder
L"é’j Microsoft Office Publisher Document Eile Folder
ted Share this fold [z
= [Z] TextDocument File Folder
e‘] Wave Sound File Folder
B mi
F— ] Microsoft Excel Worksheet File Folder
i3] Compressed (zipped) Folder | File Folder

1. First, make sure no calls are being made and exit the PhoneTree software. On the PhoneTree
computer, use Windows Explorer and browse to C:\Program Files. Next, at the top of the
window, click File » New » Folder. This will create a folder named “New Folder” (should be
the last folder here), right-click on it and select Rename from the submenu that appears. Name
the folder “PhoneTree Backup <current version> «current date>” and use the current PhoneTree
software version (to identify your PhoneTree software’s version, click Help » About from any
Desktop view) and the current date (mmddyy) as part of the name (e.g., PhoneTree Backup
6.9.4 061909).

| ]

€3 F'||:|r|E=Tr'E=|:= Ay Open

[ChRiva Explore

[DSeagate Softw o 4

ICSSigmaTel

I3 TechSmith Shating and Security. ..
|2 Voiceware cend 1o -

[ windows Live

[Chwindows Live 8 Cuk
[ windows Mediz
[ windows MNT Paste

"j xme Create Shortcut
|[CiPhoneTree Bac Delete
Renarne

2. Next, right-click on the “PhoneTreeMVPu” folder and choose Copy from the sub-menu that
appears.



Appendices: Backing Up/Restoring Your PhoneTree System, continued

IPCs Search:...
ICiPhoneTreetyPu

Eriva Sharing and Security. ..
[Ch5eagate Software send To b
[ChsigmaTel

E3Techsmith U

[Cavoiceware Copy
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[Ty Windows Live SkyDrive R s
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|ZWindows NT Renarme

[xerox

Properties

S Phone Tree Backup 6,94 061 i
num14.way
From ‘Menu' to Menu'

(LI ) Cancel

15 Seconds Remaining

3. Right-click on the “PhoneTree Backup” folder you created in step 1 and choose Paste from the
sub-menu. This will copy the entire PhoneTreeMVPu folder you copied in step 2 into this folder.
Once the “Copying...” window disappears, your backup is complete.

4. Copy the “PhoneTree Backup” folder to another location, such as a backup hard drive, USB flash
drive or on another computer on your network. If you prefer to copy the “PhoneTree Backup”
folder to a CD, make sure you first compress the folder using the Compressed Folder tool in
Windows (right-click on the folder » Send to » Compressed (zipped) Folder) to prevent the
files from being set to read-only. Then, write the zipped folder that is created to a CD.

We recommend repeating these steps every time you make changes to your PhoneTree system to
keep an up to date copy of your files and configurations. As advised before, consult your
administrator about backup procedures in your office.

Restoring Your PhoneTree System

To restore your PhoneTree system, you will require a PhoneTree Installation CD containing the
same version of the PhoneTree software used to create the backup folder (see “Backing Up Your
PhoneTree System” on page 174).

Please Note: If you have misplaced your PhoneTree Installation CD, or your copy has a later
version number than your “PhoneTree Backup” folder, please contact PhoneTree Customer
Support at 866.234.2943, or by email at support@phonetree.com.

1. Make the most recent “PhoneTree Backup” folder available to the new computer by using one
of the following two methods:

a) Place the folder in a location on the office network where you will be able to browse to it
from the new PhoneTree computer, OR:

b) Create a compressed archive containing the folder, then burn the archive to a CD (creating
a .zip or other archive avoids the problem of CD files being automatically set to read-only).



Appendices: Backing Up/Restoring Your PhoneTree System, continued

2. Install PhoneTree on the new computer. You must install under the user name from which you
will be using the software. Do not yet launch the PhoneTree software.

Hardware Installation

3.

Connect the PhoneTree hardware,
including the phone cable(s), USB cable
and finally, the power cable. You may
receive one or more messages explaining
that PhoneTree has not passed Windows
Logo testing. It is 100% safe to install
PhoneTree on your PC - therefore you
should click the Continue Anyway
button at these prompts.

N

The software you are installing for this hardware:

FPLCS PhoreTree USE Shared 01-04 [B]

has not passed Windows Logo testing to verify its compatibility

with ‘windows X<, [Tell me why this testing is important. |

Continuing your ir of this may impair
or destabilize the comect operation of your system
either immediately or in the future. Microzoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
paszed Windows Logo testing.

[ Continue Aryway ] [ STOP Installation ]

Before launching the PhoneTree software, copy the backed-up “PhoneTreeMVPu” folder in to
the C:\Program Files directory on the new computer.

Launch the PhoneTree software. All of your call lists, messages and option preferences will be
available just as they were before they were backed-up
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Warranty Information: In Warranty

Full One Year Warranty

PCS warrants its products to be free from defects in materials and workmanship for a period of one
full year from the original date of purchase.

Defective products returned to PCS will be repaired or replaced, at our option, if returned within the
warranty period. PCS may use new or reconditioned parts to repair your unit.

The repair or replacement shall be warranted for either 90 days, or the remainder of the warranty
period, whichever is longer.

Limitations: PCS makes no implied warranties, including those of fitness for a particular purpose or
merchantability. PCS will not pay for loss of time, inconvenience, loss of use of your PCS product or
property damage caused by your PCS product or its failure to work, or any other incidental or
consequential damages.

State Law Rights

This warranty gives you specific legal rights. You may also have other rights which vary from state
to state.

To Receive Service (In Warranty)

To receive technical assistance with your PhoneTree system, please call 866.234.2943 and you will
be connected with one of our customer support technicians. They will remotely connect to your
computer to see the problem firsthand and attempt to correct it. If your problem is found to be
related to your PhoneTree hardware, we will provide you with a Return Authorization Number
(RA#) and you will be requested to ship us the unit. An RA# is only valid up to 30 days after being
issued. If this period has expired before return, there must be a new number issued before a return
will be allowed. Any shipments received without an RA# will be returned to the customer.

You must pay the shipping charges to send the unit and PCS will pay the return shipping charges.
Carefully package your PhoneTree hardware (we recommend using the original packing materials)
along with your RA#, name, address, phone number and a description of the problem. PCS is not
responsible for damage that occurs in shipping from the customer. Repair or replacement is your
exclusive remedy.

Ship your unit to:

Personal Communication Systems, INC
Attn: Customer Support

2400 Reynolda Road

Winston-Salem, NC 27106

This warranty does not cover defects resulting from accidents, alterations, unauthorized repair,
failure to follow instructions, misuse, fire, flood, or acts of God. Nor does PCS warrant this product
to be compatible with any particular telephone equipment or switching systems.

PCS makes no other warranties expressed or implied.

Note: PhoneTree contains no user-serviceable parts.



Warranty Information: Out of Warranty

To Receive Service (Out of Warranty)

If your PhoneTree warranty has expired and you are experiencing a technical problem, please call
our customer support at 866.234.2943. You will be asked to either pay a per-incident fee or renew
your Service Agreement to allow a technician to assist with resolving your issue. If the problem is
found to be related to your PhoneTree hardware, there will be an additional fee to have it repaired.
You will be issued a Return Authorization Number (RA#) and asked to send us the unit. Once your
unit has been received and tested, a technician will contact you with the repair costs. An RA# is
only valid up to 30 days after being issued. If this period has expired before return there must be a
new number issued before a return will be allowed. Any shipments received without an RA# will be
returned to the customer.

You must pay the shipping charges to send the unit and PCS will pay the return shipping charges.
Carefully package your PhoneTree hardware (we recommend using the original packing materials)
along with your RA#, name, address, phone number and a description of the problem. PCS is not
responsible for damage that occurs in shipping from the customer. Repair or replacement is your
exclusive remedy.

Ship your unit to:

Personal Communication Systems, INC
Attn: Customer Support

2400 Reynolda Road

Winston-Salem, NC 27106

PCS has a fixed-price repair policy (including return ground shipping). We will repair or replace, at
our option, any PhoneTree unit using new or remanufactured parts and include a 90-day parts and
labor warranty.

This warranty does not cover defects resulting from accidents, alterations, unauthorized repair,
failure to follow instructions, misuse, fire, flood, or acts of God. Nor does PCS warrant this product
to be compatible with any particular telephone equipment or switching systems.

PCS makes no other warranties expressed or implied.

Note: PhoneTree contains no user-serviceable parts.
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Regulatory Information: Model No. 6G2PT

Regulatory Information Model No. G2PT

This device complies with Part 15 of the FCC Rules. Operation is subject to
the following two conditions:

(1) This device may not cause harmful interference, and (2) This device
must accept any interference received, including interference that may
cause undesired operation.

This device requires the ferrite provided in the package on the
telephone line(s) to comply with FCC emission limits.

You are cautioned that any changes or modifications not expressly
approved in this manual could void your authority to operate this device.

This equipment complies with Part 68 of the FCC Rules. On the bottom of
this equipment is a label that contains among other information, the FCC
Registration Number and Ringer Equivalence Number (REN) for this
equipment. You must, upon request, provide this information to your
telephone company. (NOTE: REN is not required for some types of
analog or digital facilities.)

This equipment uses USQCs jacks RJ14.

An FCC compliant telephone cord and modular plug are provided with this
equipment. This equipment is designed to be connected to the telephone
network or premises wiring using a compatible modular jack which is part
68 compliant. See installation instructions for details.

The REN is useful to determine the quantity of devices you may connect
to your telephone line and still have all those device ring when your
number is called. In most, but not all areas, the sum of the RENs of all
devices connected to your line should not exceed five (5.0). To be certain
of the number of devices you may connect to your ling, as determined by
the REN, you should contact your local phone company to determine the
maximum REN for your calling area. (NOTE: REN are associated with
loop-start and ground-start ports. Do not use for E&M or digital ports)

If your telephone equipment causes harm to the telephone network, the
Telephone Company may discontinue your service temporarily. If possible,
they will notify you in advance. But if advance notice is not practical, you will
be notified as soon as possible. You will be informed of your right to file a
complaint with the FCC.

Your telephone company may make changes in its facilities, equipment,
operations or procedures that could affect the proper functioning of your
equipment. If they do, you will be notified in advance to give you an
opportunity to maintain uninterrupted telephone service.

If you experience trouble with this telephone equipment, please contact
Personal Communication Systems (1-336-722-5008) for information on
obtaining service or repairs. The telephone company may ask that you
disconnect this equipment from the network until the problem has been
corrected or until you are sure that the equipment is not malfunctioning.

There are no user-serviceable parts inside.

This equipment may not be used on coin service provided by the telephone
company. Connection to party lines is subject state tariffs.

INDUSTRY CANADA (IC) NOTICE

"NOTICE: The Industry Canada (IC) label identifies certified equipment.
This certification means that the equipment meets telecommunications
network protective, operational and safety requirements as prescribed in
the appropriate Terminal Equipment Technical Requirements document(s).
The department does not guarantee the equipment will operate to the
user's satisfaction.

Before installing this equipment, users should ensure that it is permissible
to be connected to the facilities of the local telecommunications company.
The customer should be aware that compliance with the above conditions
may not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative
designated by the supplier. Any repairs or alterations made by a user to
this equipment, or equipment malfunctions, may give the telephone
company cause to request the user to disconnect the equipment.

Users should ensure for their own protection, that the electrical ground
connections of the power utility, telephone lines and internal metallic water
pipe system, if present, are connected together. This precaution may be
particularly important in rural areas.

CAUTION: Users should not attempt to make such connections
themselves, but should contact the appropriate electric inspection
authority, or electrician, as appropriate.

"NOTICE: The Ringer Equivalence Number (REN) assigned to each
terminal device provides an indication of the maximum number of
terminals allowed to be connected to a telephone interface. The
termination on any interface may consist of any combination of devices
subject only to the requirement that the sum of the Ringer Equivalence
Numbers of all the devices does not exceed 5."

REN: 0.78
WARRANTY AND REPAIR SERVICE CENTER:

Personal Communication Systems, Inc.
2400 Reynolda Road

Winston-Salem, NC 27106
866.234.2943



Regulatory Information: Model No. PT-400

Regulatory Information: Model No. PT-400

This equipment has been tested and found to comply with the limits for a
class B digital device, pursuant to Part 15 of the FCC rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by tumning the equipment off
and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and the receiver.

* Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

* Consult the dealer or an experienced Radio/TV technician for help.

This device requires the ferrite provided in the package on the
telephone line(s) to comply with FCC emission limits.

You are cautioned that any changes or modifications not expressly
approved in this manual could void your authority to operate this device.

This equipment complies with Part 68 of the FCC Rules. On the bottom of
this equipment is a label that contains among other information, the FCC
Registration Number and Ringer Equivalence Number (REN) for this
equipment. You must, upon request, provide this information to your
telephone company. (NOTE: REN is not required for some types of
analog or digital facilities.)

This equipment uses USOCs jacks RJ11.

An FCC compliant telephone cord and modular plug are provided with this
equipment. This equipment is designed to be connected to the telephone
network or premises wiring using a compatible modular jack which is part
68 compliant. See installation instructions for details.

The REN is useful to determine the quantity of devices you may connect
to your telephone line and still have all those device ring when your
number is called. In most, but not all areas, the sum of the RENs of all
devices connected to your line should not exceed five (5.0). To be certain
of the number of devices you may connect to your line, as determined by
the REN, you should contact your local phone company to determine the
maximum REN for your calling area. (NOTE: REN are associated with
loop-start and ground-start ports. Do not use for E&M or digital ports)

If your telephone equipment causes harm to the telephone network, the
Telephone Company may discontinue your service temporarily. If possible,
they will notify you in advance. But if advance notice is not practical, you will
be notified as soon as possible. You will be informed of your right to file a
complaint with the FCC.

Your telephone company may make changes in its facilities, equipment,
operations or procedures that could affect the proper functioning of your
equipment. If they do, you will be notified in advance to give you an
opportunity to maintain uninterrupted telephone service.

If you experience trouble with this telephone equipment, please contact
Personal Communication Systems (1 336-722-5008) for information on
obtaining service or repairs. The telephone company may ask that you
disconnect this equipment from the network until the problem has been
corrected or until you are sure that the equipment is not malfunctioning.

The user may in some circumstances repair a unit by replacing a plug-in
telephone LINE board. There are no other user serviceable parts inside.

This equipment may not be used on coin service provided by the telephone
company. Connection to party lines is subject state tariffs.

INDUSTRY CANADA (IC) NOTICE

"NOTICE: The Industry Canada (IC) label identifies certified equipment.
This certification means that the equipment meets telecommunications
network protective, operational and safety requirements as prescribed in
the appropriate Terminal Equipment Technical Requirements document(s).
The department does not guarantee the equipment will operate to the
user's satisfaction.

Before installing this equipment, users should ensure that it is permissible
to be connected to the facilities of the local telecommunications company.
The customer should be aware that compliance with the above conditions
may not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative
designated by the supplier. Any repairs or alterations made by a user to
this equipment, or equipment malfunctions, may give the telephone
company cause to request the user to disconnect the equipment.

Users should ensure for their own protection, that the electrical ground
connections of the power utility, telephone lines and internal metallic water
pipe system, if present, are connected together. This precaution may be
particularly important in rural areas.

CAUTION: Users should not attempt to make such connections
themselves, but should contact the appropriate electric inspection
authority, or electrician, as appropriate.

"NOTICE: The Ringer Equivalence Number (REN) assigned to each
terminal device provides an indication of the maximum number of
terminals allowed to be connected to a telephone interface. The
termination on any interface may consist of any combination of devices
subject only to the requirement that the sum of the Ringer Equivalence
Numbers of all the devices does not exceed 5."

REN: 0.9B
WARRANTY AND REPAIR SERVICE CENTER:

Personal Communication Systems, Inc.
2400 Reynolda Road

Winston-Salem, NC 27106
866.234.2943
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